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This User Guide is a reference for Silhouette and is available as an Acrobat
PDF file. You can read from start to finish or jump around as you please.

Copyright
No part of this document may be reproduced or transmitted in any form or by
any means, electronic or mechanical, including photocopying and recording,
for any purpose without the express written consent of Boris FX.
Copyright © Boris FX 2020. All Rights Reserved
August 13, 2020

About Us
Founded in 1995, Boris FX is a leading developer of VFX, compositing, titling,
video editing, and workflow tools for broadcast, post-production, and film
professionals. Boris FX products have grown to serve over a million artists
worldwide. The company’s success lies in its ability to tightly integrate and
leverage technologies through strong partnerships with Adobe, Apple, Avid,
Blackmagic Design, Autodesk, FilmLight, Grass Valley, Magix, SGO, and other
leading developers of video editing software. In 2014, Boris FX acquired
Imagineer Systems, the Academy Award-winning developer of Mocha planar
tracking software. In 2016, Boris FX acquired GenArts, the developer of
Sapphire, the gold standard plug-in package for high-end visual effects. In
2019, Boris FX acquired the Academy Award-winning Silhouette for advanced
feature film rotoscoping, painting, and effects.

Silhouette User Guide

•
•
•
•
•
•

2

About this Guide

•
•
•
•
•
•

Silhouette User Guide

•
•
•
•
•
•

3

Table of Contents

TABLE OF CONTENTS

•
•
•
•
•
•

About this Guide .............................................................................. 2
Copyright ...................................................................................... 2
About Us....................................................................................... 2
Table of Contents............................................................................. 4
Silhouette Features.......................................................................... 7
Paint ............................................................................................. 8
Tracker ......................................................................................... 8
Roto.............................................................................................. 9
Architecture .................................................................................. 9
Supported Hosts........................................................................... 9
Installation ........................................................................................ 10
Windows / Macintosh ................................................................... 10
Linux............................................................................................. 10
Licensing .......................................................................................... 13
Node-Locked Licenses................................................................. 13
Floating Licenses ......................................................................... 21
Tutorials............................................................................................ 34
Applying the Silhouette Plug-in .................................................... 34
Paint ............................................................................................. 35
Paint Presets ................................................................................ 39
Onion Skin.................................................................................... 40
Clone Brush.................................................................................. 41
Display Roto Shape Outlines In Paint .......................................... 53
Alpha Channels ............................................................................ 54
Detail Separation In Paint............................................................. 56
Auto Paint..................................................................................... 61
Tracker ......................................................................................... 73
Roto.............................................................................................. 104
Motion Blur ................................................................................... 141
Renaming Objects........................................................................ 142
Silhouette User Guide

•
•
•
•
•
•

4

Table of Contents

Timebar Keyframes ...................................................................... 143
Timeline........................................................................................ 144
Viewer .......................................................................................... 147
Optimizing Playback..................................................................... 153
ROI (Region of Interest) ............................................................... 155
Keyboard Customization .............................................................. 157
User Interface ................................................................................... 159
Host Application Plug-in Parameters............................................ 159
Paint Interface .............................................................................. 162
Roto Interface............................................................................... 163
Viewer .......................................................................................... 164
Toolbars ....................................................................................... 181
Tool Tabs ..................................................................................... 182
Roto Object List............................................................................ 183
Parameters................................................................................... 189
Notes ............................................................................................ 190
Timebar / Player Controls............................................................. 191
Timeline........................................................................................ 197
Windows and Adjustments ........................................................... 204
Pull-Down Menus ......................................................................... 210
Paint .................................................................................................. 212
Projects ........................................................................................ 213
Applying Silhouette....................................................................... 214
Paint ............................................................................................. 215
Roto................................................................................................... 257
Roto.............................................................................................. 257
Tracker (Shift-T) ........................................................................... 306
Preferences ...................................................................................... 329
Autosave ...................................................................................... 330
Cache ........................................................................................... 331
Color Management....................................................................... 332
Environment ................................................................................. 333
Silhouette User Guide

•
•
•
•
•
•

•
•
•
•
•
•

5

Table of Contents

GPU.............................................................................................. 334
Nudging ........................................................................................ 335
Paint ............................................................................................. 336
Roto.............................................................................................. 339
Shape ........................................................................................... 340
Tracker ......................................................................................... 345
Undo............................................................................................. 346
User Interface............................................................................... 347
Viewer .......................................................................................... 348
Keyboard Shortcuts......................................................................... 352
Paint ............................................................................................. 352
Roto.............................................................................................. 358
Timeline........................................................................................ 367
Viewer .......................................................................................... 368
Licenses Used by Silhouette .......................................................... 371
GLEW (OpenGL Extension Wrangler Library) ............................. 371
libjpeg ........................................................................................... 372
libpng............................................................................................ 373
libtiff .............................................................................................. 376
libz ................................................................................................ 377
OpenColorIO ................................................................................ 378
OpenCV (Open Source Computer Vision Library) ....................... 384
OpenEXR .................................................................................... 385
Power Matte ................................................................................. 385
PySide2 ........................................................................................ 385
Python .......................................................................................... 397
Qt.................................................................................................. 398
Shiboken2 .................................................................................... 402
xmlio ............................................................................................. 413

Silhouette User Guide

•
•
•
•
•
•

•
•
•
•
•
•

6

Silhouette Features

SILHOUETTE FEATURES

•
•
•
•
•
•

Silhouette is a high dynamic range, non-destructive, 2D raster based paint
system that was designed from the ground up to handle the demands of feature
film and television production. Now, the same Academy Award And Emmy
Award winning paint tools used by visual effects artists worldwide can be used
for paint and retouching in Adobe After Effects & Premiere Pro, Foundry NUKE,
Blackmagic Resolve & Fusion, and Magix Vegas host applications.
Black & White, Blemish, Blur, Burn, Clone, Color, Color Correct, Cutout, Detail,
Dodge, Drag, Eraser, Grain, Mosaic, Repair and Scatter brushes are available
for any task. As you paint, every action you make is recorded as events. These
events can be selectively played back on the same frame, different frames,
multiple frames and with or without tracking data applied. This makes for a very
powerful and versatile Auto Paint feature that provides the flexibility of vector
paint with the speed of a raster paint system.
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Paint

•
•
•
•
•
•

• Black & White, Blemish, Blur, Burn, Clone, Color, Color Correct, Cutout, Detail,
Dodge, Drag, Eraser, Grain, Mosaic, Repair and Scatter brushes

• Non-destructive raster paint system allows playback of paint strokes on a range
of frames or the entire clip

•
•
•
•
•
•
•
•
•
•
•

Detail separation separates the image into color and detail layers
Automatic recording of paint events with selective stroke playback
Track paint strokes and Clone sources
Sophisticated cloning interface
Motion track, position, scale, rotate, skew and corner pin clone sources
Color Correct, Blur, Sharpen or Warp the Clone source
Onion-Skin and Align tools to match up elements
Presets to store brushes and their settings
Automatically redo all paint strokes if a source sequence changes
Roto shape assisted painting
High dynamic range painting in 32 bit float

Tracker
• Planar Tracking using either Mocha Pro or Silhouette’s Planar Tracker
• Planar Trackers provide automatic, markerless motion analysis and tracking
• Planar Tracker tracks corners, edges or ridges
• Track multiple planes simultaneously
• Unlimited Point Trackers for manual precision
• Match Moving or stabilization
• Pre-processing filters for problematic shots include: Blur, Sharpen, Contrast,
Gamma, De-Noise and Remove Flicker will increase tracker accuracy for
problematic images

• Post-processing of point tracking data to include: Average, Smooth and Merge
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Roto

•
•
•
•
•
•

• Shape assisted paint
• Unlimited number of animated B-spline, X-Spline, Bézier or Freehand shapes
• Integrated Motion Tracker that can apply motion data to points or shapes
• IK (Inverse Kinematics) for animating humans, animals and all manner of jointed
creatures

• Support for open or closed shapes
• Move, scale, rotate, shear, and corner-pin shapes and groups of shapes
• Create magnetic freehand shapes with or without magnetic properties
• Edge Snapping tool that snaps the control points of an X-Spline to an object edge
• Point-by-Point variable edge softness
• Animation changes for one point or selected points across all keyframes
• Realistic motion blur
• Independent shape viewing and hiding
• User-definable names, colors, blurs and blend modes for each shape
• Display shape animation over image as an outline or filled color
• Shape import

Architecture
• Region of Interest for enhanced performance
• Scripting and Actions
• OpenColorIO Color Management
• Multi-processor support
• GPU and OpenGL® accelerated

Supported Hosts
• Adobe After Effects and Premiere Pro
• OFX support in The Foundry’s NUKE, Blackmagic Resolve, Autodesk Flame and
more
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INSTALLATION
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Windows / Macintosh
1

Download Silhouette from: www.borisfx.com

2

Double-click on the file that was downloaded and when prompted, select the
destination programs to install to. You can choose from Adobe After
Effects/Premiere Pro and OFX.

Silhouette will now appear as an available plug-in within the host application.
3

Start the host application and apply Silhouette:

• After Effects: Apply Silhouette Paint to a clip in the timeline from the Effects >
Boris FX Silhouette menu.

• Premiere Pro: Apply Silhouette Paint to a clip in the timeline from the Effects >
Video Effects > Boris FX Silhouette group.

• OFX: The method for applying an OFX plug-in varies. Consult the OFX host
software documentation for details.

Linux
1

Download the Silhouette software at www.borisfx.com

2

Open a Terminal window and change to the directory where you downloaded the
file.

3

Type: tar xvzf <name of file>

4

Change to the new directory that is created.

5

To install Silhouette Paint for OFX, run the “install_paint.ph” script by typing:
sudo ./install_paint.sh

Silhouette is unpacked into the OFX plug-ins directory and will now appear as
an available plug-in within the OFX host application.
6

Start the host application and apply Silhouette. The method for applying an OFX
plug-in varies. Consult the OFX host software documentation for details.
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When using the KDE or GNOME desktops, by default there is a Move Window
modifier key combination set up, so that if you Alt-drag a window, it will move.
This interferes with our Alt-drag capability in some tools, so you will want to
disable this desktop feature.

KDE Desktop
1

Run the KDE Control Center.

2

Go to the Desktop/Window Behavior panel and select the “Actions” tab.

3

Down in the Inner Window, Titlebar & Frame area, change the “Modifier Key”
option from Alt to Meta.

GNOME Desktop
1

Run the Control Center in Preferences.

2

Select Windows.

3

Select Super (or “windows logo”).

Linux Tablet Configuration

We require that proper tablet support is enabled in the X server. This part is left
up to the user, as it is very distribution and version specific. This site can be
used for more information: http://linuxwacom.sourceforge.net/index.php/all
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Node-Locked Licenses
When you purchase your license, you will be emailed a serial number.

Internet Activation

When your machine is connected to the Internet, you can activate directly in a
few simple steps.

1

Make sure you are connected to the Internet.

2

Apply Silhouette:

• After Effects: Apply Silhouette Paint to a clip in the timeline from the Effects >
Boris FX Silhouette menu.

• Premiere Pro: Apply Silhouette Paint to a clip in the timeline from the Effects >
Video Effects > Boris FX Silhouette group.

• OFX: The method for applying an OFX plug-in varies. Consult the OFX software
documentation for details.

3

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
4

Select Activate nodelock license in the License window and click OK.

The Boris FX License Tool will load.
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5

Choose Activate your license now and press Next.

6

Paste the serial number into the Activation Key field and click Next.
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If the activation is successful, details will appear on the next page.

7

•
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Select Finish.

Your license is now installed and Silhouette opens.
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If your machine is not connected to the Internet or you are behind a firewall, use
the Activate your license manually option.

1

Apply Silhouette.

2

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
3

Select Activate nodelock license from the License window and click OK.

The Boris FX License Tool will load.
4

Choose Activate your license manually using another computer’s web browser
and press Next.
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5

You will be provided with file fields to load a key file.

6

Download and save the key file that you received from your license email from a
computer that has an Internet connection.

7

Transfer the key file to your offline machine you are going to activate via a
flash/thumb drive or a shared network.

8

Select the location of the key file in the first field.

9

Pick a location for the request file (which will be created) in the second field.

•
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10 Copy the request file (.req) to a machine with an Internet connection.
11 Upload it to http://activation.borisfx.com/offline-activation.php.
12 Save the activation file it returns (via download or email), and copy that back to
the offline machine.
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13 Enter its location into to the license tool and click Next.
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Your license is now installed and Silhouette’s New Project dialog box opens.

Internet Deactivation

Once Silhouette has been activated, you can access the deactivate option by
selecting the Help > License menu.

1

Make sure you are connected to the Internet.

2

Apply Silhouette

3

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
4

Select Help > License.

The Boris FX License Tool loads.
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5

Choose Deactivate your license now and press Next.
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Silhouette deactivates.
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Node-Locked License Troubleshooting
1

It is important that your Silhouette software matches your activation code, so
check your purchase order to make sure everything matches up version wise. It
may be that you don’t have the correct version of Silhouette installed from our
download section. This is especially important for legacy software before
Silhouette 2020, where a different licensing method is used.

2

Check to make sure you are not restricted to using certain ports due to a firewall
or other admin permissions. When in doubt, temporarily turn your firewalls off
for the duration of the installation and then turn them back on when you are
done.

3

Troubleshoot your machine; try uninstalling all your Silhouette software,
restarting your machine, and installing the software again from scratch, and
make sure you follow installation directions off our website exactly. It sounds
redundant, but sometimes it’s a great way to figure out what is going on inside
your machine.

4

If all else fails, our support team is happy to help you figure this out. Please
contact support.
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This section will walk you through the process of installing floating licenses.
Installing nodelocked licenses does not require the use of the license manager.
See above.

Floating licenses - How it works

A floating license allows central administration of your license deployment,
avoiding the need to manually activate and deactivate our software on every
machine, which is particularly beneficial for large facilities.
Configuring a new machine to use your floating license server is very
straightforward and requires no Internet connection.
Similarly, replacing a failed machine can be done without needing to contact
technical support for the license to be released.

How do I Install the Floating License Server?

Silhouette uses the Boris FX RLM License server for floating licenses.
You can download the license server from the Boris FX website. See the steps
below.
Floating licenses are easy to set up if you are familiar with configuring network
services, but if you need any help with the process, please contact technical
support.
Note: To configure a license server you must have Administrator (or root) privileges.

Installing Floating Licenses with Online Activation
1

Download the RLM License Manager from the download section here: RLM
License Server

2

Run the License Manager file then follow the installation prompts.

3

Open a Web browser and go to: http://SERVERNAME:5054/goforms/activate

4

Replace SERVERNAME with the name of the license server.

5

Click BEGIN License Activation.

6

Enter activation.genarts.com in the ISV activation website field and click Next.

7

Enter genarts in the ISV field.

Silhouette User Guide
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8

Copy and paste your Silhouette Activation Key license that you received from
your license email into the License activation key field. Then, click Next.

9

Your Ethernet address will auto-populate in the License Server or Node-lock
hostid field. Accept the auto-populated Ethernet address
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10 Enter the number of licenses that should be locked to this server in the License
count (for floating licenses) field. Or just enter 0 to assign all licenses to the
specified server. Click Next.

A default license location will auto-populate in the License File to create or edit
field. Accept the default license location and click Next.
11 On the Activation Request Data screen, verify all the information you have
entered, and click REQUEST LICENSE.

12 On the License Activation page, click on (Re)start License Server.
13 Then, on the Reread/Restart Servers page, click on Reread/Restart.
The license server should now be set up.
14 To confirm that the Boris FX license server is working, go to
http://SERVERNAME:5054

15 Replace SERVERNAME with the name of the server, and click Status on the top
left hand corner.

genarts should show up under the ISV Servers and it will say Running: Yes.

Installing Floating Licenses With Offline Activation

In cases where you cannot install the license via an Activation code (normally
where the server is not connected to the Internet) you can manually install your
license:

1

On a machine with Internet access, download the RLM License Manager from the
download section here: RLM License Server

2

Install the License Manager on both the machine that has an Internet connection
and the offline server you intend to run on.
Note: You will use the online machine to get the license for your offline server.

3

One the online computer, open a web browser and go to:
http://SERVERNAME:5054/goforms/activate

4

Replace SERVERNAME with the name of the license server.

5

Click BEGIN License Activation.
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6

Enter activation.genarts.com in the ISV activation website field and click Next.

7

Enter genarts in the ISV field.

8

Copy and paste your Silhouette Activation Key license that you received from
your license email into the License activation key field. Then, click Next.

9

The Ethernet address of the machine you are on will auto-populate in the License
Server or Node-lock hostid field. You will need to overwrite it with the Ethernet
address of the offline license server. To find the Ethernet address on the offline
license server:

•
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For RLM Server v13 and newer:

• On Windows: Go to Start > Boris FX RLM Server > Get RLM HostID
• On Mac: In a console type: /Library/Application Support/BorisFX/rlm/GetHostid.py
• On Linux: In a terminal type: /usr/borisfx/rlm/hostid_wrapper.py
For older versions of RLM Server:

• On Windows: Go to Start > GenArtsRLMServer > Get RLM HostID
• On Mac: In a console type: /Library/Application Support/GenArts/rlm/Get
Hostid.py

• On Linux: In a terminal type: /usr/genarts/rlm/hostid_wrapper.py
The command above will print out the results.
10 Get the first mac address from the first line: Hostid of this machine.
11 Enter the mac address into the online License Server or Node-lock hostid field.
12 Enter the number of licenses that should be locked to this server in the License
count (for floating licenses) field. Or just enter 0 to assign all licenses to the
specified server.

13 Click Next.
14 A default license location will auto-populate in the License File to create or edit
field. Replace the default location to a location that you can easily write to and
access the file, such as your Desktop or the Downloads folder.

15 Click Next.
16 On the Activation Request Data screen, verify all the information you have
entered, and click REQUEST LICENSE.

17 On the License Activation page, click on (Re)start License Server.
18 Then, on the Reread/Restart Servers page, click on Reread/Restart.
Silhouette User Guide
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19 Transfer the License File onto the offline license server and save the License File
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to the RLM directory.

For RLM Server v13 and newer:

• For Windows: C:\Program Files\BorisFX\rlm
• For Mac: /Library/Application Support/BorisFX/rlm/
• For Linux: /usr/borisfx/rlm/
For older versions of RLM Server:

• For Windows: C:\Program Files (x86)\GenArts\rlm
• For Mac: /Library/Application Support/GenArts/rlm/
• For Linux: /usr/genarts/rlm/
20 Open the License File in a text editor and edit the file with your offline server’s
Hostname.

21 Open a Web browser on the offline server, go to http://localhost:5054 and click
on (Re)Start License Server.

This completes the License server set up.
22 To confirm that the Boris FX license server is working, go to
http://SERVERNAME:5054

23 Replace SERVERNAME with the name of the server, and click Status on the top
left hand corner.

genarts should show up under the ISV Servers and it will say Running: Yes.
Now that everything is installed and activated, you no longer need the RLM
server installed on the temporary online computer – you can remove it at this
time.

Installing The Floating License On A Client Machine
(Manual Install)

If you haven’t yet installed the server license, follow the instructions above in
How do I Install the Floating License Server. Once you have the server
license installed, perform the following steps to get the client license running.

Install Floating Client License Using The License Window
1

Install Silhouette on the client machine.
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2

Get the host line from the server license, which looks like this: HOST
ServerName EthernetAddress PortNumber
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For example, HOST camelot 00000000042e 5053
3

Apply Silhouette.

4

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
5

Select Use floating license in the License window.

6

Enter the PortNumber and ServerName from the server license in the Server field
in the following format: port@ServerName. In the server license example above,
you would enter 5053@camelot

7

Click OK.

Your client machine is now connected to the license server.

Install Floating Client License Using a License File
1

Install Silhouette on the client machine.

2

Get the host line from the server license, which looks like this: HOST
ServerName EthernetAddress PortNumber

For example, HOST camelot 00000000042e 5053
3

Create a new file in a text editor called silhouette_client.lic. The file name is not
important, as long as the .lic extension exists.

4

Paste in the HOST line into the client license file and press enter to create a new
line.
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5

You can either keep the server Mac address in the client or replace it with the
word “any”. See example below.
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HOST camelot any 5053
6

Save the file to the appropriate location. For your particular system this is:

• For Windows: C:\ProgramData\GenArts\rlm
• For Mac: /Library/Application Support/GenArts/rlm/
• For Linux: /usr/genarts/rlm/
The next time you apply Silhouette, your client machine will connect to the
license server.

Install Floating Client License Using An Environment Variable
If you want to point to a license file via environment variable, use
genarts_LICENSE. It uses the usual RLM syntax, e.g:
genarts_LICENSE=5053@server-name
genarts_LICENSE=/path/to/file.lic
You can also set up the RLM environment variable to read all .lic files in a
directory:
genarts_LICENSE=your/rlm/directory
Note: The genarts in the environment variable name must be lower case.

Troubleshooting Floating Licenses

As with any software, problems may arise during the installation process.
Please take a moment to read our troubleshooting section and check for
common errors.
If you continue to have issues installing, please contact support and we will be
happy to help you. You may contact our support team here:
https://borisfx.com/support/open-a-case/

Verify Server License Has Been Successfully Installed
Check that your license actually exists on the Server.
For RLM Server v13 and newer:

• For Windows: C:\Program Files\BorisFX\rlm
Silhouette User Guide
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• For Mac: /Library/Application Support/BorisFX/rlm/
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• For Linux: /usr/borisfx/rlm/
For older versions of RLM Server:

• For Windows: C:\Program Files (x86)\GenArts\rlm
• For Mac: /Library/Application Support/GenArts/rlm/
• For Linux: /usr/genarts/rlm/

Verify License Server Software Is Latest Version
Check to make sure your License Manager is up to date.

Verify Firewall Is Not Running Between Server And Client
If your organization needs to run a firewall, you will need to check if the ports
for the RLM server are open for use.

Check That Silhouette Version Matches Activation Code
Check your purchase order to make sure everything matches up version wise.
It may be that you don’t have the correct version of Silhouette installed from our
download section. This is especially important for legacy software.

Check Conflicting Licenses Installed In Licensing Folder
If you have more than one Silhouette license installed on the server or client
machine check to make sure they are not expired licenses. While rare,
sometimes these licenses can conflict with any current ones you have on your
system.

The Client Does Not Connect Or See The Server Host Name
If your client machine does not connect to the server based on the server name,
try replacing the server name with the IP address of the server instead in the
license file. You can easily do this via the License Manager or via a text editor.

When In Doubt, Check The Logs!
Check logs and their paths: Read the logs from Silhouette and from your server.
They will tell you all about what is happening to your machine.
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Check Your Firewall Settings
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Check to make sure you are not restricted to using certain ports due to a firewall
or other admin permissions. When in doubt, temporarily turn your firewalls off
for the duration of the installation and then turn them back on when you are
done.

Check Your Host Name Settings
If your client machine is not able to connect to the server you may have a
networking issue. Try changing the server name on the client machine to the IP
address of the server instead when entering the port@host, or check to see if
your host has “.local” appended to the end of it.

Sometimes The Best Solution Is To Start Again
You might roll your eyes at this one, but try uninstalling, restarting your
machine, and installing the software again from scratch. Make sure you follow
installation directions off our website exactly. It sounds redundant, but
sometimes it’s a great way to troubleshoot what is going on inside your
machine.

When All Else Fails…
Contact us! Our support team are more than happy to help you fix any floating
license issues you may have. Please contact support here:
https://borisfx.com/support/open-a-case/

Installing Render Licenses

This section will discuss the installation of floating render licenses and how they
differ from standard interactive floating licensed.

Render Floating Licenses vs Interactive Floating Licenses
A render license is a specific kind of floating license that only allows rendering
of Silhouette project output.
When you are using a floating license, it is broken into two parts: The interactive
portion and the rendering portion.
1

If you open Silhouette (and a license is available) you are entering the interactive
portion.
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2

If you have Silhouette closed and are using the command-line renderer, you are
utilizing the rendering portion.
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If the interactive license is in use elsewhere or missing, the Silhouette GUI will
become unlicensed and attempting further work may encrypt your project if you
choose to save. If you have no interactive floating licenses available to render
with, additional render licenses can be helpful to let you free up interactive
licenses elsewhere.

Workflow For Render Licenses - Example 1
To help illustrate the Render License workflow, let’s look at the following
situation:

• 5 floating licenses (interactive)
• 10 render licenses (render only)
• There is only 1 user
The license server is operating with both sets of licenses.

• If only one person is using Silhouette on the network, there are 4 interactive and
10 render licenses still available to use.

• If only that one person was using Silhouette on the network, they would have 15
render machines available for use including the one they were working with.

• If another person started working and all machines were in use for rendering, their
version of Silhouette would be unlicensed, as there would be no available seats.

Workflow For Render Licenses - Example 2
To help illustrate the Render License workflow, let’s look at another situation.

• 5 floating licenses (interactive)
• 10 render licenses (render only)
• There are 5 users
The license server is operating with both sets of licenses.

• There are 5 people working in Silhouette.
• If another user tries to work on a 6th machine, they will open Silhouette
unlicensed, because all interactive licenses are in use.

• They open an existing Silhouette project (or render from the command line), they
will be able to render, because all render licenses are available.
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Now, what if one person wants to send off a render to the network?
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• If 5 people are using Silhouette on the network already, there would be 11 render

machines available for use including the one the user was presently working with.

• If another person stopped working in Silhouette, the interactive license would be

released, and a new machine would then be free to either use for work (interactive)
or render (non-interactive) by another user.

Installing Render Floating Licenses
The installation of a render license is exactly the same as that of a standard
interactive floating license. See Floating Licenses for a complete guide.

Run in Demo Mode

Runs Silhouette in a watermarked demo mode which does not allow saving,
exporting or rendering.
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Request A Trial
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Request a 15 day, unrestricted trial license.
Note: Internet access is required for nodelocked trial licenses.

Node-locked License Trial
1

Select Request a trial and click OK.

2

Fill out the Request Trial License form that appears and click OK.
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A 15 day trial license is automatically installed.
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Floating License Trial
1

Request a Silhouette floating trial license here: Contact Us

2

Fill out the required information indicating that you would like a Silhouette
floating trial license and if you have a current RLM license server, provide your
server’s Hostid and name.
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Applying the Silhouette Plug-in
1

Start your host application and apply Silhouette:

• After Effects: Apply Silhouette Paint to a clip in the timeline from the Effects >
Boris FX Silhouette menu.

• Premiere Pro: Apply Silhouette Paint to a clip in the timeline from the Effects >
Video Effects > Boris FX Silhouette group.

• OFX: The method for applying an OFX plug-in varies. Consult the OFX software
documentation for details.

2

To use Optional Clone Sources inputs in Silhouette:

• After Effects/Premiere Pro: Select the layers using the Optional Clone Sources >
Input 1-2 pop-up menus.

• OFX: For node based hosts, connect sources to the Silhouette node’s Input 1-2
inputs. For layer based hosts, select the layers using the Silhouette plug-in’s
Optional Clone Sources > Input 1-2 pop-up menus.

Note: In Vegas, when an optional clone source is required, create two tracks with the
clone source on the bottom track and the foreground (what you are painting on) on the
top track. Silhouette Paint is then applied to the top track by clicking the Composite
Mode icon in the track controls, navigating to the Custom > Boris FX Silhouette
category and selecting Silhouette Paint.

3

If you want to preserve the source alpha, change the Source Alpha parameter to
Preserve Alpha.
Note: By default, the source alpha is cleared. This is so you can use roto shapes to
assist in painting.

4

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
5

When prompted, enter the name of your Silhouette project, set the Working
Depth and click Create Project.

In most cases, the Working Depth should match the host application’s bit depth.
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Silhouette provides a wide variety of paint tools that are organized into Presets,
Brush, Profile and Paint tabs.

In addition, a number of different brushes are selectable from the Paint Toolbar
to the left of the Viewer.
Black & White
Blemish
Blur
Detail
Clone
Color
Color Correct
Dodge
Burn
Cutout
Drag
Eraser
Grain
Mosaic
Repair
Scatter
Stroke
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Once a brush is selected, its controls appear on the left side of the Paint
window.

1
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Select Paint using the Node Selector at the top left of the Viewer.

You can select either the Paint or Roto nodes. Once selected, the node’s
Toolbar and parameters appear.
Silhouette internally is a node based system and is made up of Paint, Roto and
Source nodes. The Source is connected to the Roto node and the Roto node
to Paint. This allows you to create shapes and trackers in the Roto node to be
used in Paint for tracking paint strokes as well as holdout mattes for painting.
2

Select the Color brush (Shift-C). By default, it is preset to white.

3

Paint on the image in the Viewer by pressing and dragging with your pen or
clicking and dragging with your mouse. You can quickly draw straight lines if you
press Alt, click and then click in a different location. If you keep Alt depressed
while clicking, you will create interconnected straight lines.
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4

In the Paint window’s Profile tab, adjust some of the settings to see how it
changes your brush.
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In addition to the Profile > Size control, the brush can also be resized by using
the [ and ] bracket keys in the Viewer or by holding Ctrl/Cmd and dragging the
brush outline.
5

Experiment with some of the other brushes in the Brush Toolbar.

6

Adjusting the brush parameters located on the left side of Paint window will
change the effect of the brush when you paint.

By default, you are painting on the RGB channels of the image. However, you
can paint individually on the red, green, blue or alpha channels as well as
simultaneously paint on the RGB and alpha channels using the Paint tab.

7

In the Paint window’s Paint tab, click on R to paint only the Red channel.

8

Paint on the image.

9

If you view the individual Red, Green and Blue channels using the RGBA buttons
in the Viewer, you will see that only the Red channel is affected.

10 Select the horizontal white bar above the RGBA buttons to quickly toggle the
display of the image back to full color mode.
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At any time, you can clear all paint strokes and restore the original unpainted
frames by using Delete in the Paint tab. You can restore the Current Frame, the
Work Range, or All Frames.
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11 In the Paint tab, select Delete > All Frames to clear all paint strokes on all frames.
12 Go to frame 1 of the clip and paint on the image.
13 Advance to frame 2.
As you change frames in the clip, the painted frames are stored to disk. Paint
on the current frame is also saved with File > Save.
14 Go back to frame 1 and you will see that your paint stroke has been recorded.
15 Paint some more frames in the clip.
As frames are painted, a marker is shown in the Timebar to provide a visual
display of which frames are painted.
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Paint Presets
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Brush presets can be saved using the Presets tab on the left side of the Paint
window. It allows you to save all of the brush parameters as a preset.
1

To save a preset, select a brush and adjust its controls.

2

Click Save and then choose one of the numbered presets.

Note: Saved presets are highlighted blue. Clicking a blue preset after selecting Save
will overwrite it.

Once saved, you can use the Alt-0 through Alt-09 keyboard shortcuts to
quickly select one of the presets.
3

Clear a paint preset by pressing Save, then Alt-clicking on the preset.
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Onion Skin

•
•
• 40
•
•
•

The Viewer > Onion Skin mode is useful for creating frame by frame, hand
painted animations. Onion Skin does a mix, as defined by the Mix value,
between the current frame and either previous or later frames.
1

Click the Onion Skin icon in the Viewer and then the down bracket to reveal the
controls.

By default, Onion Skin is set up to display a mix to the previous frame.
2

To change the Onion Skin frame range, adjust the Backward/Forward numeric
fields.
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Clone Brush
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Paints with sampled pixels from an image with the ability to grade (color
correct), blur, sharpen or warp the clone source.

Selecting the Clone Source
1

Choose the Clone brush (C) from the Toolbar.

2

In the Clone controls, select Output, Foreground or Input 1-2 in the Source popup menu.

Output is the painted output and when selected, clones from previously painted
areas. Foreground clones from the foreground image, while Input 1-2 are
optional clone sources which must be hooked up in the host application before
launching Silhouette.
Note: Resolve does not allow more than one input for plug-ins that use custom user
interfaces. A future Resolve software update will be required to accommodate multiple
inputs.

3

If you’d like, set the Frame parameter to choose which source frame to paint
from.
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Setting the Clone Offset
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Set your clone source offset by one of the following methods:

1

Shift-clicking, dragging and releasing in the Viewer.

2

Press and hold down the Shift key. Click once to set the clone source and click
once again in a different location to set the Clone target.

3

Press Q (Translate), W (Rotate) or E (Scale) and click and drag to translate, rotate
or scale the clone source. Onion Skin mode is automatically activated once the
Q, W or E key is pressed. Press whatever key you pressed (Q, W or E) again to
deactivate the mode.
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4

Turn on Interactive mode and use the on-screen controls.
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• Use the up, down, left and right arrow keys to nudge the clone source.
• Adjust the Position (Offset), Scale, Rotate, and Corner-Pin > TL (Top Left), TR (Top
Right), BL (Bottom Left) and BR (Bottom Right) numeric fields.

Clone Transform On-Screen Controls
Shortcut

Action

Drag within large center circle

Moves the clone source

Shift-drag within large center circle

Constrain clone source movement horizontally or
vertically

Drag the center square horizontal and vertical Scales the clone source horizontally or vertically
halfway points
Drag a center square corner

Proportionally scale the clone source

Drag large center circle

Rotate the clone source

Ctrl/Cmd-drag large center circle

Rotates the clone source with finer control

Drag handles on corners of image

Corner-pins the clone source

Drag dash above large circle

Skews the clone source horizontally

Drag dash to the right of large circle

Skews the clone source vertically
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Setting the Clone offset on different images
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Oftentimes, you need to align the same feature in two different frames of a clip
when painting with the Clone brush.
1

In the Clone controls, select Output, Foreground or Input 1-2 in the Source popup menu and then set the Frame parameter to choose which source frame to
paint from.

2

Press the ‘ key (located to the left of 1 key).

The clone source image automatically appears in the Viewer.
3

Set the Onion-Skin mix to 100.

4

Click on the clone source feature that you want to paint from.

The Clone target image automatically appears in the Viewer.
5

Click on the Clone target feature that you want to paint on.

The Clone offset is set.

Dual Clone Brush

Two Clone presets can be activated at once. This allows you to paint from two
different images or locations, using separate Transform, Grade/Filter and Warp
settings.

1

Select the number 1 Clone preset.

2

Set the clone source Transform, timing, Grade/Filter and Warp controls.

3

Choose the number 2 Clone preset and set its clone source Transform, timing,
Grade/Filter and Warp controls.

4

Press the Dual icon below the presets.
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A Mix control now appears at the top right of the Clone controls.

5

Change the Mix parameter to set the relative opacity of the two clone sources.

6

When you paint, both Clone presets will contribute to the painted result.
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Define a Clone Transform Region

You can change the position and size of the Clone transform on-screen control
rectangle which allows the effect of the corner-pin to be controlled from a
specific region.

1

Press the Region button to enable it.

2

Click-drag to create a region.

3

Alt-click and drag to create new region when one already exists.

4

Click and drag inside a region to move it or drag the region handles to resize.
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5

When you are ready to adjust the Clone transform, enable Interactive mode.
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Note: When there are no on-screen controls (center square and circle) within the Clone
transform bounding box, a region is active.

6

Use the on-screen controls to adjust the clone source.

The effect of the corner-pin is now controlled by the region, and the scale and
rotation anchor points are set to the region’s center.
7

To clear a region, enable Region and tap outside a region box without dragging.

Using Brush Compare Modes With the Clone Brush

Four brush compare modes preview brush settings prior to painting. You can
choose from Onion Skin, Align, Vertical Split and Horizontal Split.

The Caps Lock key toggles the compare modes on and off.
Note: The compare modes are not available for the Drag, Repair, and Cutout brushes.
Onion-Skin and Align mode only work with the Clone brush.

1

Activate Onion Skin or compare mode if you need to line up the clone source and
target images.

• Select the Onion Skin icon to activate it and then align the clone source.

or

• Select the Align icon to activate it and then align the clone source.
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Align inverts the clone source and mixes it with the foreground, creating an
embossed effect when similar images are not aligned. When perfectly aligned,
the Viewer appears gray or black depending on the state of the Paint > Clone
> Alignment Type preference.
Aligned
Not Aligned

2
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Once the clone source offset is set, deactivate Onion Skin or Align mode by:

• Clicking the selected icon.
or

• Pressing the Caps Lock key to toggle the compare mode off.
Very often, you will encounter two images from the same location that are not color
matched.

3

If the clone source needs to be color corrected to match the area to be painted,
select the Grade/Filter tab.

4

Choose the Vertical Split icon to compare the clone source and target using a
split screen.

The split is handy when using the Grade/Filter controls to color match the clone
source to the target.
Note: The | key (vertical bar) keyboard shortcut snaps the vertical split position to the
cursor position.

5

Adjust the Gain/Gamma/Lift numeric controls by dragging on them.
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6

Click the Lock icon to move the numeric fields individually. This un-gangs them.
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Note: Once a Grade/Filter or Warp parameter has been adjusted, a green dot appears
to the right of the tab to indicate that a change was made.

7

Prior to painting, click the Vertical Split icon to disable it.
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Automatic Color Correction
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The Grade/Filter > Auto Grade feature automatically color corrects the clone
source to match the location you are painting.

1

Select the Grade/Filter tab.

2

Enable Auto Grade.

3

Paint a stroke.

Now, when you paint, Silhouette automatically color corrects the clone source
to match the location you are painting.
Note: The Gain, Gamma, Lift, Hue and Saturation controls are disabled when using
Auto Grade.

Manual Color Correction

The steps below contain some useful tips when doing manual color correction.

1

Select the Grade/Filter tab.

2

Make sure Auto Grade is not enabled.

3

Choose the Vertical Split icon to compare the clone source and target using a
split screen.

The split is handy when using the Grade/Filter controls to color match the clone
source to the target.
4

Move your cursor into the image area over the split line and when the cursor
changes to a double-arrow, click and drag to move the split line to the location
where you will be painting and where you want to do the color matching. The
split line may not be obvious, so white triangles on the edges of the Viewer will
help you find it.

By isolating individual color channels, it is easier to match the colors.
5

In the Viewer, look only at the Red channel (Alt-R).
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6

Ctrl/Cmd-drag (for finer accuracy) the Gain > Red numeric field so that the
luminance values on either side of the split line match.
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Tip: Set your Update mode to Drag or Adaptive. As you drag a parameter, Silhouette
is constantly rendering. This makes the color adjustments more interactive.

7

In the Viewer, look only at the Green channel (Alt-G).

8

Ctrl/Cmd-drag (for finer accuracy) the Gain > Green numeric field so that the
luminance values on either side of the split line match.

9

In the Viewer, look only at the Blue channel (Alt-B).

10 Ctrl/Cmd-drag (for finer accuracy) the Gain > Blue numeric field so that the
luminance values on either side of the split line match.

11 Press Alt-B again to toggle off the Blue channel and to display the RGB channels
in the Viewer at the same time.

Your clone source and target should now be color matched.
12 Toggle off the Vertical Split and paint the image.
13 To reset the Clone offset, press Shift and without moving the cursor, click your
mouse or tap your pen on the screen once.

The Clone offset is quickly set to a 0,0 offset.
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Using Clone > Warp

•
•
• 51
•
•
•

The Warp tab in the Clone Brush allows you to warp specific image areas using
pins, while leaving other areas untouched. Adjustments can range from subtle
nip and tucks to something more obvious like repositioning an arm or leg.
After

Before

Photo by Tim Easley on Unsplash
1

Choose the Clone brush (C) from the Toolbar.

2

Select the Warp tab.

When the Warp tab is selected, Onion Skin mode is automatically activated so
you can see the warp effect once a pin is added.
Tip: Change the Mix value to 100 if you want to see the warped image at 100%.

3

Click-drag on the image to create a pin that contains a source and target.The
farther the target (red circle) is dragged from the source (green circle), the more
the image warps. You can add up to 20 pins.

4

To constrain the warp, click-release on the image to set a tack.
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The tack acts as a barrier and limits the effects of the warp.
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Target
Source
Tack

In addition, each pin and tack has a radius which determines its strength.
5

Hover over a pin to display the radius.

6

Shift-drag the pin radius to adjust it.

7

To track the pins and tacks, select a tracked layer from the Warp > Transform
pop-up menu.

The pins and tacks are now transformed by the motion of the tracked layer.
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Display Roto Shape Outlines In Paint
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Roto shape outlines can be displayed in Paint. This is useful to determine the
edge of a shape’s alpha channel without viewing it.
1

Select Roto using the Node Selector at the top left of the Viewer.

The Roto node is where the shape tools are located.
2

Create a shape around an object. See the Roto tutorial for more information.

3

Select Paint in the Viewer > Node Selector.

4

Enable Show Shapes in the Paint tab.

The shape outlines from Roto can now be seen in Paint.
5

Enable Obey Alpha with Alpha Source set to Foreground.

Painted strokes will now only appear within the area of the Foreground alpha.
6

Click Invert Alpha to paint outside of the input alpha.

See the Obey Alpha - Use Input Alpha section for more information.
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Alpha Channels
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Alpha channels can be used to control where you paint in the RGB channels
with the source of the alpha coming from an image or by painted strokes. Alpha
channels can also be painted on and modified.

Obey Alpha - Using Painted Alpha
Paint Temporary Alpha

Painting temporary alpha can limit where you paint in the RGB channels.
1

Select the Color brush (Shift-C).

2

Enable only the A channel in the Paint tab.

3

Press the A key once to superimpose the alpha channel over the image.

Now when you paint, you will see the alpha channel superimposed as a blue
color over the RGB channels.
4

Paint over an area of the image.

5

Press the A key twice more to remove the alpha overlay.

6

Disable A and enable RGB.

Obey Alpha
1

Enable Obey Alpha in the Paint tab.

2

Set the Alpha Source to Output.

Output uses the painted output alpha as the obey alpha source.
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3

Paint some strokes.
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When you paint, you can only modify the RGB channels in the area of the
painted alpha.
4

If you’d like, enable Invert Alpha to paint the RGB channels anywhere but where
the alpha exists.

Obey Alpha - Use Input Alpha

The alpha from source layers and images can be used to control where you
paint.

1

Enable Obey Alpha in the Paint tab.

2

Set the Alpha Source to Foreground or Input 1-2.

• Foreground: Obeys the alpha from the Foreground input or the Roto node’s
shapes.

• Input 1-2: Obeys the alpha from the Clone sources.
3

Paint some strokes.

When you paint, you can only modify the RGB channels in the area of the input
alpha.
4

If you’d like, enable Invert Alpha to paint the RGB channels anywhere but where
the alpha exists.

Note: To view the input alpha, you will need to switch the View pop-up menu to the
source containing the alpha.
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Detail Separation In Paint
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Paint separates the image into color and detail layers. By default, the color and
detail layers are painted simultaneously in Normal mode, but can also be
painted separately in Color and Detail modes. Painting in Color mode
preserves detail while painting in Detail mode preserves color.

Preserving Detail

Selecting Color mode preserves detail and only affects the color layer. This is
useful for evening out the color and tone of the image.

1

Click the Color button in the Paint tab.

2

Select View > Detail Layer or press the 9 keyboard shortcut.

The Detail Layer is now displayed in the Viewer.
3

Click the pop-up menu to the right of Detail Level field and select the Fine preset.
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This sets the Detail Level to 1 which selects fine details such as skin blemishes,
pores, hair, and wrinkles. A Detail Level of 0 is coarse detail, .5 is medium detail
and 1 is fine detail.
Original
Coarse

Medium
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Fine

Note: You can also variably set the Detail Level using the numeric field.

4

Select View > Output or press the 1 keyboard shortcut.
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The output of Paint is now displayed in the Viewer.
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Note: With the exception of Cutout and Eraser, all brushes can be used in the Color
and Detail modes.

5

Use the Dodge brush (Alt-Shift-D) to lighten areas in the image or the Burn brush
(Alt-Shift-B) to darken areas in the image.

Color Only - Before

Color Only - After

As you paint, only the color layer is affected and detail is preserved.
6

Use the Clone, Blur and Drag brushes to even out the color and tone.
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Modify Detail
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Selecting Detail mode preserves color and only affects the detail layer.

1

Click the Detail button in the Paint tab.

2

Select View > Detail Layer or press the 9 keyboard shortcut.

The Detail Layer is now displayed in the Viewer.
3

Drag in the Detail Level field to set a value of 1.

A value of 1 selects fine details.
4

Select View > Output or press the 1 keyboard shortcut.

The output of Paint is now displayed in the Viewer.
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5

Select the Clone brush (C), set an offset and paint in an area of texture.

Detail Only - Before
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Detail Only - After

The detail is modified and the color layer is preserved. Fine details in this
example are removed without affecting with the color and tone.
6

Use the Color brush (Shift-C) with a 50% gray color to remove texture completely.
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Auto Paint is a highly unique automated paint feature that records all paint
activity with tight integration of both point and planar trackers. Paint strokes can
be match moved or stabilized giving Silhouette the speed of raster paint with
the repeatability of vector paint. The beauty of the system lies in the automatic
recording of the paint strokes and brush settings. Individual paint strokes can
be selected and repeated over many frames, as well as deleted. If the original
footage changes, the entire paint history can be used to rebuild the painted
shot, automatically.

Replay Last Stroke
1

Paint a stroke.

2

Change to a different frame.

3

Press Replay in the Auto Paint window.

The last stroke is replayed on the new frame. Replay can be used to apply the
last stroke with changed settings and/or on a different frame.

Event Playback
1

Go to frame 1 and paint some strokes.

Groups are created each time painting is started on a frame and recorded with
the current time stamp. So the first time you begin painting on frame 1, for
instance, a renamable “event group” containing a current time stamp is created.
Then, events are created for the current paint state: channels/flags, brush
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profile, brush, and brush parameters. And finally, a new stroke event is created
for the new stroke. After the first stroke, state changes are stored in their own
events (ie. Brush Size change, Opacity, etc).

2
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In the Paint History, select the frame number group, paint event group, or a sub
set of the paint events you want to play back.

or
3

Choose the Stroke (S) tool and select strokes by clicking or drag selecting in the
Viewer. Hold Shift to add to the selection and Ctrl to toggle the selection.
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When strokes are selected, they are highlighted in the Viewer and the Paint
History.

4
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In the Auto Paint window, choose an option from the Frame Range pop-up menu.

If you choose Custom, you will be able to enter values in the numeric input
fields.
5

Press either the Play Selected Events Forward or Backward icon in the Auto
Paint window.
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This will play back all of the selected events for the desired frame range. The
playback is smart, so if you try to play back starting on the frame from where
the source events are coming from, it will skip this frame and just move on to
the next.

•
•
• 64
•
•
•

As it plays, Silhouette copies the paint events from the start frame on to the end
of the history for successive frames, as if you were manually performing those
events.

Event Playback - Tracking Paint Strokes

Let’s suppose you want to paint out some facial blemishes on frame 1 and
apply those strokes to the rest of the clip, while taking into account the camera
movement. With Silhouette’s Auto Paint features, you can easily do this by
playing back the paint strokes from frame 1 and using tracking data to match
move the strokes on successive frames.

1

Select Roto using the Node Selector at the top left of the Viewer.

The Roto node is where the Tracker tool is located.
2

Choose the Tracker (Shift-T) in the Toolbar.
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3

Track the area that you want to paint. See the Tracker tutorial for more
information.

4

Select Paint in the Viewer > Node Selector.

5

Choose a brush and paint some strokes that you would like to duplicate over the
entire clip.
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For this image, I used the Blemish brush to remove acne from the girl’s face.

6
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Select a tracked layer in the Paint tab’s Transform pop-up menu.
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7

Enable Match Move located at the bottom of the Auto Paint window.
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Activating Match Move will use the tracking data from the selected layer and
apply it to the paint strokes when playing back selected events.
8

In the Paint History, select the paint event group or a sub set of the paint events
you want to play back. In this example, selecting the top group is good.

9

In the Auto Paint window, select All Frames from the Frame Range pop-up menu.

10 Press either the Play Selected Events Forward or Backward icon in the Auto
Paint window.

The paint strokes from the start frame are duplicated on successive frames with
tracking data applied to them so they will follow the motion of the clip.
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Event Playback -Tracking the Clone Source
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Tracking the clone source is useful for when you want the clone source to
match the motion of the clip you are painting on.

1

In the host application, make sure you first select both a foreground and Clone
source before opening the Silhouette interface.

2

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
3

Select Roto using the Node Selector at the top left of the Viewer.

The Roto node is where the Tracker tool is located.
4

Choose the Tracker (Shift-T) in the Toolbar.
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5

Track the area that you want to paint. See the Tracker tutorial for more
information.

6

Select Paint in the Viewer > Node Selector.

7

Choose the Clone Brush (C) in the Toolbar.

8

Select the Clone source by choosing Input 1 from the Clone > Source pop-up
menu.
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9

Choose a tracked layer in the Paint tab’s Transform pop-up menu.

•
•
• 70
•
•
•

10 Enable Source Match Move in the Clone transform controls.

Selecting a layer and activating Source Match Move in the Clone transform
controls applies the tracking data of the selected layer to the clone source. In
this configuration, the painted clone source is match moved.
11 Paint some strokes that you would like to duplicate over the entire clip.
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For this image, I am painting a graphic into the face of the watch.
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Once you are done painting the frame, you can then duplicate it over the rest
of the clip.
12 Enable Match Move located at the bottom of the Auto Paint window.

Activating Match Move will use the tracking data from the selected layer and
apply it to the paint strokes when playing back the events.
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13 In the Paint History, select the paint event group or a sub set of the paint events
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you want to play back. In this example, selecting the top group is good.

14 In the Auto Paint window, select All Frames from the Frame Range pop-up menu.

15 Press either the Play Selected Events Forward or Backward icon in the Auto
Paint window.

The paint strokes from the start frame are duplicated on successive frames with
tracking data applied not only to the paint strokes but to the clone source as
well.

Rebuild

The Rebuild feature in the Auto Paint window will rebuild the paint events for all
frames defined in the Frame Range in the order in which they were painted.
This is useful if you replace your footage with a different color correction than
the original and want the result of painting with the Clone brush to match the
new footage.

1

In the Auto Paint window, select All Frames from the Frame Range pop-up menu.

2

Click the Rebuild button in the Auto Paint window.
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Planar Trackers

Silhouette includes two Planar Trackers: Silhouette’s Planar Tracker and the
Mocha Planar Tracker. Regardless of which one you use, the workflow is the
same.
The key to getting the most out of the Planar and Mocha trackers is to learn to
find planes of movement in your shot which coincide with the object that you
want to track. Sometimes it will be obvious--other times you may have to break
your object into different planes of movement. For instance, if you were tracking
a tabletop, you would want to draw a spline to avoid a flower arrangement in
the center of the table, since it is not on the same plane and will make your track
less accurate.
Both the Planar and Mocha trackers require a selected layer with at least one
shape in it to drive the tracker.

Note: If shapes are selected and not in a layer, clicking the Track Forward/Backward
buttons will create a new layer, select it and begin tracking.
If shapes are selected in an unselected layer, clicking the Track Forward/Backward
buttons will select the layer and begin tracking.

1

Select Roto using the Node Selector at the top left of the Viewer.

The Roto node is where the Tracker tool is located.
2

Go to the frame where you want to start tracking.

3

Set the View to Foreground for the fastest speed when tracking. In the
Foreground view, no processing occurs and therefore it is faster than View >
Output.
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4

Create a shape around the object that you would like to track and make sure that
there is some detail inside of the shape. It does not have to be exact and it is best
to leave a little extra room around the object. In addition, you can use more than
one shape as long as they are on the same geometric plane. See the Roto tutorial
for more information

5

Choose the Tracker (Shift-T) in the Toolbar.

6

In the Tracker tab located at the bottom of the screen, select either the Planar
Tracker or Mocha Tracker tab.

7

Enable Preview in Pre-Processing.
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The image in the Viewer becomes black and white and displays the color space
that you will track in.
8
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Select the color space to track with in the Channel pop-up menu.

Pick the color space that displays the best contrast in the object you are
tracking.
9

Disable Preview in Pre-Processing.

10 Select the tracking shape you created in the Object List.
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11 Hit either the forward or backward track button depending on which direction
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you are tracking.

Both the Planar and Mocha trackers require a selected layer with at least one
shape in it to drive the tracker.
Note: If shapes are selected and not in a layer, clicking the Track Forward/Backward
buttons will create a new layer, make it active and begin tracking.
If shapes are selected in an unselected layer, clicking the Track Forward/Backward
buttons will make the layer active and begin tracking.

12 When the tracking is done, that’s it, you're done.
The tracking data is automatically applied to the selected layer.
13 After tracking, if you are not happy with the results, try the different techniques
listed in Planar Tracking Tips and Tricks and Mocha Tracker Tips and Tricks.
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14 If you want to use Stabilization, click the Stabilize icon above the Viewer and

•
•
• 77
•
•
•

choose either the Active Layer or a layer from the list.

The Viewer is now stabilized based on the selected layer’s tracking data.
15 Make shape adjustments and keyframe it as necessary using the Reshape and
Transform tools.

16 When shape editing is complete, click on the Stabilize icon (if it was activated)
and select None to turn it off.

The Viewer is returned to its normal state.
Silhouette User Guide

•
•
•
•
•
•

Tutorials

Exclude Areas While Planar Tracking
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In some cases, there are parts of an image that can interfere with the
effectiveness of the Planar or Mocha trackers. To handle this, you can create
subtractive shapes to exclude those areas from tracking.

Exclude Shape - To Be Tracked
When the exclude shape should be tracked by the Planar or Mocha trackers,
create a subtractive shape above the primary tracking shape.
1

Create a shape around the object that you would like to track.

2

Create a shape around the area that you would like to exclude from the tracking
process. Set the shape’s Blend mode to Subtract.

3

Place the subtractive shape above the primary tracking shape.

4

Select both shapes.

5

Hit either the Track Forward or Backward button depending on which direction
you are tracking.

Note: When shapes are selected and not in a layer, clicking the Track
Forward/Backward buttons will create a new layer, make it active and begin tracking.

Now the area within the subtract shape is not analyzed by the Planar or Mocha
trackers.

Exclude Shape - No Tracking
When the exclude shape should not be tracked by the Planar or Mocha
trackers, create a subtractive shape above the layer to be tracked.
1

Create a shape around the object that you would like to track and place it in a
layer.

2

Create a shape around the area that you would like to exclude from the tracking
process. Set the shape’s Blend mode to Subtract.

3

Place the subtractive shape above the layer containing the primary tracking
shape.
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4

Select the layer you are tracking and then add the subtract shape to the selection
by using Ctrl/Cmd-click.
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Note: The same method used for shapes to exclude areas while tracking can be used
for layers.

5

Hit either the Track Forward or Backward button depending on which direction
you are tracking.

Now the area within the subtract shape is not analyzed by the Planar or Mocha
trackers.
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Offset Planar Tracking Using Layers
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There are times when the object you are planar tracking becomes obscured,
and in these instances, you can use a layer to compensate for the obscured
object.

1

Track an object using either the Planer Tracker or the Mocha Tracker.

2

When the object you are tracking becomes obscured or the track fails, hit the
Cancel button in the Tracker Progress window.

3

Back up to the last properly tracked frame.

4

Select the Timeline tab at the bottom left of the screen.

5

After this point in the Timeline, delete any Transform:Matrix keyframes for the
tracked layer.

6

Click on Transform (T) in the Toolbar.
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7

Set Transform keyframes for the selected layer at the last properly tracked frame
by enabling the Animate icon for the layer parameters that you will be adjusting.

Off

8
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Enabled

Move the Timebar forward to where the object you are tracking is no longer
obscured and animate the layer parameters so that your shape matches the
object you are tracking.

The manual keyframes you set take care of the animation of the object while
the object was obscured.
9

Choose the Tracker (Shift-T) in the Toolbar.

10 If you are using the Planar Tracker, press the Reset button to reset the track
points to account for the new location. This sets a new Reference point.

11 Hit either the forward or backward track button depending on which direction
you are tracking.
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Smoothing Planar Tracked Layers
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Smoothing planar tracked layers removes inaccuracies in the tracking data.
1

Select a layer which has been planar tracked.

Once selected, the layer displays tracking paths on the four corners and in the
center of the frame.
2

Zoom into one of tracking paths on a corner of the image.

Viewing the path while adjusting the Smooth slider will provide visual feedback.
3

In the Tracker tab, choose Smooth and adjust the slider when it pops-up.
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The planar tracked layer is smoothed.
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Group Tracking
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Multiple layers containing non-overlapping shapes can be tracked as separate
planar surfaces.
1

Select multiple layers that contain non-overlapping shapes.

2

Track using the Planar Tracker.

Each layer is tracked as a separate planar surface.
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Part Tracking
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Part Tracking uses multiple layers that contain overlapping shapes to aid in
tracking non-planar surfaces.
1

Select multiple layers that contain overlapping shapes.

Make sure there is a good overlap between the shapes.

2

Track using the Planar Tracker.

The overlapping shapes share coarse motion, but have individual motion at the
fine scale. This is helpful when tracking non-planar surfaces.
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Planar Tracking Tips and Tricks
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If you have trouble tracking a shot using the Planar Trackers, here are some
tips and tricks.

General Tips and Tricks
Scrub Your Timeline

When starting a track, go through your footage a few times to see what your
best options are for tracking. You will save yourself a lot of time by making note
of obstructions and possible problem areas in advance.

Change The Tracking Features
By default, Tracking Features is set to Auto which tracks corners, edges and
ridges simultaneously and then automatically selects the best result. Changing
from Auto to Corners, Edges or Ridges may yield a better result.

Switch The Motion Model
Perspective is the default motion model, but Affine (tracks translation, rotation,
scale, and skew) or Translation (tracks the XY offset) may better choices for
your clip. In general, use Perspective for tracking larger shapes, Affine for
medium shapes and Translation for small shapes.

Use Edges

When tracking surfaces, you will usually get a much better track if you include
the edges and not just the interior of an object. This is because the Planar
Trackers can define the difference between the background and the foreground
and lock on better.

Track From The Largest, Clearest Point

In order for Planar Trackers to keep the best possible track, it is usually best to
scrub through the timeline and find the largest and clearest area to begin
tracking from, draw your shape there, then use backwards and forward tracking
from that point.
For example, if you have a shot of a sign coming toward you down a freeway,
it is usually better to start at the end of the clip where the sign is largest, draw
your shape and track backwards, rather than start from the beginning of the
clip.
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A Planar Surface Does Not Necessarily Have To Be Flat
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We have a Planar Tracker which specifically tracks planes of motion, but this is
not limited to tables, walls and other flat objects. Faces can be tracked very
successfully around the eyes and bridge of the nose. Rocky ground, rumpled
cushions, clumps of bushes, human torsos and curved car bodies are all good
candidates. The key is low parallax or no obvious moving depth. When in
doubt, try quickly tracking an area to see if it will work, as you can quite often
trick the Planar Trackers into thinking something is planar.

Draw More Shapes

Remember you are not limited to one shape in a layer. Use a combination of
shapes to add further areas or cut holes in existing areas to maximize your
search.

Use Shapes Only For Tracking

You can use shapes for tracking purposes only and once the track is
completed, you can hide or delete them.

Create Subtract Shapes

In some cases, there are parts of an image that can interfere with the
effectiveness of the Planar or Mocha trackers. To handle this, you can create
subtractive shapes in the area you are tracking.
Create a shape to subtract out areas of unwanted motion that may interfere
with tracking and keyframe the shape as necessary. Place this shape above the
layer that you are tracking and set the shape’s Blend mode to Subtract. Select
the layer you are tracking and then add the subtract shape to the selection by
using Ctrl/Cmd-click. Now when you track, the area within the subtract shape
will be excluded.

Track From Different Points In Time

Depending on the motion of the object to be tracked, you may get better results
if you track from the end to the beginning. You may also track from the middle
to the beginning and then from the middle to the end.

Use A Different Channel To Track On

Change the Channel parameter from Luminance to Red, Green or Blue. The
Channel parameter determines which image value the tracking algorithm uses.
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Utilize The Pre-Processing Filters
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Use the Blur, Sharpen, Contrast, Gamma, De-Noise or Remove Flicker preprocessing parameters.

Track The Foreground

Set the View to Foreground for the fastest speed when tracking. In the
Foreground view, no processing occurs and therefore it is faster than View >
Output.

There Is No Magic Bullet

The Planar Trackers are very flexible trackers and will save a lot of time, but
you will eventually run into a piece of footage that just will not track. Large or
continuous obstructions, extreme blur, low contrast details and sudden flashes
can all cause drift or untrackable situations.

Mocha Tracker Tips and Tricks
In addition to the Planar Tracker Tips and Tricks previously mentioned, here is
an important Mocha Tracker tip.

When In Doubt, Ramp Up Your Pixels
You can quite often get a great result with the default settings, but if you’re
getting a lot of drift, try setting the Min % Pixels Used value higher. The
processing can be slower, but you will usually get a much more solid track.
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Point Tracker

•
•
• 89
•
•
•

The Point Tracker uses trackers which are placed on distinguishable image
features.

Creating a Tracker
1

Select Roto using the Node Selector at the top left of the Viewer.

The Roto node is where the Tracker tool is located.
2

Select the Tracker (Shift-T) in the Toolbar.

3

Go to the frame where you want to start tracking.

4

Set the View to Foreground for the fastest speed when tracking. In the
Foreground view, no processing occurs and therefore it is faster than View >
Output.

5

In the Tracker window located at the bottom of the screen, select the Point
Tracker tab.

6

Press the Create button and a tracker is placed in the center of the image.

or
7

Alt-click on an open space in the image.
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As you pass your cursor over the image with the Alt key depressed, a zoomed
region to the right of the tracker aids in selecting your Match Area.
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Moving Tracker Components
1

Clicking and dragging directly on the Track point will move all components of the
Tracker: Match Area, Search Region and Track Point simultaneously.

2

Clicking and dragging within the area of the Search Region will move only the
Search Region.
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3

Clicking and dragging within the area of the Match Area will move both the
Search Region and Match Area simultaneously, leaving the Track Point at its
current location. This would be used for Offset Tracking when the original track
point becomes obscured.
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Scaling Tracker Components
1

Clicking and dragging on the corners of the Match Area bounding box scales
both the Match Area and Search Region.

2

Clicking and dragging on the corners of the Search Region bounding box scales
only the Search Region.

Tracking an Image
1

Adjust the size and position of the Match Area and Search Region.

2

Right-click on the tracker and select the color space to use in the Channel submenu.

3

Hit either the forward or backward track button.

Silhouette will analyze the motion for each frame in the clip.
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Offset Tracking
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There are times when your original Match Area gets obscured, and in these
instances, you can offset the Match Area and Search Region from the Track
Point.
1

Create a tracker and track a portion of the clip until the Match Area becomes
obscured.

2

Hit the Stop button in the Tracker Progress window.

3

Back up to the last properly tracked frame.

4

Click and drag somewhere within the Match Area and both the Match Area and
Search Region will move simultaneously, leaving the Track Point at its current
location.

5

Click the forward tracking button to continue tracking.

The Track Point follows the same path, but the new Match Area is used to
acquire the tracking data.

Tracking Difficult Shots
Some clips are difficult to track because of erratic motion or the occlusion of the
feature that you are attempting to track. In these cases, you can do a bit of hand
tracking using one of two methods:

• By pre-keyframing the tracker at various frames throughout the clip.
• Keyframing a shape and then creating tracker keyframes based on the shape’s
motion.

1
2

Keyframing the Tracker
Create a tracker.
Adjust the tracker to match the object at various frames throughout the clip.
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3

In the Tracker tab, change the Behavior to Key Frames.
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The Tracker Match Area will now use these keyframes as a reference while
tracking.
1

Create Tracker from Shape Center
Create a shape around the feature that you would like to track. Go to various
frames throughout the clip and adjust the shape to match the feature.

2

Select the Tracker tool and right-click on the shape.

3

From the pop-up menu, select Create Tracker from Shape Center.

A tracker is automatically created around the center point of the shape and any
shape keyframes are automatically applied to the Tracker.
4

In the Tracker tab, change the Behavior to Key Frames.

The Tracker Match Area will now use these keyframes as a reference while
tracking.
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Averaging Trackers
Averages multiple tracks into a new destination track. A common technique is
to track forwards from the first frame to the last, and then create a second track,
tracking backwards from the last frame to the first. These two trackers are then
averaged together to derive a more accurate track.
1

Select more than one tracker.

2

In the Tracker tab, choose Average.

A new averaged tracker is created.

Smoothing Trackers
Smoothing trackers removes inaccuracies in the tracking data.
1

Select a tracker to smooth.

2

Zoom into the tracker’s path.

Viewing the path while adjusting the Smooth slider will provide visual feedback.
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3

In the Tracker tab, choose Smooth and adjust the slider when it pops-up.
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The tracker is smoothed.

Merging Trackers
If you have multiple trackers that cover different frame ranges, they can be
merged into one tracker, automatically compensating for the different offsets.
1

Select multiple point trackers that cover different frame ranges.

For instance, you may have one tracker that covers frames 1-25, another 2575 and the last one from 75-100. Ideally, the trackers should overlap in time by
at least one keyframe.
2

Click the Merge button.

A new tracker is created that covers the frame range encompassed by the three
trackers.
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Match Moving and Stabilizing Layers
In general, tracking data should be applied to layers instead of individual
shapes. The tracking data is copied into the transform of a layer (containing
shapes) allowing you to have separate keyframes for both the layer
transformation and for the shapes. This results in far fewer shape keyframes
than other methods and is the preferred way of working with clips in motion.
The result is a very flexible method for discrete editing of layer and shape
transformations.
Once applied to a layer, the tracking data can be used in Match Move or
Stabilize mode. In Match Move mode, the clip moves as normal and the shape
follows along according to the tracking data. In Stabilize mode, the clip is locked
in place by stabilizing the Viewer. In either mode, you only need to keyframe
the shape when it changes form.
1

Select the trackers that you would like to use.

2

Press the Apply button.

• With only trackers selected, clicking Apply creates a new layer and the tracking
data will be applied to that layer.

• If a layer is selected along with the trackers, the tracking data will be applied to the
selected layer.

You have a choice of applying position, scaling and/or rotation. However,
scaling and rotation require two trackers.
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3

Select Position, Rotation and/or Scaling and click OK.
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The tracking data is applied to the Layer’s > Transform > Matrix parameter.
4

Create a shape inside of the layer.

If you look at various frames in the clip, you’ll see that the shape is match
moved to the motion of the image.
5

If you want to use Stabilization, click the Stabilize icon above the Viewer and
choose either the Active Layer or a layer from the list.

The Viewer is now stabilized based on the selected layer’s tracking data.
6

Make shape adjustments and keyframe it as necessary using the Reshape and
Transform tools.
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7

When shape editing is complete, click on the Stabilize icon and select None to
turn it off.
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The Viewer is returned to its normal state.
Each layer can have different tracking data applied to it. Just go to the Tracker
tab and apply the motion from other trackers to other layers.

Four Point Corner-Pin Tracking
Four-point tracking is traditionally used to match the perspective of a square or
rectangular shape by tracking its four corners and applying a corner-pin
transformation.
1

Create four trackers on the corners of a square or rectangular object and track
the motion.

2

Create a layer in the Object List using the Add Layer icon.

The new layer is active and you can tell by the check mark icon in the box to
the right of the layer name in the Object List.
Note: Point tracking data is only applied to the active layer.

3

Select the four trackers.

4

Press the Apply button.

The corner-pin data from the four trackers is applied to the layer.
5

Create a square shape inside of the selected layer. When drawing the shape, it
should be placed near the location of the four trackers.

If you look at various frames in the clip, you’ll see that the shape’s motion is
matched to the motion of the image.
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Match moving applies the motion of a tracker to individual points on a shape.
Note: Match moving individual points results in keyframes being set on every frame of
the shape and can make it cumbersome to later edit those points. This functionality has
been added to Silhouette as some users prefer to work with this way.

1

Select a tracker.

2

Click on a shape to select it and then select a point.
Note: To select points on a shape, you must first select the shape by clicking on the
shape outline. Then, Ctrl/Cmd-click each point that you would like to select. Also, when
a tracker overlaps a point, it will be difficult to select the point while in the Tracker. To
select a point that overlaps a tracker, switch to the Reshape tool, select the point and
switch back to the Tracker.

3

Right-click over a selected point and choose Apply from the pop-up menu.

The tracking data is applied to the point.
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If you have trouble tracking a shot using the Point Tracker, here are some tips:

• Set the View to Foreground for the fastest speed when tracking. In the Foreground
view, no processing occurs and therefore it is faster than View > Output.

• Stop the tracker, go to the bad frame and reposition the Track Point, and hit the
tracking button again. You don't need to go back to your start frame.

• Lower the Tolerance value, and track again from the beginning, or the frame

before the bad frames. The lower the Tolerance, the more forgiving the tracker will
be--but also less accurate.

• Start over and switch Behavior from Start Frame to Every Frame. This means that
instead of trying to compare the tracking region with the first “pure” frame, it will
try to match to the previous frame. If you re-track from the middle of a clip, it will
consider your new start frame as your reference frame with either setting.

• Use the Blur, Sharpen, Contrast, Gamma, De-Noise or Remove Flicker preprocessing parameters.

• At any time, you can manually adjust the Track Point by simply grabbing it and
putting it where you need to.

• Change the Channel parameter from RGB to Luminance, Red, Green or Blue and
re-track. The Channel parameter determines which image value the tracking
algorithm uses.

• A technique you can use to assist with difficult shots is to manually insert tracking
keyframes. For example, if you have 100 frames to track, you can put in a keyframe
every 5 or 10 frames by repositioning the Tracker. Once your keyframes are
manually entered, return to frame 1 and set the Behavior to Key Frames. The
tracker searches along the tracker's pre-existing motion path to find matching
patterns.

• You can use the same technique as in the previous tip, but with the following

differences. Create a shape around the feature that you would like to track. Go to
various frames throughout the clip and adjust the shape to match the feature.
Select the Tracker tool and right-click on the shape. From the pop-up menu, select
Create Tracker from Shape Center. A tracker is automatically created around the
center point of the shape and any shape keyframes are automatically applied to
the tracker. In the Tracker window, change the Behavior to Key Frames. The
tracker Match Area will now use these keyframes as a reference while tracking.
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Exporting Tracking Data

Trackers can be exported to the After Effects, Autodesk, and Nuke tracker
formats. In addition, the tracking data applied to a layer, either by Point
Trackers or Planar Trackers, can be exported as a four point corner-pin track.
1

Exporting One to Two Trackers
Choose the Tracker (Shift-T) in the Roto Toolbar.

2

Select the trackers that you want to export.

3

Choose Export in the Tracker tab and select the tracker format.

4

When the window pops-up, type in a name and click Save.

Currently, you can export to the After Effects, Autodesk, and Nuke tracker
formats.
1

Exporting Four Trackers for Corner-Pinning
Choose the Tracker (Shift-T) in the Roto Toolbar.

2

Using the Shift key, select the four trackers that you want to export in a Z pattern:
Upper Left, Upper Right, Lower Left and Lower Right.

3

Choose Export in the Tracker tab and select the tracker format.

4

When the window pops-up, type in a name and click Save.

1

Exporting a Layer as a Four Point Corner-Pin
Select the layer that you want to export.

2

Press the Tracker (Shift-T) in the Toolbar, Choose Export in the Tracker tab and
select the tracker format.

3

When the window pops-up, type in a name and click Save.
Note: When exporting a four point corner-pin track to Autodesk products, it is better to
use four trackers instead of the tracking information from a layer.
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Mocha Pro, After Effects Corner-Pin, Nuke 8 and above, or Simple Format
formatted trackers can be imported into Silhouette. If you would like to import
trackers from non-supported applications, simply export a Silhouette tracker in
Simple Format to see how it should be formatted.
1

Silhouette
Select the Tracker (Shift-T) in the Roto Toolbar.

2

Choose Import in the Tracker tab.

3

Select the Mocha Pro, After Effects Corner Pin, Nuke, Shake or Simple Format
tracker file that you would like to import and click Open.

If you select multiple trackers in the import dialog, more than one tracker can
be imported at a time.
4

If you used Copy to Clipboard when exporting to Silhouette Corner Pin in Mocha
Pro, you can paste the trackers into the Tracker.
Note: With some formats, the imported trackers may not line up with the tracked
feature. If so, use MultiFrame mode to move the tracker and it’s keyframes into the
proper location.

1

After Effects
Double-click on the tracker text file that you exported from Silhouette.

The value of the Comp Pixel Aspect Ratio line at the top of the exported tracker
file must match the Pixel Aspect Ratio in the After Effects Composition settings.
Edit the exported tracker file as needed.
2

Press Ctrl/Cmd-A to select all and Ctrl/Cmd-C to copy.

3

In After Effects, select a layer in the Timeline and press Ctrl/Cmd-V to paste the
Tracker Data.
Note: If you exported a limited work range in Silhouette, go to the start frame of the
work range in After Effects before pasting.

4

Open the Window > Tracker controls.

5

In the Motion Source pop-up, select the layer where you pasted the tracking data.

6

From the Current Tracker pop-up, select the Tracker that you just pasted. If you
only have one tracker, this would be Tracker 1.

7

Change the Track Type from Raw to one of the available options.

Silhouette User Guide

•
•
•
•
•
•

Tutorials

8

Click Edit Target and choose the layer that you would like to apply the motion to.

9

Hit Apply.

1
2
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Flame
Select the Stabilizer.
Click on the Imp button below the Track fields and select the tracker file that you
saved from Silhouette.
Note: When importing a four point corner-pin track in Flame, it is better to use four
trackers instead of the tracking information from a layer.

1

Nuke
Choose File > Import Script and select the tracker file that you saved from
Silhouette.
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Rotoscoping or “Roto” for short has become a generic term for drawing shapes
to extract, isolate or affect a portion of an image. It is tedious work, but it’s one
of the most important parts of the visual effects process. Within Roto, there are
all the tools needed to make quick work of any Roto job.
The Roto node is where you create shapes and trackers to be used in Paint for
tracking paint strokes as well as holdout mattes for painting.
Note: The shapes from the Silhouette Paint plug-in can’t be exported or rendered.

Tips

Creating usable shape animations can be a bit tricky with the most common
problem being edge chatter. Here’s a few tips to help you on your way.

Analyze the Clip
View your clip to determine the frame that requires the greatest number of
points to create the shape. It is easier to draw your shape on the most complex
frame as opposed to starting on a simpler frame and adding points later.

Select a Spline Type
In Silhouette, you can create B-Splines (also known as natural splines), XSplines, Bézier splines, Circles and Squares.

Create Shapes with Less Points
Use as many points as needed to create the shape, but avoid using more than
is necessary. The fewer the points, the easier it is to successfully animate the
shape. Unnecessary shape complexity inevitably leads to inconsistency when
editing points.

Create Multiple Shapes
Create multiple shapes to Roto complex objects. Drawing separate shapes for
the major parts of an object give you finer control over motion especially when
separate objects intersect with each other.
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Try not to individually move points in a shape unless absolutely necessary.
Moving points in groups will maintain consistency and eliminate edge chatter.

Use the Tracker
Use the tracker to analyze the motion of your clip and then apply that motion to
your shapes. This will cut down on the number of keyframes needed.

Keyframe, Keyframe, Keyframe
By editing your shape at various frames in the clip, Silhouette animates the
shape in between those keyframes. This saves you work. Make as few
keyframes as possible, but as many as needed so the shape properly follows
the object that you are rotoing. For instance, on a 80 frame clip, start by adding
keyframes at 1, 20 and 40. If more animation is needed, add keyframes at 10
and 30. Get the idea? Creating too many keyframes will cause the shape to
jitter or chatter.
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For the inpatient among you, here’s a Roto quick start. For all others, Roto
features are covered in more detail after this exercise.

1

Select Roto using the Node Selector at the top left of the Viewer.

A number of different tools are selectable from the Toolbar to the left of the
Viewer.
Transform
IK
X-Spline
Magnetic Freehand

Reshape
B-Spline
Bézier
Square

Circle
Tracker
MultiFrame
RotoOverlay
2

View your clip to determine the frame that requires the greatest number of points
to create the shape. It is easier to draw your shape on the most complex frame
as opposed to starting on a simpler frame and adding points later.

3

Select B-Spline (B) from the Toolbar.

4

Click on the screen to create a control point.

A control point is created.
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5

Add as many points as you like.

6

When finished adding points, click the first control point that you added to close
the shape.
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Use as many points as needed to create the shape, but avoid using more than
is necessary. The fewer the points, the easier it is to successfully animate the
shape.
Now that you have a shape, you can use either Reshape or Transform to
perform editing functions.
7

Select Reshape (R).

Reshape modifies shapes by adjusting their control points and tangents.
8

To move points, select one or more control points and drag the point or points to
a new location.

9

To add a new control point, Alt-click on a selected shape.

10 To delete control points, select them and press the Delete key.
11 Go to various frames in your clip and edit the shape using the Reshape tool.
As the shape is edited on different frames, a keyframe marker is shown in the
Timebar to provide a visual display of where there are shape keyframes. The
color of the markers is determined by the shape color. If multiple selected
shapes have a keyframe on the same frame, the most recently selected
object's color has precedence.

Next, instead of modifying the shape’s control points, try modifying the entire shape.

12 Click on Transform (T) in the Toolbar.

Transform affects an entire shape or a group of shapes
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13 Select a shape and use one of the on-screen controls to modify it.
Shortcut

Action

Drag within large center circle

Moves the layer

Shift-drag within large center circle

Constrain layer movement horizontally or vertically

Drag the center square horizontal and
vertical halfway points

Scales the layer horizontally or vertically

Drag a center square corner

Proportionally scale the layer

Drag large center circle

Rotate the layer

Ctrl/Cmd-drag large center circle

Rotates the layer with finer control

Drag small center circle

Moves the Anchor point

Q

Activates / Deactivates translation of selected layers

W

Activates / Deactivates rotation of selected layers

E

Activates / Deactivates scaling of selected layers

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments
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The Q, W and E keys allow you to quickly translate, rotate or scale selected
shapes while using the Transform tool.
14 Press the Q key to activate translation mode, the W key for rotation mode or the
E Key for Scale mode and click and drag to transform the selected shape. You
must press the Q, W or E key, whichever one was selected, a second time to
deactivate the mode.

Bézier

Bézier splines are defined by control points and tangents. The position of the
two tangent handles control the amount of a point's curvature.
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1

Select Bézier (Shift-B) from the Toolbar.

2

Click on the image to place the first control point.
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The starting control point is created and sets the direction of the shape’s path.
3

To extend the control point’s tangents, drag the cursor while keeping the mouse
pressed.

Although you can use the Reshape tool to later change a shape’s look after
drawing it, you can also use the same Reshape keyboard shortcuts to modify
a shape while drawing it. See Adjusting Bézier Curves for more information
on the various ways to change a control point’s tangents.
4

Click on the screen to add more control points.

5

When finished adding points, click the first control point that you added to close
the shape.

Use as many points as needed to create the shape, but avoid using more than
is necessary. The fewer the points, the easier it is to successfully animate the
shape.

B-Spline

In contrast to Béziers, B-Splines don’t use tangents and are created by only
using control points. The position of the points, their intensity settings as well
as their proximity to each other determine the curvature of the shape.

1

Select B-Spline (B) from the Toolbar.
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2

Click on the screen to create a control point.
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A control point is created.
3

Add as many points as you like.

4

When finished adding points, click the first control point that you added to close
the shape.

Use as many points as needed to create the shape, but avoid using more than
is necessary. The fewer the points, the easier it is to successfully animate the
shape.

X-Spline

A X-Spline is an intuitive and easily editable spline format whereby its points
can be of three different types: Cardinal, Corner or B-Spline.
Cardinal

Corner

1

Select X-Spline (S) from the Toolbar.

2

Click on the screen to create a control point.

B-Spline

A control point is created.
3

Add as many points as you like.

4

When finished adding points, click the first control point that you added to close
the shape.

Use as many points as needed to create the shape, but avoid using more than
is necessary. The fewer the points, the easier it is to successfully animate the
shape.
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You can snap the control points of an X-spline to edges of an object by using
the Edge Snapping tool.
1

Select some points on an X-Spline.

2

Press the Alt-S key to snap.

The points snap to the nearest detectable edge. Alternatively, start dragging the
points, hold the Alt-S key down and they will snap to the nearest detectable
edge. In some cases, the points may not snap to where you want them to. If
this happens, adjust the points manually.
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Creating A Magnetic Shape
Using the Magnetic Freehand tool, you can create a freehand shape with
magnetic properties. There are two methods of creating a magnetic shape:
Tracing or Strokes.

Tracing
Trace the cursor along the edge you want to follow and the shape boundary
snaps to the nearest edge.
1

Select Magnetic Freehand (Shift-F) from the toolbar.

2

Click once near the edge you want to start with.

3

Move your cursor along the edge you want to follow.

4

Click once any time you want to anchor the currently drawn path along the route
and a point is added.

5

If there is a tricky section of the edge that the Magnetic Freehand tool doesn’t
want to line up with, click-hold and drag to draw a freehand shape.
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If you want to draw off the edge of the frame, click-hold and drag while tracing
to switch to freehand mode.
6
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To complete the drawn line, click the first control point that you added.

Strokes
Draw temporary foreground (inside the shape) and background (outside the
shape) strokes for the object you want to create a shape around.
1

Define foreground areas by Shift-click-dragging.
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2

Define background areas by Alt-click-dragging.
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BG

FG

As soon as the first background stroke is drawn, an X- Spline is created around
the object.

3

Add additional foreground and background strokes as needed so that the shape
properly surrounds the object.

4

Press Esc to clear the foreground and background strokes as well as deselect
the current shape. You can now create a new magnetic shape or new
foreground/background strokes.

Creating A Freehand Shape
1

Select Magnetic Freehand (Shift-F) from the toolbar.

2

Click-hold and drag to create a freehand shape.
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To complete the drawn line, release the mouse on the first control point that you
added.
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Adjusting Detail
Magnetic and freehand shapes have a fairly high point count to match the
subtle changes in the line.The amount of points can be reduced or increased.
1

Select Magnetic Freehand (Shift-F) from the Toolbar.

2

Select an X- Spline in the Object List.

3

Adjust the Detail slider directly above the Viewer to reduce or increase the
number of points.

Adjusting the Detail reduces points for X-Splines created with the Magnetic
Freehand tool, while increasing points for normal X-Splines.

Square
1

Select Square (Shift-S) from the Toolbar.

2

Do one of the following:

• Click and drag in the shape of a square.
• To create a perfect square, hold down the Shift key while clicking and dragging in
the shape of a square.

3

When you release the mouse button, a square shape appears.
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Circle
1

Select Circle (Shift-C) from the Toolbar.

2

Do one of the following:
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• Click and drag in the shape of a circle.
• To create a perfect circle, hold down the Shift key while clicking and dragging in
the shape of a circle.

3

When you release the mouse button, a circular shape appears.

Open Shapes

Open shapes are good for rotoscoping strands of hair or thin objects.

1

Select either Bézier, B-Spline or X-Spline from the Toolbar.

2

Click on the screen to create a control point.

A control point is created.
3

Add as many points as you like.

4

When finished adding points, select the Reshape tool.

You can also press the Esc key to finish the shape.
5

Select the open shape and in the Object window, adjust the Stroke Width to set
its thickness and choose a Flat or Round Cap Style.
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Once you draw a shape, there are various ways to modify it. As the object that
you are attempting to Roto changes over time, you will need to adjust the shape
so that it exactly matches the object. The Transform tool affects an entire shape
or a group of shapes.

Shape Mode
Transform Shape Mode allows you to position, move, scale, rotate, shear or
corner-pin a shape or selection of shapes using the on-screen controls.

1

Click on Transform (T) in the Toolbar.

2

Select a shape.

3

Use one of the on-screen controls to modify the shape. See the tutorials to follow
for more detail on using the On-screen controls.
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Transform Points Mode allows you to position, move, scale, rotate, shear or
corner-pin a selection of points using the on-screen controls.
1

Using Reshape (R), select multiple points on the shape.

2

In the Toolbar, click on Transform twice (TT).

A bounding box with on-screen controls appears around the selected points
instead of around the entire shape.
3

Use one of the on-screen controls to modify the shape. See the tutorials to follow
for more detail on using the On-screen controls.

Moving Shapes
Shapes can be moved horizontally or vertically.
Note: The remainder of the Transform tutorials assume that Transform Shape Mode is
enabled in the Toolbar.

1

Make sure that Transform (T) Shape Mode is enabled.

2

Select a shape or series of shapes.
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Drag on the outline of one of the shapes.
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or
4

Press the Q key to activate translation mode and click and drag to move the
shapes.

5

You must press the Q key a second time to deactivate translation mode.

To constrain movement along an axis:
1

Select a shape or series of shapes.

2

Press the Shift key while dragging the outline of a shape. The movement is
constrained by the first direction (horizontal or vertical) that you drag in.

Nudging Shapes
Shapes can be nudged horizontally or vertically using the Arrow keys. One
press of the Arrow key moves the shapes 1 pixel. Using the Shift key in
conjunction with the Arrow keys moves the shapes 10 pixels.
1

Select a shape or series of shapes.

2

Use the Arrow keys to nudge the shapes.

Scaling Shapes
Scaling changes the size of the shapes.
1

Select a shape or series of shapes.

2

Drag any of the points on the shape bounding box.

or
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3

Press the E key to activate scaling mode and click and drag to scale.
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Note: The position of the cursor when E is pressed sets the anchor point for the
scaling.

To proportionately scale, hold down the Shift key when scaling.
4

You must press the E key a second time to deactivate scaling mode.

Rotating Shapes
Rotating changes the angle of the shapes.
1

Select a shape or series of shapes.

2

Ctrl/Cmd-drag on a shape bounding box corner handle.

or
3

Press the W key to activate rotation mode and click and drag to rotate.
Note: The position of the cursor when W is pressed sets the anchor point for the
rotation.

4

You must press the W key a second time to deactivate rotation mode.

Corner-Pinning Shapes
The corner points of a shape’s bounding box can be corner-pinned. For
instance, you could fit the corners of a shape into the corners of a billboard.
1

Select a shape.

2

Alt-drag the corners of the shape’s bounding box.
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Shapes can be sheared resulting in the shape being skewed horizontally or
vertically.
1

Select a shape.

2

Ctrl/Cmd-drag on the midpoints of a shape bounding box on either the horizontal
or vertical axis.

Anchor Point
A shape rotates around its center point, but scales from the opposite handle.
Moving the anchor point changes the center of rotation and scaling when using
the on-screen controls.
1

Press the

. (period key).

The Anchor Point is displayed on the screen.

2

Click and drag the Anchor Point to the desired location.

3

Select your shape and then rotate or scale it.

Notice how the shape rotates and scales around the Anchor Point.
Note: If more than one shape is selected, they will both rotate and scale around the
Anchor Point.

Copying and Pasting Shapes
Shapes can be cut(Ctrl/Cmd-X), copied(Ctrl/Cmd-C) and pasted(Ctrl/CmdV).
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A shape or selection of shapes can be easily deleted using none other than the
Delete key.
1

Select a shape or set of shapes.

2

Hit the Delete key.
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The Reshape (R) tool modifies shapes by adjusting their control points and
tangents.

Selecting Control Points
1

Select Reshape (R) from the Toolbar.

2

Select a shape.

3

Click on a single point to select it, Shift-click to add to the selection or Ctrl/Cmdclick to toggle the point selection.

Rectangular Selection
Control points can be selected by drawing a rectangular selection. This is the
default behavior.
4

Click and drag a rectangle over multiple control points.

A rectangular selection is created.
Note: A Shape > Freehand Point Selection preference controls whether freehand
selection is used by default. Pressing Ctrl/Cmd and dragging uses the non-default
method of selection. See the Shape Preferences for more information.

Freehand Selection
Control points can be selected by drawing a freehand polygon.
5

Ctrl/Cmd-drag in the Viewer to begin the selection. Once the selection is started,
release Ctrl/Cmd and complete the selection.

A freehand selection is created.

Adding Control Points
Adding control points assists in tracing more detailed objects.
1

Select a shape.

2

Alt-click on a selected shape to add a new control point.

Don’t click on an existing control point because it will move it instead.

Deleting Control Points
1

Select the control points and press the Delete key.
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Right-click on a control point and select Delete from the Reshape pop-up menu.

Moving Control Points
1

Select one or more control points.

2

Drag the point or points to a new location.

Nudging Points
Points can be nudged using the Arrow keys. One press of the Arrow key
moves the points 1 pixel. Using the Shift key in conjunction with the Arrow
keys moves the points 10 pixels.
1

Select a point or series of points.

2

Use the Arrow keys to nudge the points.

Magnet Mode
1

In the Toolbar, click on Reshape to cycle between Normal and Magnet mode.

2

Select a series of points.

3

Drag one of the selected points.
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Numbering Points
All points or a selection of points can be numbered.
1

Numbering All Points
Go to File > Preferences > Shape on Windows and Linux or Silhouette >
Preferences > Shape on Mac.

2

Set the Number Points preference to All.

3

Click OK.

Numbers are now displayed next to all points.
1
2

Number One Point or a Selection of Points
Using the Reshape (R) tool, select one or more points.
Right-click on one of the selected control points and select Tag.

The points are now tagged for numbering.
3

Go to File > Preferences > Shape on Windows and Linux or Silhouette >
Preferences > Shape on Mac.

4

Set the Number Points preference to Tagged.

5

Click OK.
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Numbers are now only displayed next to tagged points.
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Feather
Shape points can be feathered to create variable edged blurs on a point by
point basis.
1

2

Closed Shapes
Select Reshape (R) from the Toolbar.

Select a shape point and a red, outward feather handle appears. Dragging this
handle outward will pull the feather out.

After the initial drag, the outer feather point can be dragged around
independently.
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Multiple selected points can be dragged simultaneously and by a proportionate
amount. To move the shape and feather points simultaneously, press Shift
while moving the shape point.
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Note: The display of the feather handles can be hidden using Alt-F.

1

2

Open Shapes
Select Reshape (R) from the Toolbar.

Select an open shape, adjust the Stroke Width to set its thickness and choose
either a flat or round Cap Style in the Object window.

Once you've done this, additional per-point feather handles appear--a red one
for the Stroke Width and a green one for the Feather.

Just drag on the handles to make adjustments.

3

Multiple selected points can be dragged simultaneously and by a proportionate
amount.

Silhouette User Guide

•
•
•
•
•
•

Tutorials

Adjusting Bézier Curves
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The length and direction of a control point’s tangents direct the curve through
that control point.
Curve Join
Tangent Handle

Tangent
Control Point

Control points have two tangents that can extend from it. The path of the curve
through the control point is determined by the length and orientation of the
tangents. When you drag one tangent’s handle, the adjacent tangent moves as
well.
1

Select a control point on a Bézier shape.

2

Click and drag a tangent handle.

This adjusts the length of one tangent while retaining a fixed angle between the
two tangents.

3

Ctrl/Cmd-drag a tangent.

This adjusts both tangents simultaneously while retaining a fixed angle
between the two tangents.

4

Alt-drag a tangent.
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Only one tangent is moved which is useful for creating corners.

5
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Right-click over a control point and select Linear, Corner or Cardinal.

Linear adjusts both tangents one quarter the distance and in the direction of
their adjoining control points. Corner collapses both tangents to create a corner
point. Cardinal creates a smooth point where the curve passes smoothly
through it.

Extending Short Tangents
Sometimes a control point’s tangents are so close together that trying to modify
the tangent results in movement of the control point. If this is the case, you can
force the tangents to move without affecting the control point.
1

Press the Alt key while dragging the tangent.

Only the tangent will move, leaving the control point unaffected.

Moving Curve Segments
Normally, you move control points to adjust the form of a shape, but you can
also move the portion of the curve between control points.
1

Deselect all control points by clicking somewhere off the shape.

2

Ctrl/Cmd-drag a Bézier curve segment between control points.

Once you start dragging, the Ctrl/Cmd key can be released.
Note: The surrounding tangents remain smooth, but if you want to keep adjacent
tangents from moving, hold down the Alt key while dragging.
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Adjusting B-Splines
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B-Splines are created by only using control points and are simple to adjust. The
position of the points, their weight settings as well as their proximity to each
other determine the curvature of the shape. The weight (amount of pull on a
point) decides how sharp or smooth it is. Silhouette employs variable weight
intensities on a point by point basis.
1

Select a control point on a B-Spline shape.

2

Alt-drag the point to the right to create a corner point or Alt-drag to the left to
create a smooth point.

or
3

Alt-click to cycle through the preset weight settings of the point.

or
4

Right-click over a control point and select Corner or B-Spline.
Note: The Alt-click and pop-up menu preset weight settings for Corner and B-Spline
can’t be animated.

Adjusting X-Splines
X-Splines are created by using control points and then adjusting their weight to
coincide with one of the point types: Cardinal, Polygon or B-Spline. The point
type can even be somewhere in between one point type and another.
1

Select a control point on a X-Spline shape.

2

Alt-drag the point to the right. The tension of the point goes from Cardinal to
Corner to B-Spline.

or
3

Alt-click to cycle through the different point types.

or
4

Right-click over a control point and select Corner, Cardinal or B-Spline.

Converting B-Splines or X-Splines to Bézier Splines
You may convert your B-Splines or X-Splines to Bézier Splines at any time.
1

Select a B-Spline or X-Spline shape.

2

Select Actions > Edit > Convert to Bézier.
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Once you select Convert to Bézier, a couple of things happen. The visibility of
the B-Spline or X-Spline is toggled to off. A new Bézier Spline is created and is
named the same as the B-Spline or X-Spline but has an * at the end of the
name.
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Note: The Bézier conversion of B-Splines that use extreme, variable weight
adjustments will not exactly match the original B-Spline. Do not use extreme, variable
weight adjustments if you are planning on converting the B-Spline to a Bézier.

Copying and Pasting Shapes
Selected shapes can be cut(Ctrl/Cmd-X), copied(Ctrl/Cmd-C) and
pasted(Ctrl/Cmd-V).

Breaking Shapes
In the Reshape tool, closed shapes can be opened using the Break option from
the control point pop-up menu.
1

Select and right-click on a control point.

2

Choose Break from the pop-up menu.

The shape opens at the selected control point.

Closing and Extending Shapes
Shapes can be closed or extended with just a few mouse clicks. It is necessary
to use the Reshape tool to perform the following actions.
1
2
1
2

Closing Shapes
Select one of the control points at the end of the shape.
Alt-click on the other end point to close the shape.

Extending Shapes
Select a control point at either end of an open shape.
Alt-click somewhere off the shape.

Joining Open Shapes
In the Reshape tool, open shapes can be joined together.
1

Select one of the end points of the source shape by clicking on it.

2

Make sure both shapes are selected in the Object window.

3

Alt-click on one of the end points of the target shape.
Silhouette User Guide

•
•
•
•
•
•

Tutorials

The two shapes are now joined together as one.
4
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Repeat steps 1 and 3 for the two remaining end points to close the shape.

Note: The target shape inherits the attributes of the source shape.

Combine Shapes
Copies the selected control points from a source shape into a target shape,
placing them between two adjacent selected points in the target shape.
1

Select one or more points on a source shape.

2

Ctrl/Cmd-click the target shape in the Object List.

3

Select two adjacent points on a target shape.

4

Choose Combine Shapes from the pop-up menu.

The selected points from the source shape are copied between the two
selected points in the target shape.

Extract Shape
Extracts the selected points of a shape into a new closed shape.
1

Select three or more shape control points.

2

Choose Extract Shape from the pop-up menu.

The selected controls points are used to create a new closed shape while
removing the points from the original shape.
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IK (Inverse Kinematics)
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In computer graphics, inverse kinematics (IK) is a technique that provides
automatic movement of objects. It allows elements of an object to be linked,
such as the parts of an arm or leg, and causes them to move in a prescribed,
realistic manner. IK simplifies the process of rotoscoping jointed, segmented
figures by making the motion of each part related to the motion of the linked
parts. That way, you simply have to animate the starting and ending joints, and
the ones in between will adjust themselves and create more natural looking
movement.

1

To create an IK chain for an arm, create three layers.

2

Name the layers as follows: Arm, Elbow, Wrist.

3

Move the Elbow layer into the Arm layer.

4

Move the Wrist layer into the Elbow layer.

Your layers should look like this:

Create shapes for each layer.
5

Select the Arm layer and create a shape for the upper arm.

6

Select the Elbow layer and create a shape for the forearm.

7

Select the Wrist layer and create a shape for the hand.

The layers and shapes should look like this:

Now that the layers and shape have been setup, the joints need to be placed
by positioning the Anchor Point of each layer using the Transform tool.
8

Select the Arm layer in the Object List and activate the Transform (T) tool.
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9

Move the center Anchor Point on-screen control so that it is positioned at the top
of the shoulder.
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10 Select the Elbow layer and position the Anchor point at the elbow.
11 Select the Wrist layer and position the Anchor point at the wrist.
Your image will be different, but the joints should look something like this:
Joints

Arm

Elbow

Wrist

12 Select IK (Y) in the Toolbar.
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13 Select the Upper Arm, Forearm and Wrist shapes and an IK chain is built on the
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fly that flows up the shape's layer tree to the top-most layer.

Each layer’s Anchor Point becomes a joint in the IK chain. The “bones” are just
the connections between the layer anchors.
14 Click-drag a bone or shape to rotate the shape around the parent’s anchor point.
When animated, keyframes are automatically set for each layer’s rotation
parameter. However, you can explicitly set the layer rotation keyframes by rightclicking on a selected bone and a choosing Add Key.
15 Click-drag a joint to use IK to rotate all joints up the chain.
16 Alt-click-drag a joint to move the joint while attempting to keep other joints in
place.

IK greatly simplifies the rotoscoping of humans, animals and all manner of
jointed creatures.
Note: To quickly jump between the Reshape, Transform, and IK tools while editing a
shape, use the shortcut keys: R for Reshape, T for Transform and Y for IK. R, T and Y
are very convenient since they are right next to each other.
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MultiFrame
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MultiFrame modifies the Transform and Reshape tools to allow you to make
adjustments across all previously set keyframes or a selection of keyframes.

1

Select MultiFrame (M) in the Toolbar.

A red outline is drawn around the Viewer to let you know that MultiFrame is
active.
2

Drag the red ends of the MultiFrame range bar at the top of the Timeline to limit
the keyframes affected by MultiFrame.

The MultiFrame range is displayed in the status bar while it is being edited.
3

Select either the Transform or Reshape tools, make a selection and modify the
shape.

Only keyframes defined in the MultiFrame range are adjusted.
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RotoOverlay
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The RotoOverlay tool provides three options to visualize the selected shape’s
animation and motion blur: Motion Path, Motion Blur and Onion Skin.

1

Select RotoOverlay (O) in the Toolbar.

Once selected, a Roto Overlay window opens allowing you to select or deselect
various options.

2

View each option separately.

• Motion Path
Displays the shape’s motion path with visual indicators for frames and
keyframes.

3

Hold Alt over a motion path marker and the frame number is displayed in the
status bar. Click on the marker and the Timebar will jump to that frame.

Silhouette User Guide

•
•
•
•
•
•

Tutorials

• Motion Blur
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Displays a dashed line to show the width of the motion blur.

Note: When the Viewer is set to Foreground, this option allows you to visualize the
motion blur without rendering it. This provides a significant speed increase when using
many shapes with motion blur.

• Onion Skin
Shows the shape outline on previous and future frames.

4

Hold Alt over an onion skin shape and the frame number is displayed in the
status bar. Click on the shape and the Timebar will jump to that frame.
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5

Change the Onion Skin Frame Range in the Roto Overlay window. This
determines the amount of frames used in the onion skin.
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Note: The first numeric field displays the frames before the current frame while the
second numeric field displays frames after the current frame. By default, the two fields
are ganged together. Click the lock icon to decouple them.

As an alternative to using the pre-defined colors for the Motion Path, Motion
Blur and Onion Skin, you can use the default shape colors.
6

Enable Use Shape Color.

The color of the shape is now used for the selected overlay function.
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Importing Shapes
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Silhouette, Mocha Pro, After Effects, Commotion, Elastic Reality and Shake 4.x
SSF shapes can all be imported into Silhouette.

1

Choose File > Import and select the shape format that you would like to import.

A file browser opens.
2

Select the shape file to import and click OK.

The shapes are added to the current session.

Mocha Pro
Mocha Pro shapes and layers are imported into Silhouette using the Silhouette
Shapes format. If Copy to Clipboard was used in Mocha Pro instead of saving
to a file, the shapes and layers are copied to the system clipboard and can then
be pasted into the Silhouette Roto node.

Commotion
When importing Commotion shapes into Silhouette, the following shape
parameters transfer into Silhouette: shape visibility, shape locked state, shape
motion blur on/off state. If the shape is invisible in Commotion, it will start out
invisible in Silhouette, so it might not look like it was imported unless you have
the Object List open.

Shake
Shake 4.x shapes are imported into Silhouette, but attributes such as
feathering, color and opacity are ignored.
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Motion Blur
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Motion blur is the directional blurring of rapidly moving shapes. To use Motion
Blur, it must be activated for each individual shape as well as in the Roto node.
1

Select one or more shapes and enable Motion Blur in the Object window.

2

In the Node parameters, enable Motion Blur and adjust the Shutter Angle, Shutter
Phase and Samples as desired.

When working with motion blur, it is best to keep your View set to Foreground.
This way editing your shape will be quick and interactive.
3

Set your View to Foreground.
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When you need to view the motion blurred alpha channel, use Shift-A. Shift-A
toggles the View to Output, superimposes the alpha channel over the image
and deactivates the Overlay. Pressing Shift-A again returns the Viewer to its
previous state.
4
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To view the motion blurred alpha channel, press Shift-A.
Note: Normally, motion blur is calculated going forward, so if there is no shape motion
beyond the end of a clip, there won’t be motion blur on the last frame. To work around
this, add an extra frame or two to the end of the work range in the Timebar, make sure
Show Work Range is disabled in the Timeline context menu, and then move the
shape’s last keyframe to be outside of the Session range.

Renaming Objects
You can rename a shape, layer or tracker by:
1

Click on the object once to select it, hit the Enter key, type in the new name and
press Enter again.

or
2

Double-click the object, type in a new name and hit the Enter key.

or
3

Right-click on the object, select Rename and type in a new name.
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Timebar Keyframes
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Colored markers in the shuttle area signify where selected objects have
keyframes. These keyframes can be moved to a new position. Objects that
display keyframes in the Timebar are shapes, trackers and painted frames.
Path keyframes are shown for shapes, position keyframes for trackers and
painted frames when in the Paint node.

The color of the markers is determined by the object color. If multiple selected
objects have a keyframe on the same frame, the most recently selected
object's color has precedence.
1

Press Shift-Alt and hover over one of the colored markers.

2

When the cursor changes to a double arrow, click and drag the marker to a new
location.
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Timeline
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The Timeline is an overall view of all animated parameters. It provides you with
the tools necessary to view, edit, move or delete keyframes as well as change
their interpolation type using a Curve Editor.

Zooming the Timeline In or Out
1

Use the scroll wheel to zoom the Timeline in and out.

or
2

Shift-Middle-mouse drag in the Timeline.

Panning the Timeline
1

Use the Spacebar and click and drag to pan horizontally or vertically in the
Timeline.
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Changing the Work Range
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The Timeline displays the full session range with the work range displayed
using a gray bar at the top of the Timeline.

The work range can quickly be adjusted by:
1

Ctrl/Cmd-drag the ends of the work range bar to change the start and end.

2

Ctrl/Cmd-drag the work range bar to slide it forward and back while maintaining
the duration.

Moving One Keyframe
1

Click on a keyframe to select it.

2

Drag the selected keyframe to its new time.

Moving a Selection of Keyframes
1

Click on the starting keyframe to select it.

2

Shift-click on the ending keyframe.

A range of keyframes is selected.
3

Click and drag one of the selected keyframes to the new location.

All selected keyframes move to the new location.

Adding a Marker
1

Move the Timebar to the desired frame.

2

Right-click in the Timeline and select Marker > Create/Edit.

3

Enter the marker text and click OK.

A light blue marker is displayed at the top of the Timeline.
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Curve Editor
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The Curve Editor is a view mode in the Timeline that allows you to work with
keyframe animations expressed as curves on a graph. It allows you to visualize
the interpolation of the animation.

1

Animate a parameter by setting a couple of keyframes.

Once a parameter is animated, the Curve Editor icon appears to the right of the
parameter in the Timeline.

2

Enable the Curve Editor icon.

The Curve Editor appears at the bottom of the Timeline.

3

Use the + or = keys to zoom in, the - key to zoom out or Space Bar-move mouse
to pan the Curve Editor.

4

Click and drag a point to move it and Alt-click on the curve to add a new point.

5

Right-click on a keyframe in the Timeline or a point in the Curve Editor to bring
up the pop-up menu.

The pop-up menu allows you to change the keyframe interpolation.
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Viewer
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Color Management

Silhouette uses the OpenColorIO standard originally developed by Sony
Pictures Imageworks for its color management. You can load custom color
configuration files and custom LUTs, apply colorspace conversions, as well as
use other controls for fine tuning.

1

Make sure that the Display Options icon is enabled in the Viewer.

Silhouette automatically tries to determine the colorspace based on the data in
the file and other information from the header.
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2

If not set correctly, change the input colorspace of the current scene using the
Colorspace pop-up menu.
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When using Cineon/DPX images with the Color Management > Cineon/DPX
Working Space preference set to Linear, the input colorspace should be set to
Linear. When the preference is set to Log, the Cineon colorspace should be
used.
3

If you are using a custom OCIO configuration with multiple Display options,
choose the colorspace of the display using the Display pop-up menu.
Note: If there is only one Display option, the Display pop-up menu is hidden.

4

Select the colorspace transform to apply to the scene from the View Xform popup menu.

5

To adjust the brightness of the image in the Viewer, use the Viewer > Display >
Gain and Gamma settings.

You can select a custom OpenColorIO (.ocio) configuration file by choosing it
in the Color Management > OCIO Configuration preference.
For more information on OpenColorIO, including the OCIO file format, please
visit http://opencolorio.org/.
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Viewer RGBA Buttons
1
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Click on the Red, Green, Blue or Alpha buttons to solo that channel as a gray
scale image.

If only one component is selected, it is displayed in gray scale. The horizontal
white bar above the RGBA buttons quickly toggles the display of the image
back to full color mode.
2

Select the horizontal white bar above the RGBA buttons to quickly toggle the
display of the image back to full color mode.

3

Either press the Alpha button (to the right of the blue button) or the A key to cycle
the state of the alpha display.
Note: To view a shape’s alpha channel, you must first set the View to Output before
pressing the Alpha button or A key.

Hitting the Alpha button or A key once superimposes the alpha channel over
the image. Pressing a second time displays the alpha channel over black.
Hitting again shows only the color image.
Shift-A activates RGBA mode which does the following: Toggles the View to
Output, superimposes the alpha channel over the image and deactivates the
Overlay. Pressing Shift-A again returns the Viewer to its previous state.
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Viewer Navigation
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Zooming

1

Select a value between 25% and 500% in the Zoom pop-up menu.

or
2

Use the scroll wheel on your mouse to zoom in and out of the image.

or
3

Press Space Bar-Shift and move the mouse up to zoom in or down to zoom out.

or
4

Use the + or = keys to zoom in and the - key to zoom out.

Zoom and Centering Presets
1

Press the F keyboard shortcut or select Fit from the zoom pop-up window to
display the image as large as possible within the Viewer window.

2

Press the H keyboard shortcut or double-click the middle mouse button to set
the image to a 100% zoom level and center it in the Viewer.

3

Press Ctrl/Cmd-F to center the selected object in the Viewer.
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Viewer Rotation
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Rotating the Viewer can facilitate rotoscoping and painting.

1

Select the Rotate icon to enable Viewer rotation mode.

Once Rotate is enabled, the Adjust Rotation editing control (hand icon)
becomes available.
2

Press the Adjust Rotation icon to enable it.

3

Click and drag in the Viewer to set the angle.

Once the angle has been set, you will need to disable Adjust Rotation to use
the node’s tools.
4

Select the Adjust Rotation icon again to disable it.
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Opening Additional Viewers
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Open additional Viewers that can be set to any node or view.

1

At the top left of the Viewer, click the New Viewer icon.

A new viewer opens as a floating window.
2

Select the node to view.

The new Viewer has the following controls: Node, View, Update Mode,
Channels and Zoom. The remainder of the controls are shared with the main
Viewer.
Note: Multiple viewers from the same node have the option of being synchronized in
terms of zoom and pan using the Use Viewer > Synchronize Viewers preference.
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Optimizing Playback
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Silhouette can cache frames into RAM to guarantee real-time playback. When
you hit the play button, each frame is cached into RAM. Once the clip is played
through once, it will then play in real-time if enough RAM is available. At the
bottom right corner of the interface, there is a numeric readout (Cache Display).
It displays the length of your clip, the maximum frames that can be cached into
RAM, the percentage of RAM currently being used as well as the session’s bit
depth.

If your clip is longer than the maximum frames that can be cached into RAM,
the clip will not play in real-time.

Preload Frames
1

Play your source clip to cache it into memory.

Once cached, playback is instantaneous since the frames are already loaded.
In addition, source frames are also automatically cached in a background
thread. The amount of preloaded frames is controlled by a Cache > Preload
Frames preference with the default value being 10 frames.
2

Select File > Preferences on Windows and Linux or Silhouette > Preferences on
Macintosh.

3

Go to the Cache group.

4

If you’d like, you can change Preload Frames to a higher value.

5

Click Apply.

Increase Amount of Frames During Playback

There are number of ways to increase the amount of frames that can be played
back in real time.

1

Enable the Viewer > ROI (Region of Interest) to work on a sub-region of the
image.
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2

Select File > Preferences on Windows and Linux or Silhouette > Preferences on
Mac and increase the %Total Physical RAM parameter in the Cache preferences
(requires a restart of Silhouette to take effect). Please note that setting the %
Total Physical RAM too high could cause instability if running other memory
intensive programs.

3

When in the Roto node, change the View from Output to Foreground.

4

Shorten the length of the clip by adjusting the First and Last Frame in the
Timebar.

Silhouette User Guide

•
•
• 154
•
•
•

•
•
•
•
•
•

Tutorials

ROI (Region of Interest)
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ROI (Region of Interest) crops the image in the Viewer to a user defined size
and can be animated. This is especially useful when you only need to work
within a smaller region of a larger image as it will use less memory and process
faster. If expanded, the ROI will display overscan pixels which can then be
manipulated.

Using a Smaller ROI for Performance

The ROI can be made smaller than the session size to speed up processing
and save memory. This is especially useful when working with larger images.

1

Display the ROI controls by clicking the ROI icon above the Viewer.

Once the ROI icon is activated, the ROI controls appear above the Viewer.

2

Make sure the Enable button is active.

3

Drag one of the corner points to size the ROI.
Note: You can also Ctrl/Cmd-Shift-drag a square region in the Viewer to draw a ROI
region.

4

Move the ROI by clicking and dragging its bounding box.

5

Animate the ROI by enabling the Animate icon and adjust the ROI at various
frames.

6

To avoid moving the ROI by mistake after it has been set, disable the Viewer >
ROI icon.

This hides the ROI controls, but it is still active.
Note: To temporarily turn off the ROI effect, toggle the Enable icon.
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Using the ROI to Reveal Overscan Pixels
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If the source’s DOD (Domain of Definition) is larger than the session, the ROI
can expand to reveal overscan pixels which can then be manipulated.

1

Display the ROI controls by clicking the ROI icon above the Viewer.

Once the ROI icon is activated, the ROI controls appear above the Viewer.

2

Make sure the Enable button is active.

3

Click the Set ROI to DOD icon in the Viewer.

The ROI will automatically be set to match the size of the source’s DOD and
will reveal any overscan pixels.
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Keyboard shortcuts can be customized by using a text editor to modify a Python
script located in the scripts folder of your Silhouette installation.

To modify your Silhouette keyboard shortcuts:
1

Go to the scripts folder of your Silhouette installation.

2

For Windows, go to C:\Program
Files\SilhouetteFX\Silhouette[version]\resources\scripts.

or
3

For Linux, go to /SilhouetteFX/silhouette[version]/resources/scripts.

or
4

For Macintosh, go to /Applications/Silhouette[version], right-click on Silhouette
and select Show Package Contents.

A new Browser window opens.
5

In the new Browser window, go to Contents/Resources/scripts.

Inside the scripts folder, you will find a keybinds.py file. As a precaution, it would
be a good idea to make a backup of this file.
6

Make a copy of the keybinds.py file and rename the copy keybinds.py.bak.

7

Using a text editor, open the keybinds.py file.

8

Scroll down and replace the existing shortcuts with those of your choosing.

9

Save the file.
Restart Silhouette for the new keyboard shortcuts to be active.
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Silhouette internally is a node based system and is made up of Paint, Roto and
Source nodes. The Source is connected to the Roto node and the Roto node
to Paint. This allows you to create shapes and trackers in the Roto node to be
used in Paint for tracking paint strokes as well as holdout mattes for painting.
You can select either the Paint, Roto, or Source nodes. Once selected, the
node’s parameters appear in the Node window and the appropriate tools
appear in the Toolbar.

Host Application Plug-in Parameters
Silhouette Interface
Open

Opens the Silhouette user interface.

Optional Clone Sources
Inputs 1-2

Selects optional sources to use as Clone inputs.
For node based hosts, connect sources to the Silhouette node’s Input 1-2
inputs. For layer based hosts, select the layers using the Silhouette plug-in's
Input 1-2 pop-up menus.
Notes

• Resolve does not allow more than one input for plug-ins that use custom user
interfaces. A future Resolve software update will be required to accommodate
optional clone sources.

• Vegas supports 1 optional clone input.

Source Alpha

Controls whether the source alpha is used in Silhouette.

Clear Alpha
The source alpha is set to transparent.
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The alpha from the source (the image or layer Silhouette is applied to) is
passed to Silhouette.

Output Alpha

Determines the alpha output mode.

Brush Mask
Outputs an automatically generated alpha channel where the brush painted.

Painted Alpha
Outputs strokes painted in the alpha channel.

Source Alpha
Outputs the source alpha.

Hold Frame

Holds the currently painted frame for the entire sequence.
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When the Silhouette interface is opened, a New Project Dialog opens.

Note: Silhouette Standalone projects can be opened in Silhouette Paint, but Silhouette
Paint projects can’t be opened in the Standalone.

Name
Sets the project name.

Folder
Sets the folder path.

Working Depth
8 bit
Sets the bit depth to 8 bits per channel.

Float 16
Sets the bit depth to 16 bit floating point. Float 16 will have slightly less
precision than Float 32 but will take up much less memory.

Float 32
Sets the bit depth to 32 bit floating point. Float 32 will be higher precision than
Float 16, but will take up much more memory.
Note: In most cases, the Working Depth should match the host application’s bit depth.

Create Project
When a new project is created, a folder is generated using the name of the
project and contains the project file as well as paint data, autosave, and
backups

Open Project
Opens existing projects using a file browser. This allows loading Silhouette
Paint plug-in projects created in other host applications as well as Silhouette
standalone projects.
Note: If loading a Silhouette standalone project, it is best practice to use the Paint
Template when creating the standalone session and to not have more than one Paint
and Roto node. It goes without saying that the sources need to be hooked up to the
same inputs in both the standalone and plug-in.
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The Paint interface is comprised of Toolbar, Tool Tab, Auto Paint and Viewer
windows.

Viewer

Toolbar
Auto Paint

Tool Tab
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The Roto interface is comprised of Toolbar, Tool Tab, Object List, Parameters,
Viewer and Timeline windows.
The Roto node is where you create shapes and trackers to be used in Paint for
tracking paint strokes as well as holdout mattes for painting.

Viewer

Toolbar
Object List
Tool Tab / Timeline

Parameters
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Silhouette uses a Viewer for image editing as well as for clip playback. Some
features include viewing individual color channels and the simultaneous display
of RGB and alpha channels.

Node Selector

Selects either the Paint or Roto nodes. Once selected, the node’s Toolbar and
parameters appear.

Alt-] cycles between the Paint and Roto nodes.
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The New Viewer icon opens additional Viewers that can be set to any node or
view.

Note: Multiple viewers from the same node have the option of being synchronized in
terms of zoom and pan using the Use Viewer > Synchronize Viewers preference.

View

Offers various View options for the selected node. The View choices will
depend on the node and what inputs are used.
Paint

Roto

Update

Determines when processing takes place. The ! key cycles through the Update
modes.

Drag
Tries to process at the current resolution as fast possible.

Adaptive
Tries to process as fast possible by first processing a 4:1 proxy and then full
resolution.
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Processes once the mouse or pen is released. This the default setting.

Manual
Silhouette does not process. If you place the cursor within the Viewer window
and hit the Enter key, Silhouette will manually process any changes.

Proxy

Sets the viewer resolution. The higher the number, the lower the resolution.

The higher the proxy setting, the more frames you can play.

1:1
1:1 keeps the image quality at full resolution.

2:1
2:1 lowers the image resolution by 1/2.

3:1
3:1 lowers the image resolution by 1/3.

4:1
4:1 lowers the image resolution by 1/4.
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Onion Skin does a mix, as defined by the Mix value, between the current frame
and either previous or later frames. This is useful for creating frame by frame,
hand painted animations.

By default, Onion Skin is set up to display a mix to the previous frame.

Backward
Displays frames before the current frame.

Forward
Displays frames after the current frame.

Mix
Sets the Onion Skin mix value.

Snapshot

Captures the image in the Viewer so that it can be compared with other nodes
or Viewer modes using Toggle Snapshot, Vertical Split, and Horizontal Split
snapshot modes.

Toggle Snapshot
Cycles between the snapshot and the current image.
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Compares the snapshot and the current image using a vertical split. Move your
cursor into the image area over the split line and when the cursor changes to a
double-arrow, click and drag to move the split. Depending on the image, the
split line may not be obvious, so triangular sashes on the outside of the image
help you find it.
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Compares the snapshot and the current image using a horizontal split. Move
your cursor into the image area over the split line and when the cursor changes
to a double-arrow, click and drag to move the split. Depending on the image,
the split line may not be obvious, so triangular sashes on the outside of the
image help you find it.
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The Display Options icon reveals the color management options which remain
visible as long as it is enabled.

Silhouette uses the OpenColorIO standard originally developed by Sony
Pictures Imageworks for its color management. You can load custom color
configuration files and custom LUTs, apply color space conversions, as well as
use other controls for fine tuning. Silhouette includes a set of preset color
profiles, plus you can configure and use your own by specifying one in the Color
Management > OCIO Configuration preference.
For a more detailed explanation of OpenColorIO, including generating LUT’s
and suggested workflows, please visit http://opencolorio.org/.
Note: The color management functionality provided in the Display Options is for display
purposes only. The color profiles, LUTs, and colorspace conversions applied in the
Viewer do not affect the rendered image.

Color Management
Colorspace
Sets the input colorspace of the scene. The following colorspaces are provided:
Linear, sRGB, rec709, Cineon, Gamma 1.8, Gamma 2.2, Panalog, REDlog,
ViperLog, AlexaV3LogC, PLogLin, SLog, Raw.
Silhouette automatically tries to determine the colorspace based on the data in
the file and other information from the header. If a colorspace can’t be detected,
Linear will be selected.
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If you are using a custom OCIO configuration with multiple Display options, the
Display pop-up menu appears for you to choose the colorspace of the display.
The default OCIO configuration only has one display option. Additional devices
can be added in a custom configuration and will show up in this menu.
Note: When there is only one Display option, the Display pop-up menu is hidden.

View Xform (Transform)
Select a colorspace transform to apply to the scene. You can select from sRGB,
rec709 or None.

LUT
Select a custom LUT to apply to the scene.

Choose

A number of LUT formats are supported including: Flame, Lustre, Color
Correction Collection, Color Correction, Cinespace, Houdini, Iridas itx, Iridas
cube, Pandora mga, Pandora m3d, Sony Pictures Imageworks 1D, Sony
Picture Imageworks 3D, Sony Picture Imageworks mtx, Truelight and Nuke vf.
Note: Selecting a LUT disables the Colorspace and View Xform controls.

Clear List

Clears the LUT list.

Gain
Adjusts the brightness of the image in F-stops. Gain is applied before the
display transform.

Gamma
Adjusts the gamma of the image. Gamma is applied after the display transform.
Go to the Color Management tutorial to see how it works.

Silhouette User Guide

•
•
•
•
•
•

User Interface

ROI (Region of Interest)

•
•
• 172
•
•
•

ROI (Region of Interest) crops the image in the Viewer to a user defined size
and can be animated. This is especially useful when you only need to work
within a smaller region of a larger image as it will use less memory and process
faster. If expanded, the ROI will display overscan pixels which can then be
manipulated.

Go to the Region of Interest tutorial to see how it works.

ROI Controls
Once the ROI icon is activated, the ROI controls appear above the Viewer.

ROI Keyboard Shortcuts
Shortcut

Action

Initial click-drag bounding box

Sets the ROI

Click-drag bounding box points

Scales the ROI

Click-drag bounding box

Positions the ROI

Ctrl/Cmd-Shift-drag

Draws a new ROI

Enable
You can toggle the ROI effect on and off by clicking on the Enable icon.

ROI Manual Input
If you click on the numeric field to the right of the ROI label, the fields become
editable. Just click in the field you want to edit, type in a number and press the
Set button.
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Enable the animate icon and change the position or size of the ROI at various
frames.

Set ROI to Current DOD
The Set ROI to Current DOD icon automatically sets the ROI to match the size
of the source’s DOD (Domain of Definition). If the source’s DOD is larger than
the session, the ROI will expand revealing the overscan pixels which can then
be manipulated.

Note: The Transform > DOD node can change the DOD of any source.

Reset
Resets the ROI to the session size.
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The Magnifier opens a magnification window at the bottom right corner of the
Viewer and displays a zoomed area around the cursor location. It is useful for
precise control point, tracker and paint placement. The Magnifier is available in
the Reshape and Tracker tools as well as Paint.

Masks
Masks aid you in determining what will be projected on film or shown on
television by adding reticles and or a variable opacity mask to the Viewer.
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Creating Custom Masks
In the Silhouette/resources folder of your installation, there are two files:
formats.xml and masks.xml.
You can add your own custom masks to the masks.xml file. The rectangle
values are multiplied by the image width/height to figure out where the mask
should be placed. For example, Safe Action is a 90% rectangle, so the border
is .1, .1, .9, .9 (i.e. 10%, 10%, 90% 90%) of the image size.
You associate certain masks with certain formats by adding a “Mask” entry to
the formats in formats.xml. You can add any number of masks to each format.
These masks will be available in the mask selector in the Viewer, depending on
the session format.
Note: You can't associate masks with “custom” session formats. Instead, you should
add a new format to your formats.xml file if you have an odd format you want to use
with masks.
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The Viewer is stabilized based on the selected layer’s tracking data.

Rotate

Activates Viewer rotation mode. Shift-Ctrl/Cmd-R toggles the Viewer rotation
mode. Rotating the Viewer can facilitate rotoscoping and painting.

Adjust Rotation

Once Rotate is enabled, the Adjust Rotation editing control becomes available.

Adjust Rotation allows you to click and drag in the Viewer to set the angle.
Shift-R toggles the rotation editing mode on/off.
Go to the Viewer Rotation tutorial to see how it works.

Overlay

Toggles the display of overlays which are lines, shapes or objects that
Silhouette superimposes over the image. 0, the number zero, toggles the
overlay.
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Displays various combinations of the red, green, blue and alpha channels.

Selecting Channels
Clicking on the Red, Green, Blue or Alpha buttons solo that channel as a gray
scale image. The horizontal white bar above the RGBA buttons quickly toggles
the display of the image back to full color mode.

Solo Channels
Alt-R/G/B/A toggles the red, green, blue and alpha channels on and off.

Alpha Display
Cycle Alpha

Either press the Alpha button (to the right of the blue button) or the A key to
cycle the state of the alpha display. Pressing once superimposes the alpha
channel over the image. Pressing a second time displays the alpha channel
over black. Hitting it again shows only the color image.
Note: To view a shape’s alpha channel, you must first set the View to Output before
pressing the Alpha button or the A key.

Display Alpha - No Overlay

Shift-A toggles the View to Output, superimposes the alpha channel over the
image and deactivates the Overlay. Pressing Shift-A again returns the Viewer
to its previous state.

Display Roto Node’s Output Alpha

Alt+O toggles the view mode to Output and displays the alpha. Pressing Alt-O
again returns the Viewer to its previous state.

Alpha Mix

The numeric entry box next to the RGBA buttons controls the opacity of the
alpha channel when it is superimposed over the image.

Premultiply
You can premultiply the image in the Viewer by using Shift-0.
Go to the Viewer RGBA Buttons tutorial to see how it works.
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Activates pixel aspect ratio correction in the Viewer as defined in the session
settings. For instance, this lets you view Cinemascope ratio images as they
would appear when projected.

Zooming and Panning

Sets the zoom factor for the image.

25%-500%
Choose from one of the preset zoom percentages. 100% displays the image at
its actual size at a ratio of one image pixel to one screen pixel.
You can also zoom the image using the scroll wheel on your mouse, the + or =
keys to zoom in, and the - key to zoom out or press Space Bar-Shift and move
the mouse up to zoom in or down to zoom out.

Fit
Either pressing the F keyboard shortcut or selecting Fit from the zoom pop-up
window will display the image as large as possible within the Viewer window.

Home
You can either press the H keyboard shortcut or double-click the middle mouse
button to set the image to a 100% zoom level and center it in the Viewer.

Center Selected Object
Press Ctrl/Cmd-F to center the select object in the Viewer.
Go to the Viewer Navigation tutorial to see how to zoom and pan the Viewer.
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Viewer Keyboard Shortcuts
Shortcut

Action

F1

The composite workspace is displayed

F2

The Viewer is displayed full screen

F3

The Viewer and Timeline are displayed

F4

The Viewer and Trees window are displayed

F5

The dual monitor workspace is displayed

0

Toggles the display of overlays which are lines, shapes or objects

1-7 (Number Keys)

Switches the Viewer > View menu

~

Cycles through the update modes

A

Cycles the display between the full color image, the alpha channel
superimposed over the image, and the alpha channel by itself

Shift-A

Toggles the View to Output, superimposes the alpha channel over
the image and deactivates the Overlay

Alt-R/G/B/A

Toggles the red, green, blue and alpha channels on and off

Alt-O

Toggles the Roto node’s view mode to Output and displays the
alpha. Pressing Alt-O again returns the Viewer to its previous state.

Shift-Ctrl/Cmd-R

Toggles the Viewer rotation mode on/off

Shift-R

Toggles the Viewer rotation editing mode on/off

Shift-0

Premultiplies the image in the Viewer by the alpha

Alt-]

Cycles to next node in the Node pop-up menu
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Viewer Pan/Zoom Keyboard Shortcuts
Shortcut

Action

Middle-mouse drag

Pans the image

Space Bar-move mouse

Pans the image

+ or =

Zooms the image in

-

Zooms the image out

Shift-Middle-mouse drag

Zooms the image in and out

Scroll wheel

Zooms the image in and out

Space Bar-Shift-move mouse up/down

Zooms the image in and out

F

Fits the image in the Viewer

H or Middle-mouse double click

Centers the image in the Viewer at 100%

Ctrl/Cmd-F

Centers selected object in the Viewer

‘

Opens a context menu over pen/mouse location
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Along the left side of the Viewer is the Toolbar. It contains icons specific to the
selected tool--Paint or Roto.
Paint Toolbar
Roto Toolbar
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At the bottom of the Viewer is the Tool Tabs. It contains controls specific to the
selected tool--Paint or Tracker.
Paint Tool Tab

Tracker Tool Tab
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The Object List is where you can select, lock, combine, rename or delete
shapes, layers and trackers. Layers are containers for shapes and other
objects and have their own individual transforms.
Layer
Objects

Layer Icons
Shape Icons

Search

Searches for shapes, layers or trackers in the Object List.

Click the Search icon, enter an object name into the search field and it will
appear. Disable the Search icon when done to return to the normal Object List
window view.

Add Layer

Located at the bottom of the Object List, this icon creates a new layer. Layers
are used to organize shapes, trackers and other objects, but more importantly
they are used to contain the motion information from trackers.

Note: Dragging objects onto the New Layer icon will create a new layer and move the
objects into it in one operation.
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Select an object in the list and press Ctrl/Cmd-X, hit the Delete key or use the
Delete icon at the bottom of the Object List.

Renaming

You can rename an object by either:

• Clicking on the object once to select it, hitting the Enter key, typing in the new
name and pressing Enter again.

• Double-clicking the object, typing in a new name and hitting the Enter key.
• Right-clicking on the object, selecting Rename and typing in a new name.

Selecting

Clicking the name of an object selects it. Multiple objects can be selected by
Shift-clicking on them. Ctrl/Cmd-clicking will add to the selection of objects
that are located at different levels of the Object List while Ctrl/Cmd-clicking an
object after it is selected will deselect it. In addition, if you Shift-click a color pot
in the Object List, you select all objects of the same type and color.
Note: In File > Preferences > Shape on Windows and Linux or Silhouette >
Preferences > Shape on Mac, there is a Template Color setting that sets the color and
opacity of unselected shapes. This feature is enabled by using Shift-W.

Moving

Objects can be moved by dragging and dropping them to a new position in the
list or within another layer.

Expanding / Collapsing Layers
Expand All

Shift-clicking the +/- icon expands or collapses all nested layers inside that
layer.
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If expanding or collapsing a selected layer using +/- icon, then any other
selected layers with the same parent will also expand or collapse. This can be
combined with Shift to expand or collapse children as well.

Icons

Shape Icons
There are number of icons directly to the right of a shape’s name that can be
used to modify shapes. The Opacity, Blend Mode, Invert, Motion Blur and Color
icons duplicate the functionality of the Shape parameters in the Object window
and does so because it is often easier to change these settings in the Object
List when multiple shapes are selected.
Motion
Visibility
Opacity
Invert Blur Color
Blend Mode
Lock
Notes

Opacity
Indicates the opacity level of a shape. It is white when opacity is 100%, black
when 0% and a shade of gray when somewhere in between. When keyframing
is activated for Opacity in the Shape parameters, you can quickly keyframe the
opacity of a shape from 100% to 0% by toggling this icon.

Note: In File > Preferences on Windows and Linux or Silhouette > Preferences on Mac,
there is a Shape > Fade Outline with Opacity setting that draws unselected/inactive
shape outlines using the Opacity value. This preference can be toggled using the V key
so that you can easily see any shapes that are at 0% opacity.
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Controls how shapes are blended together. Each click of the icon cycles
through the blend modes. See the Blend Mode section for information.

Invert
Inverts selected shapes.

Motion Blur
Turns Motion Blur on or off for selected shapes.

Outline Color
Sets the color of selected shape’s outlines.

Left-clicking the color pot opens a standard color picker while right-clicking on
the color pot opens a pop-up color menu with 16 primaries.

Lock
Locks/Unlocks selected objects. A locked shape cannot be edited or changed
and is italicized in the Timeline.
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Click the Visibility icon to hide or show selected objects. Only visible shapes are
rendered. To solo an object, Alt-click on its Visibility icon. Alt-Ctrl/Cmd-click to
force the visibility of all objects to the on position.

Notes
Select an object and click the Notes icon to bring the Notes window forward
above the Object List.

You can type a note for selected objects. Currently, shapes, trackers, depth
objects, and layers are supported. Because you can type multiple paragraphs
into the Notes window, you must press Apply to assign the note. The Notes icon
changes once a note is applied to the object.

• Hovering over the Notes icon displays the note, if there is one, as a tool tip.
• The Status Bar displays the object name and the note for the selected object.

Layer Icons
There are some icons directly to the right side of a layer’s name that can be
used to modify layers.
Visibility
Color
Blend Mode
Active Layer
Invert
Notes
Lock

The Layer’s Blend Mode, Invert, Color, Lock, Visibility and Notes icons have
similar functionality to the ones used by other objects.
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The Active Layer box displays a check mark when the layer is selected.
Clicking the checkbox will toggle the state of the Active Layer.

Object List Shortcuts
Shortcut

Action

Click on an object

Selects the object

Shift-click an object

Adds an object to the current selection

Ctrl/Cmd-click on an object

Toggles the object selection

Shift-click color pot

Selects shapes of same color

Alt-click the Visibility icon

Solos an object

Alt-Ctrl/Cmd-click the Visibility icon

Forces the visibility of all objects to the on position

Shift-click the +/- icon

Expands or collapses all nested layers inside that layer

Double-click an object

Selects the object so it can be renamed
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Node

Parameters specific to the Roto and Source nodes appear in the Node
parameters window.

Note: The Paint node does not have any Node parameters.

Enable/Disable
Enables or disables the node.
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All of the editable parameters of a shape, layer or tracker can be adjusted in the
Object parameters window. When a shape is selected, you will see the controls
listed below.

Notes
The Notes window allows you to type a note for selected objects.

Silhouette User Guide

•
•
•
•
•
•

User Interface

Timebar / Player Controls

•
•
• 191
•
•
•

The Timebar below the Viewer provides you with controls to play your clips as
well as navigate your session.

First Frame

Current Frame

Play Menu

Keyframes

Shuttle Area

Last Frame

Player Controls

Current Frame Increment

Duration

Frame Rate

Timebar

Keyframe Markers
Colored markers in the Timebar shuttle area signify where selected objects
have keyframes. Objects that display keyframes in the Timebar are shapes,
trackers and painted frames. Path keyframes are shown for shapes, position
keyframes for trackers and painted frames when in the Paint node.

The color of the markers is determined by the object color. If multiple selected
objects have a keyframe on the same frame, the most recently selected
object's color has precedence. A white marker is used to signify the current
frame and hovering over a marker displays a tool tip showing the keyframe
time.
Shift-Alt-clicking and dragging a marker will move the keyframe in time.
Note: In the Paint node, selecting a paint tool ignores the object selection and displays
paint keyframe markers instead. To see the keyframe markers of selected objects,
select a non-paint tool like Reshape, Transform or Tracker.

First Frame
The numeric entry box on the left displays the first frame to be viewed. Enter a
new number in the numeric entry box to change the start frame and hit Enter.
Frame numbers located before the start frame, including negative numbers,
can be entered. This is useful when adjusting motion blur at the start of a shot.
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The numeric entry box to the right of the shuttle slider displays the last frame to
be viewed. Enter a new number in the numeric entry box to change the last
frame and hit Enter. Frame numbers located beyond the end frame can be
entered. This is useful when adjusting motion blur at the end of a shot.

Current Frame
The second numeric entry box to the right of the shuttle slider displays the
currently viewed frame. Enter a new number in the numeric entry box and hit
Enter to move directly to that frame.

Increment
The far right numeric entry box controls the amount of frames that the Viewer
increments from frame to frame.

Fields
When selected, the Fields button changes the Timebar and Timeline to
advance and display in half frame increments.

Play Menu
Changes the playback mode. The Play menu is located at the bottom-left of the
Viewer.

Once
Plays the clip once when you press the Play button.

Loop
Plays the clip in a continuous loop when you press the Play button.

Bounce
Plays the clip continuously, alternately forwards, then backwards when you
press the Play button.
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These controls affect playback.

Shuttle
Clicking and dragging in the shuttle area shuttles through the clip.

Previous Key
Moves to the previous keyframe.

Next Key
Moves to the next keyframe.

Home
Moves to the first frame.

Previous Frame
Step backward 1 frame.

Play Backward
Plays backward.
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Stops playback.

Play
Plays forward.

Next Frame
Step forward 1 frame.

End
Moves to the last frame.
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Playback Controls Keyboard Shortcuts
Shortcut

Action

Z

Step backward 1 frame

Shift-Z

Moves to the previous keyframe

X

Step forward 1 frame

Shift-X

Moves to the next keyframe

J

Plays backward

K

Stops or starts playback

L

Plays forward

Space Bar

Stops playback

Home

Moves to the first frame

End

Moves to the last frame

Click and drag in the shuttle area

Shuttles through the clip
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Shift-Alt-click and drag a keyframe marker Moves the keyframe in time

Frame Rate

Sets the frame rate for the clip in the Viewer. Enter the desired frame rate, for
instance: 24 fps (film), 25 fps (PAL), 29.97 fps (NTSC DF) or 30 fps (NTSC
NDF).

Duration

Displays the duration of the clip in the Viewer.
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RAM Cache

Silhouette can cache frames into RAM to guarantee real-time playback. When
you hit the play button, each frame is cached into RAM. Once the clip is played
through once, it will then play in real-time if enough RAM is available. At the
bottom right corner of the interface, there is a numeric readout (Cache Display).
It displays the length of your clip, the maximum frames that can be cached into
RAM, the percentage of RAM currently being used as well as the session’s bit
depth.

If your clip is longer than the maximum frames that can be cached into RAM,
the clip will not play in real-time.
Hovering over the Cache Display will reveal a tool tip that shows the maximum
cache size and total available physical memory in megabytes.

Go to the Optimizing Playback tutorial to see how you can playback the
maximum amount of frames.

Purge RAM Cache
The RAM cache can be purged by double-clicking on the Cache Display. The
currently cached frames are then cleared from RAM.
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The Timeline is an overall view of all animated parameters. Animation is the
process of setting values at various frames, or keyframes as they are called.
These keyframes transition from one to another over time. The Timeline
provides you with the tools necessary to view, edit, move or delete keyframes
as well as change their interpolation type.

The Timeline is divided in three parts:

• Parameter List: lists all animateable parameters for a particular process.
• Timeline: displays keyframes over time.
• Curve Editor: The Curve Editor is a view mode in the Timeline that allows you to

work with keyframe animations expressed as curves on a graph. The Curve Editor
is only displayed once the Curve Editor icon is enabled.

Go to the Timeline tutorial to see how it works.
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The Parameter list shows all objects in the current session. This list is arranged
in a collection of shapes, filters, trackers and their associated parameters. Click
the twirly to the left of the parameter to either show or hide parameters of a
particular object.

Timeline

The Timeline is an overview of your objects and their keyframes. In the
Timeline, you can edit a keyframe's position in time, but not its value.

Work Range
The Timeline displays the full session range with the work range displayed
using a gray bar at the top of the Timeline.

The work range can quickly be adjusted by:

• Ctrl/Cmd-drag the ends of the work range bar to change the start and end.
• Ctrl/Cmd-drag the work range bar to slide it forward and back while maintaining
the duration.

Current Time Indicator
The vertical line in the Timeline is the current time that you are parked at. To
move the Current Time Indicator, just click and drag the shuttle slider below the
Viewer or in the top line of the Timeline.
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To center the timeline on the current frame, click the top left corner of the
Timeline above the object labels.
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Out of Bounds Indicator
The area before the first frame and after the last frame (the area between the
actual session range and the work range, if extended) is shaded red in the
timeline to show the usable, but out of bounds area.

Zooming and Panning the Timeline
The Timeline shows the duration specified for the current session. You can
zoom in or out using the mouse scroll wheel to see the Timeline in more or less
detail and can pan horizontally or vertically using the Spacebar while clicking
and dragging.

Timeline Pop-up Menu
Right-click over a selected keyframe in the Timeline or point in the Curve Editor
to open the Timeline pop-up menu.

Interpolation
Ease

Ease allows you to smoothly transition in or out of a keyframe.
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Eases in to the selected keyframe.

• Ease Out
Eases out of the selected keyframe.

• Ease In/Out
Eases in and out of a selected keyframe.

Hold
There is no interpolation and abrupt switches in value occur at keyframes.

Linear
When values change, a straight line with sharp, abrupt angles from one
keyframe to the next is drawn.

Smooth (Catmull-Rom)
Smooth (Catmull-Rom) creates a smooth animation curve between keyframes.

Extrapolate
Extends the path of the curve beyond the first or last points.
Note: When the Shape > Interpolation Engine preference is set to Spatial (Nukecompatible), shape keyframes can only be set to Smooth (Catmull-Rom), Hold and
Extrapolate. This ensures that shapes using Smooth (Catmull-Rom) interpolation in
Silhouette exactly match the result in Nuke when exported.

Add Key
Right-click over the property you are interested in at the desired frame in the
Timeline and select Add Key. Keyframes will be added to that property for all
selected objects.
Note: You can also Alt-click in the Timeline to add a keyframe.

Cut
Deletes the currently selected keyframe or keyframes.

Copy
Copies the currently selected keyframe or keyframes.

Paste
Pastes the currently selected keyframe or keyframes.
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Deletes the currently selected keyframe or keyframes.
Note: Individual shape points can be copied and pasted between keyframes using
Ctrl/Cmd-Alt-C to copy and Ctrl/Cmd-Alt-V to paste.

Select All Keys
When hovering over a track, it will select all keyframes for that track. If not over
a track (empty area), it will select all keyframes in the timeline.

Marker
Marker allows for the creation, editing or deletion of markers. Markers are a
handy way of placing notes at specific points in time and are displayed as light
blue squares at the top of the Timeline.

Hovering the cursor over the marker will display the marker’s text as a tool tip.

Create/Edit

A dialog box opens where you can enter, change, or clear text for the marker.
When you enter text and click OK, a marker is displayed.

Delete

Deletes the marker at the current frame.

Delete All

Deletes all markers.

Show Work Range
When enabled, the Timeline displays only the start and end frames of the Work
Range.

Moving One Keyframe in Time
A single keyframe can be moved by selecting it and then dragging it to a new
location.
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Multiple keyframes can be moved by first selecting a range using the Shift key
and then dragging on them to a new location.

Selecting Objects
Objects can be selected within the Timeline. Clicking the name of an object
selects it. Multiple objects can be selected by Shift-clicking on them. Ctrl/Cmdclicking an object after it is selected will deselect it.

Curve Editor

The Curve Editor is a view mode in the Timeline that allows you to work with
keyframe animations expressed as curves on a graph. It allows you to visualize
the interpolation of the animation.

The Curve Editor is only displayed once the Curve Editor icon, located to the
right of the parameter in the Timeline, is enabled.
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Timeline Keyboard Shortcuts
Shortcut

Action

Scroll wheel

Zooms the Timeline in and out

Shift-Middle-mouse drag

Zooms the Timeline in and out

Space Bar-move mouse

Pans the Timeline

Middle-mouse drag

Pans the Timeline

Single-click keyframe

Selects one keyframe

Ctrl/Cmd-click keyframe

Toggle the keyframe selection

Shift-click keyframes

Selects a range of keyframes

Alt-click

Inserts a keyframe

Right-click keyframe

Opens Timeline pop-up menu

Click-drag keyframe

Moves the keyframe

Ctrl/Cmd-drag the ends of work range bar

Changes the start and end of the work range

Ctrl/Cmd-drag the work range bar

Slides the work range forward and back

Click top left corner of the Timeline

Centers the timeline on the current frame
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Curve Editor Keyboard Shortcuts
Shortcut

Action

Alt-click on curve

Inserts a point on the curve

Click-drag curve point

Moves the curve point

+ or =

Zooms the Curve Editor in

-

Zooms the Curve Editor out

Space Bar-move mouse

Pans the Curve Editor

Hover cursor over curve

Displays the current curve value

Right-click curve point

Opens Curve pop-up menu
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The Silhouette interface contains multiple windows. Windows can be closed,
torn off to be a floating window, or moved to a new location. The upper right
portion of the window has two icons: a Minimize/Maximize and a Close icon.
Minimize/Maximize

Close

Opening and Closing Windows:
• Click the Close icon to close a window.
• Once a window has been closed, it can be reopened by selecting it from the
Window pull-down menu.

Creating Floating Windows:
• Click the Minimize/Maximize icon to make the window a floating window.
Moving Windows:
• Click and drag a window’s title bar and place it in a new location. This moves all
of the tabs docked in the window as one unit.

Title Bar
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• Click and drag a tab and place it in a new location. This moves only the single tab.
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• If you drop the window in the center of an existing window, a tab will be created
so that both windows will share the same space. This is the same as the Node,
Object, and Notes windows sharing the same location.

• Windows can be docked next to each other. For instance, you can put the Object
List to the left of the Trees window with both being docked to the right of the
Viewer.

Sashes

By clicking and dragging the sashes, dividing lines between areas of the
screen, you can customize the Silhouette interface.
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The Status Bar is located at the bottom left of the user interface and displays
various messages.

Cursor Position Color Values
The cursor position color values when in the Paint node are displayed in the
Status Bar.

Tool Tips

Hovering the cursor over an icon will pop up a tool tip that displays its function.

Twirly Icons

Effect groups in the Node and Object parameter windows can be expanded and
collapsed using the Twirly icons located to the left of the group.
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Animateable parameters in the Parameters and Object windows have an
Animate icon to the left of them. Keyframes are set when the Animate icon is
enabled (highlighted).

Off

On

Numeric Keyboard

Single clicking on a numeric field opens a numeric keyboard.

Numeric Fields

Drag on a numeric field to adjust the value. You can adjust any value with finer
precision by pressing Ctrl/Cmd while dragging.

Note: When the cursor is hovering over a Numeric Field, the Arrow keys can adjust the
value.
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Individual parameters as well as parameter groups can be reset to their default
settings using the Reset icon.

Mouse Wheel Adjustments

Hover over a numeric field and use Alt-mouse wheel to adjust it. Use Alt-Shift
for a 10 time larger change. Use Alt-Ctrl/Cmd for 10 time smaller change.
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Spin boxes change values according to the following key strokes:

• Click = change by 1 pixel.
• Shift-click = change by 10 pixels.
• Ctrl/Cmd-click = change by 0.1 pixel.
• Middle-Mouse button-click, hold and drag back and forth over spin box arrows
adjusts the value.

Note: When the cursor is hovering over a Spin Box, the Arrow keys can adjust the
value.

Silhouette User Guide

•
•
•
•
•
•

User Interface

Pull-Down Menus

•
•
• 210
•
•
•

File

Save Project
Projects can be saved by choosing Save.

Open Backup
Opens a browser that lists the available backups by date and time which can
then be loaded.

Revert Project
You can revert to the last saved version by selecting Revert.

Import
Imports shapes into the Silhouette Roto node.

Edit

Undo
Undo operations.

Redo
Redo operations.

Cut
Cuts the selected object.

Copy
Copies the selected object.

Paste
Pastes the selected object.

Duplicate
Duplicates the selected object.

Delete
Deletes the selected object.
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Selects all shapes.

Deselect All
Deselects all shapes.

Window

The various Silhouette interface windows are displayed with checkboxes next
to them. When the box is checked next to an item, that particular window is
displayed in the user interface.

Help

About
Shows the Silhouette version.

User Guide
Opens the Silhouette User Guide.

What’s New
Opens the Silhouette What’s New document.

Check for Update
Checks to see if a newer version of Silhouette is available.

License
Opens the license tool.
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Silhouette is a high dynamic range, non-destructive, 2D raster based paint
system that was designed from the ground up to handle the demands of feature
film and television production. Now, the same Academy Award winning paint
tools used by visual effects artists worldwide can be used for paint and
retouching in Adobe After Effects & Premiere Pro, Foundry NUKE, Blackmagic
Resolve & Fusion, and Magix Vegas host applications.

Black & White, Blemish, Blur, Burn, Clone, Color, Color Correct, Cutout, Detail,
Dodge, Drag, Eraser, Grain, Mosaic, Repair and Scatter brushes are available
for any task. As you paint, every action you make is recorded as events. These
events can be selectively played back on the same frame, different frames,
multiple frames and with or without tracking data applied. This makes for a very
powerful and versatile Auto Paint feature that provides the flexibility of vector
paint with the speed of a raster paint system.
Go to the Paint tutorial to see how it works.
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When Silhouette is applied, you are required to create or open a project before
you can begin painting. A project contains the painted frames as well as a
complete record of the paint history so that it can be reproduced at any time.

Autosave and Backups

An autosave and backup system ensures that you will not lose any of your
work. Autosaves and backups are stored in the project folder.

Autosaves
The Auto Save > Interval (minutes) preference specifies how often to update
the autosave file which is named autosave.sfx. If Silhouette crashes, you are
given the choice to open the autosave file when re-opening the project. When
projects are closed or saved normally, the autosave file is automatically
deleted.

Backups
The Auto Save > Maximum # of Backups preference controls how many
backup files are created. Each time a project is saved, a backup copy is stored.
The most recent backup is backup.sfx, the second most recent is backup.1.sfx,
then the next is backup.2.sfx, etc., up to the maximum number of 5. As each
new backup is added, the files are rotated upward.
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Start your host application and apply Silhouette:

• After Effects: Apply Silhouette Paint to a clip in the timeline from the Effects >
Boris FX Silhouette menu.

• Premiere Pro: Apply Silhouette Paint to a clip in the timeline from the Effects >
Video Effects > Boris FX Silhouette group.

• OFX: The method for applying an OFX plug-in varies. Consult the OFX software
documentation for details.

2

To use Optional Clone Sources inputs in Silhouette:

• After Effects/Premiere Pro: Select the layers using the Optional Clone Sources >
Input 1-2 pop-up menus.

• OFX: For node based hosts, connect sources to the Silhouette node’s Input 1-2
inputs. For layer based hosts, select the layers using the Silhouette plug-in’s
Optional Clone Sources > Input 1-2 pop-up menus.

3

Open the Silhouette user interface.

• After Effects/Premiere Pro: Click the Silhouette Interface > Open button.
• OFX: Click the Open Silhouette Interface button.
The Silhouette user interface opens.
4

When prompted, enter the name of your Silhouette project, set the Working
Depth and click Create Project.

In most cases, the Working Depth should match the host application’s bit depth.
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Various non-animateable controls are organized into Presets, Brush, Profile
and Paint tabs.

Presets

A Presets tab contains 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 and Save buttons on the left
side of the Paint window and allows you to save all of the brush parameters as
a preset.

To save a preset, select a brush and adjust its controls, click Save and then
choose one of the numbered presets. Shift-Save will save to the currently
selected preset without having to hit the number too. Once saved, you can use
the Alt-0 through Alt-9 keyboard shortcuts to quickly select one of the presets.
Note: Saved presets are highlighted blue. Clicking a blue preset after selecting Save
will overwrite it.

Clear a paint preset by pressing Save, then Alt-clicking on the preset.
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A number of different brushes are selectable from the Paint toolbar to the left
of the Viewer.
Black & White
Blemish
Blur
Detail
Clone
Color
Color Correct
Dodge
Burn
Cutout
Drag
Eraser
Grain
Mosaic
Repair
Scatter
Stroke
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To paint with a mouse, click and drag on the screen. To paint with a pen and
tablet, just press and drag.

Drawing Straight Lines
If you press Alt, click and then click in a different location, a straight line is
drawn. This will work with any brush type. If you keep Alt depressed while
clicking, you will create interconnected straight lines.

Black & White (B)
The Black & White brush converts color images to black and white simulating
the look of black and white photographic filters.

Mode
Selects the method by which the color image is converted to a monochrome
image.

Luminance

Creates a monochrome image using the brightness of the image.

Average

Creates a monochrome image using the average of the red, green and blue
channels.
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Simulates a red filter in black and white photography.

Green

Simulates a green filter in black and white photography.

Blue

Simulates a blue filter in black and white photography.

Yellow

Simulates a yellow filter in black and white photography.

Orange

Simulates a orange filter in black and white photography.

Blemish (Shift-B)
The Blemish brush is useful for removing facial blemishes on film originated
footage. It combines the Blur and Grain brushes.

Blur (Ctrl/Cmd-B)
Blurs the image.

Radius
Sets the amount of blur to be applied.

Burn (Alt-Shift-B)
Darkens areas in the image.

Exposure
Sets the brightness of the brush.
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Shadows, Midtones, Highlights, Full

Targets the Burn operation to either shadows, midtones or highlights as well as
the entire range when set to Full.

Clone (C)
Paints with sampled pixels from an image with the ability to grade (color
correct), blur, sharpen or warp the clone source.

Go to the Clone Brush tutorial to see how it works.
The controls for the Clone brush are split into three tabs: Clone, Grade/Filter
and Warp. The Clone tab deals with the selection, timing and transformation of
the clone source. The Grade/Filter tab contains color correction (grade), blur
and sharpening parameters. Last, the Warp tab has warp related controls.

Clone
Setting the Clone offset on the same image:
1

Press and hold down the Shift key and then click, drag and release the mouse
and then the Shift key. The first click sets the clone source and where you drag
and release is the Clone target.

or
2

Press and hold down the Shift key. Click once to set the clone source and click
once again in a different location to set the Clone target.
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mouse or tap your pen on the screen once.
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Setting the Clone offset on different images:
Oftentimes, you need to align the same feature in two different images of a clip
when painting with the Clone brush.
1

In the Clone controls, select Output, Foreground or Input 1-2 in the Source popup menu and then set the Frame parameter to choose which source frame to
paint from.

2

Press the ‘ key (located to the left of 1 key).

The clone source image automatically appears in the Viewer.
3

Set the Onion Skin mix to 100.

4

Click on the clone source feature that you want to paint from.

The Clone target image automatically appears in the Viewer.
5

Click on the Clone target feature that you want to paint on.

The Clone offset is set.

Source

Picks which image will be used as the clone source.

Output
Clones from the previously painted areas.
Foreground
Clones from the foreground image.
Input 1-2
Clones from the clips assigned to Paint’s Optional Clone Sources > Input 1-2
inputs.
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Choose which frame number of the clone source to paint from. By default, the
Frame field displays the actual frame number that you are cloning from.
Alternatively, a frame offset can be displayed instead. This behavior is
controlled with the Paint > Clone > Absolute Frame Numbers preference.
Relative
When the Relative box is checked, the clone source Frame value remains
relative to the current frame. So, if the Frame value is different than the current
frame, the offset between the two is maintained.
When Relative is unchecked, the clone source is painting from a single frame
defined by the value entered in the Frame field.

Transform Controls

The Transform Controls allow you to position, scale, rotate, skew and cornerpin the clone source.

Source Match Move
Source Match Move allows you to apply the selected tracked layer to the clone
source. This is useful for when you have a single frame, clean plate that needs
to be tracked to match the motion of the clip you are painting on.
Note: To Match Move the clone source during event playback, you will need to:
1) In the Tracker, track an object and apply the tracker to a layer.
2) Select a tracked layer in the Paint tab’s Transform pop-up menu.
3) Enable Clone > Source Match Move prior to painting.
For more information on playing back paint strokes, go to the Auto Paint tutorial.

Offset
Sets the horizontal and vertical position of the clone source.
Scale
Sets the horizontal and vertical scale of the clone source. Typing in negative
values will flip or flop the clone source.
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• TL

Sets the horizontal and vertical position of the top left corner point.

• TR
Sets the horizontal and vertical position of the top right corner point.

• BL
Sets the horizontal and vertical position of the bottom left corner point.

• BR
Sets the horizontal and vertical position of the bottom right corner point.
Rotate
Sets the rotation of the clone source.

Nudging the Clone Source

The clone source can be nudged using the Arrow keys. One press of the Arrow
key moves the clone source 1 pixel. Using the Shift key in conjunction with the
Arrow keys moves the clone source 10 pixels. Ctrl plus the Arrow keys moves
the clone source one tenth of a pixel. These nudge values can be changed in
the Preferences menu located in File > Preferences > Nudging on Windows
and Linux or Silhouette > Preferences > Nudging on Mac. Holding an Arrow key
down slides the clone source.
Q (Translate), W (Rotate), E (Scale)
Pressing Q, W or E and then clicking and dragging will translate, rotate or scale
the clone source. Pressing Q, W or E a second time deactivates the mode.
Also, the position of the cursor when W or E is pressed sets the anchor point
for the rotation or scale operation.
Note: Onion Skin mode is automatically activated once the Q, W or E keys are pressed.

Corner-Pin
When Interactive mode is enabled, you can corner-pin the clone source by
dragging the handles on the corners of the image. Alternatively, you can select
and move the corner points without being in Interactive mode by using
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Ctrl/Cmd-1,2,3 or 4 to select the top left, top right, bottom right and bottom left
corner points. Then, use the mouse, pen/tablet or Arrow keys to move the
points. Pressing Ctrl/Cmd-1,2,3 or 4 a second time deactivates the mode.
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Clone Transform Nudging Keyboard Shortcuts
Shortcut

Action

Arrow keys

Moves the clone source by 1 pixel

Shift-Arrow keys

Moves the clone source by 10 pixels

Ctrl/Cmd-Arrow keys

Moves the clone source by one tenth of a pixel

Hold down Arrow keys

Moves the clone source continuously

Q, W, E then Arrow keys

Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys

Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys

Translates, Rotates or Scales by 1/10 of a pixel

Ctrl/Cmd-1 then Arrow Keys

Nudges the top left corner point

Ctrl/Cmd-2 then Arrow Keys

Nudges the top right corner point

Ctrl/Cmd-3 then Arrow Keys

Nudges the bottom right corner point

Ctrl/Cmd-4 then Arrow Keys

Nudges the bottom left corner point

Clone Transform Keyboard Shortcuts
Shortcut

Action

Q

Activates / Deactivates translation of the clone source

W

Activates / Deactivates rotation of the clone source

E

Activates / Deactivates scaling of the clone source

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W

Rotates without setting the anchor point

Ctrl/Cmd-E

Scales without setting the anchor point

Ctrl/Cmd-1-4

Selects the top left, top right, bottom right and bottom left
corner points so they can be moved

. (Period key)

Sets the anchor point
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Activates the on-screen controls.
Turn off Interactive mode when you want to Paint. When Interactive is selected,
you can position, scale, rotate, corner-pin and skew the clone source using the
on-screen controls.

Clone Transform On-Screen Controls
Shortcut

Action

Drag within large center circle

Moves the clone source

Shift-drag within large center circle

Constrain clone source movement horizontally or vertically

Drag the center square horizontal and Scales the clone source horizontally or vertically
vertical halfway points
Drag a center square corner

Proportionally scale the clone source

Drag large center circle

Rotate the clone source

Ctrl/Cmd-drag large center circle

Rotates the clone source with finer control

Drag handles on corners of image

Corner-pins the clone source

Drag dash above large circle

Skews the clone source horizontally

Drag dash to the right of large circle

Skews the clone source vertically
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Changes the position and size of the on-screen control rectangle which allows
the effect of the corner-pin to be controlled from a specific area. The center of
the new region also becomes the anchor point for scale and rotation.

1
2

Using a Region
Press Region.

Click and drag around an area of interest.

A region appears.
3

Turn on Interactive and adjust the Clone transform.

Now, when you adjust the Clone transform, the region is used.

Region Shortcuts
Shortcut

Action

Click and drag

Creates a region

Alt-click and drag

Creates new region when one already exists

Click and drag inside a region

Moves the region

Drag the region handles

Resizes the region

Tap outside a region box without dragging

Resets the region to full screen
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Clone Transform On-Screen Controls With Region Set
Shortcut

Action

Drag within region

Moves the clone source

Shift-drag region

Constrains the clone source movement horizontally or vertically

Drag edge handle

Scales the clone source horizontally or vertically
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Shift-drag corner or edge handle Proportionally scale the clone source
Ctrl/Cmd-drag on corner handle Rotate the clone source / Continue holding Ctrl to adjust with
finer control
Drag on a corner handle

Corner-pins the clone source

Ctrl/Cmd-drag on edge handle

Skews the clone source
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Chooses the filtering method when transforming the clone source. Mitchell is
the default.
Triangle
The Triangle filter is not the highest quality, but fine for scaled images.
Quadratic
Quadratic is like triangle, but more blur with fewer artifacts. It offers a good
compromise between speed and quality.
Cubic
Cubic is the default filter in Photoshop. It produces better results with
continuous tone images, but is slower than Quadratic. If the image contains fine
details, the result may be blurrier than desired.
Catmull-Rom
This produces good results with continuous tone images which are scaled
down, producing sharp results with fine detailed images.
Gaussian
Gaussian lacks in sharpness, but is good with ringing and aliasing.
Mitchell
A good balance between sharpness and ringing, Mitchell is a good choice when
scaling up.
Sinc
Keeps small details when scaling down with good aliasing.

Subpixel

When activated, subpixel positioning is used when moving the clone source.
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The clone source can be color corrected (graded), blurred or sharpened.

The parameters are ganged together by default. To deactivate Gang, press the
Lock icon located to the right of each parameter group.

Auto Grade

Auto Grade automatically grades the clone source to match the location you
are painting.

Note: The Gain, Gamma, Lift, Hue and Saturation controls are disabled when using
Auto Grade.

Gain

Red
Multiplies red values.
Green
Multiplies green values.
Blue
Multiplies blue values.
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Red
Adjusts red gamma values.
Green
Adjusts green gamma values.
Blue
Adjusts blue gamma values.

Lift

Red
Adds red values.
Green
Adds green values.
Blue
Adds blue values.

Hue
Rotates the hue.

Saturation
Adjusts saturation. Positive values saturate, negative values desaturate.

Blur

Blurs the clone source.

Sharpen

Sharpens the clone source.

Reset Grade/Filter

Resets all Grade/Filter controls.
Note: Once a Grade/Filter parameter has been adjusted, a green dot appears to the
right of the tab to indicate that a change was made.
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Warp allows you to warp specific image areas using pins, while leaving other
areas untouched. Adjustments can range from subtle nip and tucks to
something more obvious like repositioning an arm or leg.

Enable

Enables/disables warping. This is useful to turn the warping effect on and off.

Pin 1 - 20

A total of 20 pins can be added to an image. To create a pin, click-drag on the
image. Pins have a source (green circle) and target (red circle). The farther the
target is dragged from the source, the more the image warps. Click-releasing
on the image sets a tack which constrains the warp.
Pin and Tack Radius
Each pin and tack has a radius which determines its strength. Hover over a pin
to display the radius. Shift-drag the radius to adjust it.

Transform

Selects tracked layers from the Tracker and match moves the pins based on
the input tracker data.
Note: Once a Warp parameter has been adjusted, a green dot appears to the right of
the tab to indicate that a change was made.
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Clone > Warp Keyboard Shortcuts
Shortcut

Action

Click-drag on image

Creates a pin

Click-release on image

Creates a tack

Click-drag pin (source or target)

Moves the pin (source or target)

Shift-drag pin (source or target)

Moves both pins (source and target)

Ctrl/Cmd-drag pin radius

Adjusts pin radius with all radii displayed
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Hover over pin, Shift-drag pin radius Adjusts pin radius with only selected pin radius displayed
Alt-drag on a tack

Converts a tack to a pin

Right-click > Remove Pin

Deletes the pin

Right-click > Make Tack

Converts a pin to a tack
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Dual Cloning allows you to paint from two different frames simultaneously,
using separate Transform, Grade/Filter and Warp settings. To Dual Clone,
create two Clone presets using the 1 and 2 button presets on the left side of the
Clone tab.

To save a preset, click on one of the numbered presets and adjust the Clone
controls. This includes the Clone Source, Frame Offset, Transform,
Grade/Filter, and Warp settings. Once you have different settings for the two
presets, press the Dual button to enable both presets simultaneously.

When you do so, a Mix control appears to the right of the Clone controls. Mix
sets the relative opacity of the two clone sources.

When you paint, both Clone presets will contribute to the painted result.
Note: You can use the Shift-Alt-1 and Shift-Alt-2 keyboard shortcuts to quickly select
one of the Clone presets.

Reset
Resets all Clone brush transform controls.
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Paints the image with the current color.

Picking Colors from the Screen
Colors can be picked off of the screen using a couple of different techniques.

.

1

Hover over an area in the Viewer and press the (period key). The area inside the
brush diameter is sampled and averaged when choosing the color.

2

Right-click picks a color from a single pixel.

3

Right-click-drag and drawing a box averages the colors within it.

Color Palette
Colors can be selected using the Color Palette.

Color Palette

Current Color

Paint Pots

Mode
Hue, Sat or Value Picker

Alpha

The Hue, Sat, Value and Sliders tabs provide you with four different methods
for selecting a color.

Hue

The hue is selected from the hue picker while the saturation and value are
chosen from the large square color palette.
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The saturation is selected from the saturation picker while the hue and value
are chosen from the large square color palette.

Value

The value is selected from the value picker while the hue and saturation are
chosen from the large square color palette.

Sliders

Use the Red, Green, Blue, Hue, Sat, Value and Alpha sliders to set a color.

Hue, Sat or Value Picker
Depending on which tab is selected in the Color Palette, the vertical color bar
to the right of the Color Palette controls the hue, saturation or value of the
selected color.

Alpha
The second vertical color bar slider to the right of the Color Palette controls the
level of the painted alpha when Paint > A (alpha) is selected. An alpha value of
0 paints black, a value of 100 paints white, while a value in between paints a
level of gray.

Current Color
Displays the currently selected color.

Mode
Selects how color is applied to the image.

Normal

The Current Color is added to the image.

Tint

The Current Color is used to tint the image by replacing hue and saturation.

Hue

The Current Color is used to tint the image by only replacing hue.

Luminance

Replaces the luminance of the image while leaving hue and saturation
unaffected.
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Pixels darker than the paint color are replaced, and pixels lighter than the paint
color do not change.

Darken

Pixels lighter than the paint color are replaced, and pixels darker than the paint
color do not change.

Paint Pots
Favorite colors can be stored in the paint pots by dragging and dropping from
the Current Color. Click on one of the paint pots to make it the current color.

Color Correct (Alt-C)
The image is painted using color adjustments.

Hue
Rotates the hue.

Saturation
Adjusts saturation. Positive values saturate, negative values desaturate.

Brightness
Adjusts brightness. Positive values brighten, negative values darken.

Contrast
Adjusts contrast. Positive values increase contrast, negative values decrease
contrast.

Center
Adjusts the contrast curve to weigh it more towards shadows or highlights. A
lower value means a brighter range.

Gamma
Adjusts gamma. The gamma adjustment leaves the white and black points the
same and only modifies the values in-between. Positive values darken the
midtones, negative values lighten the midtones.
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Adds or subtracts red.

Green
Adds or subtracts green.

Blue
Adds or subtracts blue.

Cutout (Alt-Shift-C)
Cuts out a portion of the image based on a rectangular selection, taking into
account alpha if it exists, and paints using the cutout.

If one is not defined, you can click-drag to create a source region. When a
source region already exists, press Shift to display it and then optionally drag
to create a new one. The source region can be reset by Shift-clicking or rightclicking without dragging.

Cutout Keyboard Shortcuts
Shortcut

Action

Click-drag

Creates a source region when none exists

Shift-drag or Right-click-drag

Creates a new source region

Shift

Displays source region

Shift-click or Right-click

Resets source region

Ctrl/Cmd-drag boundary

Scales the cutout

Ctrl/Cmd-Shift-drag boundary

Rotates the cutout

Type

RGBA

Creates a cutout based on the RGBA channels.

RGB

Creates a cutout based on the RGB channels.
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Scales the cutout.

Rotation
Rotates the cutout.

Detail (Alt-D)
Sharpens or smooths by decomposing the image into coarse, medium and fine
detail layers. This results in selective sharpening, detail enhancement and
edge aware smoothing.

Coarse

Adjusts the coarse detail layer. Increasing the value sharpens while decreasing
the value smooths.

Medium

Adjusts the medium detail layer. Increasing the value sharpens while
decreasing the value smooths.

Fine

Adjusts the fine detail layer. Increasing the value sharpens while decreasing the
value smooths.

Gang

The Coarse, Medium and Fine values can be ganged together. When ganged,
adjust the Coarse slider to affect all values simultaneously. This will generate
an overall sharpening effect if the numeric fields are increased and an overall
smoothing effect if decreased.

Range

Shadows, Midtones, Highlights, Full

Targets the Detail operation to either shadows, midtones or highlights as well
as the entire range when set to Full.
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Lighten areas in the image.

Exposure
Sets the brightness of the brush.

Range

Shadows, Midtones, Highlights, Full

Targets the Dodge operation to either shadows, midtones or highlights as well
as the entire range when set to Full.

Drag (D)
Smudge or smear an area of the image. When the brush first starts, it makes a
copy of the area under the brush, then on subsequent samples it stamps that
area down in the new location with a blend.

Mix
Mix is the initial blend amount of the smudged area.

Decay
Determines how much of the Mix to use on the next stamp and reduces the Mix
percentage with each sample.
The defaults are Mix = 50% and Decay = 90%. So, the first stamp will be a
50/50 mix of the brush start sample and the new sample, then the next will be
50% * 90% of it, etc. until it eventually fades away entirely.

Eraser (Shift-E)
Erases previously painted brush strokes.
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Paints grain onto the image.

Size
Sets the size of the grain.

Red Size

Controls the size of the red grain.

Green Size

Controls the size of the green grain.

Blue Size

Controls the size of the blue grain.

Amount
Sets the intensity of the grain.

Red Amount

Controls the intensity of the red grain.

Green Amount

Controls the intensity of the green grain.

Blue Amount

Controls the intensity of the blue grain.

Softness
Sets the softness of the grain.

Red Softness

Controls the softness of the red grain.

Green Softness

Controls the softness of the green grain.

Blue Softness

Controls the softness of the blue grain.
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When enabled, the grain is monochrome. In this mode, parameters that have
no effect are grayed out.

Mosaic (M)
Divides the picture up into square tiles.

Size
Controls the size of the square tiles. A small size value will create many square
tiles.

Repair (R)
Paints the image with the color level sampled at the beginning of each stroke.

Scatter (Shift-S)
Scatters pixels in a random fashion.

Radius
Sets the amount of scattering.
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Displays all strokes. Strokes can be selected by clicking or drag selecting in the
Viewer. Hold Shift to add to the selection and Ctrl to toggle the selection. As
strokes are selected, they are highlighted in the Viewer and the Paint History.
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Four brush compare modes preview brush settings prior to painting. You can
choose from Onion Skin, Align, Vertical Split and Horizontal Split.

The Caps Lock key toggles the compare modes on and off.
Note: The compare modes are not available for the Drag, Repair, and Cutout brushes.
Onion Skin and Align mode only work with the Clone brush.

Onion Skin
Onion Skin does a mix, as defined by the Mix value, between the brush preview
and source image. When using the Clone brush, it is a mix between the clone
source and target. A value of 100 displays the clone source while a value of 0
displays the clone target.

Align
Align inverts the clone source and mixes it with the foreground, creating an
embossed effect when similar images are not aligned. When perfectly aligned,
the Viewer appears gray or black depending on the state of the Paint > Clone
> Alignment Type preference.

Not Aligned

Aligned
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Compares the brush preview and source image using a Vertical Split. Move
your cursor into the image area over the split line and when the cursor changes
to a double-arrow, click and drag to move the split line. The split line may not
be obvious, so white triangles on the edges of the Viewer will help you find it.

The split is useful for determining the brush settings prior to painting.
Note: The | key (vertical bar) keyboard shortcut snaps the vertical split position to the
cursor position.

Horizontal Split
Compares the brush preview and source image using a Horizontal Split. Move
your cursor into the image area over the split line and when the cursor changes
to a double-arrow, click and drag to move the split line. The split line may not
be obvious, so white triangles on the edges of the Viewer will help you find it.

The split is useful for determining the brush settings prior to painting.
Note: The | key (vertical bar) keyboard shortcut snaps the horizontal split position to
the cursor position.
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You can customize your brush settings in the Profile tab.

Profile
A circle or square brush can be selected from the pop-up menu.

Circle
The brush profile is set to a circle.

Square
The brush profile is set to a square.

Airbrush
When on, brush samples are generated at 30 samples/sec as long as the
mouse button or pen is held down.

Buildup
Allows the opacity to accumulate so it doesn't get clamped by the Opacity
parameter value.

Size
Sets the size of the brush. The brush can also be resized in the Viewer with the
bracket keys, [ and ], or by holding Ctrl/Cmd and dragging the brush outline.

Opacity
Sets the opacity or transparency of the brush.
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Sets the brush softness. The brush softness can be changed in the Viewer by
holding Ctrl/Cmd-Shift and dragging the brush outline.

Falloff
Controls the feather contour of the brush.

Flatness
Sets the flatness of the brush.

Angle
Sets the angle of the brush.

Spacing
Sets the brush spacing.

Paint

The Paint tab contains controls that affect how paint is applied to the image.

RGB
The selected brush paints on the RGB channels.

R
The selected brush paints on the red channel.

G
The selected brush paints on the green channel.
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The selected brush paints on the blue channel.

A
The selected brush paints on the alpha channel.

Detail Separation
Separates the image into color and detail layers. The color and detail layers can
be painted separately or simultaneously. Painting on the color layer preserves
detail while painting on the detail layer preserves color.
Note: With the exception of Cutout and Eraser, all brushes can be used in the Color
and Detail modes.

Normal
Paints on the color and detail layers simultaneously.

Color
Paints on the color layer. The color layer can be viewed by selecting View >
Color Layer or pressing the 8 keyboard shortcut.

Detail
Paints the detail layer. The detail layer can be viewed by selecting View > Detail
Layer or pressing the 9 keyboard shortcut.

Detail Level

Determines the detail layer to be used. 0 is coarse, .5 is medium and 1 is fine.
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The pop-up menu to the right of Detail Level provides coarse, medium and fine
detail presets.
Original
Coarse

Medium

Fine

Coarse
Presets the detail to the coarse layer.
Medium
Presets the detail to the medium layer.
Fine
Presets the detail to the fine layer. The fine layer typically includes details such
as skin blemishes, pores, hair, and wrinkles.
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Obey Alpha
When enabled, the intensity of the alpha channel controls how much the image
will be affected by a particular paint operation. At any given pixel in the image,
the more transparent the value in the alpha channel, the more transparent the
application of the paint operation.

Invert Alpha
Inverts the alpha channel used for the Obey operation.

Opaque
Enabled once the A button is turned on, the Opaque control ensures that a solid
paint stroke is created when painting into the alpha channel. When Opaque is
off, the brush will also affect the alpha channel. So, it's possible to blur and drag
the alpha channel, for instance.

Alpha Source
Selects which input source to use when Obey is enabled.

Foreground, Input 1-2

Foreground
Obeys the alpha from the Foreground input or the Roto node’s shapes.
Input 1-2
Obeys the alpha from the Clone sources.
Output
Uses Paint’s output alpha as the obey alpha source. This option is handy for
painting temporary alpha to control where you paint in the RGB channels.

Paint Source
Selects either Foreground or Output as the paint source. Alt-S toggles between
Foreground and Output.
Foreground
The brush paints from the Foreground. For instance, this is useful for painting
multiple strokes to perform a constant color correction or blur adjustment.
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Output
The brush paints from the Output, with each new stroke affecting what was
previously painted.
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Note: Paint Source is not available for the following brushes: Clone, Cutout, Mosaic,
Repair and Scatter.

Transform
Selects tracked layers from the Tracker, for use in match moving paint strokes
or the clone source during event playback.

Show Shapes
Shape outlines from Roto can be displayed in Paint

Delete
Delete all paint strokes and restores the original unpainted frames.

Current Frame
Sets the range to the current frame.

Work Range
Sets the range to the in and out points in the Timebar.

All Frames
Sets the range to the entire frame range.

Paint Preferences
Seldom adjusted Paint controls can be accessed by clicking the Paint
Preferences icon.
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Auto Paint is a highly unique automated paint feature that records all paint
activity with tight integration of both point and planar trackers. Paint strokes can
be match moved or stabilized giving Silhouette the speed of raster paint with
the repeatability of vector paint. The beauty of the system lies in the automatic
recording of the paint strokes and brush settings. Individual paint strokes can
be selected and repeated over many frames, as well as deleted. If the original
footage changes, the entire paint history can be used to rebuild the painted shot
automatically. Go to the Auto Paint tutorial to see how it works.

Paint History
The Paint History contains all of the “events” for the current session. Events are
things like paint strokes, brush profile changes, brush parameter changes,
other paint states, etc. A selection of events essentially becomes a macro and
can be played back over a range of frames.

Groups are created each time painting is started on a frame and are recorded
with the current time stamp. So the first time you begin painting on frame 1, for
instance, a renameable “event group” containing a current time stamp is
created. Then, events are created for the current paint state: channels/flags,
brush, brush profile, and brush parameters. And finally, a new stroke event is
created for the new stroke. After the first stroke, state changes are stored in
their own events (ie. brush size, opacity, etc).
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Manually adds a paint event group. Manually creating groups is useful for
organizing your painted strokes so that they can easily be identified at a later
time.

Note: Normally, one paint group is created while painting on a frame. If you leave the
frame and come back to it later, another group will be created automatically.

Show Strokes
When you make a selection in the Paint History, the strokes are highlighted
green in the Viewer when Show Strokes is enabled--the default.

Delete
Press the Delete icon or the Delete key to delete selected events.

Groups and Events

• A date and time stamp is an automatically created group that contains the events

for frame 1. Later, if you leave and come back to frame 1, there will be a new group
created with a new time stamp. This will keep track of what changes were made
and when.

• Groups can be renamed by double-clicking, typing a new name and hitting Enter.
• The first time you do something on a frame, events that snapshot the current paint
state are recorded. This is so that if you need to rebuild the frame, everything that
is needed is in the Paint History for each frame.

• Groups that have + icons indicate you can expand them to see their contents.
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Frame Range
Defines the frame range for Event Playback and Rebuild operations.

Current

Sets the range to the current frame.

Work

Sets the range to the in and out points in the Timebar.

All Frames

Sets the range to the entire frame range.

Custom

Sets a custom range as defined by the numeric entry fields. To quickly set
custom in/out points, press the arrows in the numeric fields to enter the
currently parked frame.

Start>Current

Sets the range to the start frame ending at the current frame.

Current>End

Sets the range to the current frame ending at the end frame.

Play Selected Events Forward/Backward
Plays selected events in the Paint History either forward or backward.
In the Paint History window, select the paint event group or a sub set of the
paint events you want to play back. You will see the strokes highlight green in
the Viewer. Then, select the desired frame range and press either the Play
Selected Events Forward or Backward icon.
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The number to the right of the Play Selected Events icons represents the
number of selected items in the Paint History.
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If a layer with tracking data applied is selected and Match Move is enabled, the
selected strokes will be match moved when played back.
Note: To Match Move the clone source during playback, you will need to select the
layer and enable Clone > Match Move prior to painting.

Match Move
Match Move allows you to apply the selected tracked layer while playing back
paint events.

Duplicate
Duplicates strokes from one view to another for the current frame. If a layer with
a stereo offset is selected prior to duplicating, the stereo offset is taken into
account when duplicating the strokes.
Note: Duplicate only appears when in a stereo project.

Replay (Ctrl/Cmd-Alt-R)
Replays the last stroke. This can be used to apply the last stroke with changed
settings and/or on a different frame.

Rebuild
Rebuilds the paint events for all frames defined in the Frame Range in the order
in which they were painted. This is useful if you replace your footage with a
different color correction than the original and want the result of painting with
the Clone brush to match the new footage.
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Paint Brush Shortcuts
Shortcut

Action

B

Selects the Black and White brush

Shift-B

Selects the Blemish brush

Ctrl/Cmd-B

Selects the Blur brush

Alt-Shift-B

Selects the Burn brush

C

Selects the Clone brush

Shift-C

Selects the Color brush

Alt-C

Selects the Color Correct brush

Alt-Shift-C

Selects the Cutout brush

Alt-D

Selects the Detail brush

Alt-Shift-D

Selects the Dodge brush

D

Selects the Drag brush

Shift-E

Selects the Eraser brush

G

Selects the Grain brush

M

Selects the Mosaic brush

R

Selects the Repair brush

Shift-S

Selects the Scatter brush

S

Selects the Stroke tool
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Paint

Paint Settings Shortcuts
Shortcut

Action

Ctrl/Cmd-drag left/right

Sizes the brush

[ and ]

Sizes the brush

Ctrl/Cmd-Shift-drag

Sets the brush softness

Shift-Alt-1 and Shift-Alt-2

Selects the Dual Clone brush setups

Shift+Ctrl+1

Toggle Dual Clone mode on/off

‘ (located to the left of 1 key)

Displays the Clone source and then the Clone
target so that you can click on each to set the Clone
offset

Caps Lock

Toggles Onion Skin mode on and off

. (period key)
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Picks colors off of the screen

Right-click

Picks a color off of the screen from a single pixel

Right-click-drag

Picks a color off of the screen by drawing a box and
averages the colors within it

Alt-click-click

Draws a straight line

Alt-S

Toggles between Paint Source > Foreground or
Output

| key (vertical bar)

Snaps the vertical or horizontal split compare
position to the cursor position
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Paint View Menu
Shortcut

Action

1

View the Output

2

View the Foreground

3-7

View Input’s 1-5

8

View Color Layer

9

View Detail Layer

P

View Paint Only
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Roto
Description

Rotoscoping or “Roto” for short has become a generic term for drawing shapes
to extract, isolate or affect a portion of an image. It is tedious work, but it’s one
of the most important parts of the visual effects process. Within Roto, there are
all the tools needed to make quick work of any roto job.
The Roto node is where you create shapes and trackers to be used in Paint for
tracking paint strokes as well as holdout mattes for painting.
Note: The shapes from the Silhouette Paint plug-in can’t be exported or rendered.

Go to the Roto tutorials to see how it works.

Toolbar

When Roto is selected, a number of different tools are selectable from the
Toolbar to the left of the Viewer.
Transform
IK
X-Spline
Magnetic Freehand

Reshape
B-Spline
Bézier
Square

Circle
Tracker
MultiFrame
RotoOverlay
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Toolbar Keyboard Shortcuts
Shortcut

Action

T

Selects Transform Shape Mode

TT

Selects Transform Points Mode

R

Selects Reshape Normal Mode

RR

Selects Reshape Magnet Mode

Y

Selects IK (Inverse Kinematics)

B

Selects B-Spline

S

Selects X-Spline

Shift-B

Selects Bézier

Shift-F

Selects Magnetic Freehand

Shift-S

Selects Square

Shift-C

Selects Circle

Shift-T

Selects Tracker

M

Selects MultiFrame

Shift-O

Selects RotoOverlay

Alt-F

Toggles the shape feather handle on/off

Alt-K

Adds weighted keyframe

Silhouette User Guide

•
•
• 258
•
•
•

•
•
•
•
•
•

Roto

Bézier (Shift-B)
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Creates a Bézier spline.

Go to the Bézier tutorial to see how it works.
To draw a Bézier spline, click on the image to place the first control point and
drag the cursor while keeping the mouse pressed to extend the control point’s
tangents. Click on the screen to add more control points and when finished
adding points, click the first control point that you added to close the shape.
To create an open shape, add points and press the Esc key or switch to a
different tool to finish the shape. Then in the Reshape tool, select the open
shape, adjust the Stroke Width to set its thickness and choose either a flat or
round Cap Style in the Object Parameters.

Originally developed by Pierre Bézier in the 1970's for CAD/CAM operations,
Bézier splines became the foundation of the entire Adobe drawing model. If
you're a user of Adobe products, you've probably used Bézier’s. Bézier splines
are defined by control points and tangents. The position of the two tangent
handles control the amount of a point's curvature.
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A shape is created by drawing a Bézier curve path. This path contains control
points and tangents that define the form of the curve.
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Tangent Handle
Tangent
Control Point

Curve Join

Control Points
Control points are locations on the curve that determine its shape. When a
control point is selected, two tangents extend from the control point. These
tangents guide the shape of the curve.

Joins
The area of the curve at the control point is called the curve join.
Cardinal Join
Corner Join

Joins can either be corner or cardinal (smooth) joins. When control point
tangents are positioned in opposite directions, the join is cardinal. In contrast,
corner joins have their tangents positioned at an angle to each other.
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The length and direction of a control point’s tangents direct the curve through
that control point.
Curve Join
Tangent Handle

Tangent
Control Point

Control points have two tangents that can extend from it. The path of the curve
through the control point is determined by the length and orientation of the
tangents. When you drag one tangent’s handle, the adjacent tangent moves as
well. Using keyboard shortcuts while dragging allows you to control how the
curve passes through a control point.
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Bézier Keyboard Shortcuts
Shortcut

Action

No key needed

Adjust the length of one tangent while retaining
a fixed angle between two tangents

Ctrl/Cmd

Adjust both tangents simultaneously while
retaining a fixed angle between two tangents

Alt

Adjusts only one tangent to create corners

Shift

Adjusts only the length of one tangent (similar to
the “No key needed” shortcut)

Ctrl/Cmd-Alt-1

Sets the point tension to Corner

Ctrl/Cmd-Alt-2

Sets the point tension to Cardinal
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Curve

Extending Short Tangents
Sometimes a control point’s tangents are so close together that trying to modify
the tangent results in movement of the control point. If this is the case, you can
force the tangents to move without affecting the control point by pressing the
Alt key while dragging the tangent. Only the tangent will move, leaving the
control point unaffected.
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Normally, you move control points to adjust the form of a shape, but you can
also move the portion of the curve between control points. To move a curve
segment, deselect all control points by clicking somewhere off the shape and
then Ctrl/Cmd-drag a curve segment between control points.

Once you start dragging, the Ctrl/Cmd key can be released.
Note: The surrounding tangents remain smooth, but if you want to keep adjacent
tangents from moving, hold down the Alt key while dragging.
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Creates a B-Spline shape.

Go to the B-Spline tutorial to see how it works.
To create a B-Spline, click on the screen to create a control point and add as
many points as you like. When you are finished adding points, click the first
control point that you added to close the shape.
To create an open shape, add points and press the Esc key or switch to a
different tool to finish the shape. Then in the Reshape tool, select the open
shape, adjust the Stroke Width to set its thickness and choose either a flat or
round Cap Style in the Object Parameters.
In contrast to Béziers, B-Splines don’t use tangents and are created by only
using control points. The position of the points, their tension settings as well as
their proximity to each other determine the curvature of the shape. B-Splines
are somewhat similar to NURBS (non-uniform rational B-Splines) that are used
in many 3D modeling packages.
The images below show how the same shape can be created with either
Béziers or B-Splines.
Bézier

B-Spline

Because the two spline types of have significant strengths and differences,
artists are religiously loyal to one or the other. B-Splines create natural curves
but are terribly inefficient at defining square corners and require more points to
define than a similar Bézier shape. On the other hand, Béziers can easily
create corners and use fewer points, but can have an unnatural curved path
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caused by overly malleable “split” handles. Depending upon your expertise,
you may find Bézier splines are more appropriate for square and angular
shapes while B-Splines will work better for objects with a lot of curves like a
person’s face. Just to upset the status quo, there is a new kid on the block
called X-Splines which is explained in the next section. This spline type brings
together the best of both B-Splines and Béziers.
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Adjusting B-Splines
In contrast to Béziers, B-Splines don’t use tangents and are created by only
using control points and are simple to adjust. The position of the points, their
weight settings as well as their proximity to each other determine the curvature
of the shape. The weight (amount of pull on a point) decides how sharp or
smooth it is. Silhouette employs variable weight intensities on a point by point
basis. The weight can be adjusted by hovering over a point and Alt-dragging to
the right to create a corner point or Alt-dragging to the left to create a smooth
point. Alternatively, you can Alt-click on one of the selected points to cycle
through the preset weight settings.
Note: Do not use extreme, variable weight adjustments if you are planning on
converting the B-Spline to a Bézier Spline.

B-Spline Keyboard Shortcuts
Shortcut

Action

Alt-drag control point right

Creates a corner point

Alt-drag control point left

Creates a smooth point

Alt-clicking control point

Cycles through the preset weight settings of the point

Ctrl/Cmd-Alt-1

Sets the point tension to Corner

Ctrl/Cmd-Alt-3

Sets the point tension to B-Spline

Note: The Alt-click and pop-up menu preset weight settings for Corner and B-Spline
can’t be animated.
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Creates a X-Spline shape.

Go to the X-Spline tutorial to see how it works.
To create a X-Spline, click on the screen to create a control point and add as
many points as you like. When you are finished adding points, click the first
control point that you added to close the shape.
To create an open shape, add points and press the Esc key or switch to a
different tool to finish the shape. Then in the Reshape tool, select the open
shape, adjust the Stroke Width to set its thickness and choose either a flat or
round Cap Style in the Object Parameters.
A X-Spline is an intuitive and easily editable spline format whereby its points
can be of three different types: Cardinal, Corner or B-Spline.

• Cardinal creates a path that passes smoothly through each point.
• Corner makes a path that consists of angular corner points.
• B-Spline creates a smooth path that is determined by the surrounding points.
Look at how the same set of points can yield entirely different shapes based on
the point type setting.
Cardinal

Corner

B-Spline

The point type can be changed at anytime as well as animated from one type
to another. You’ll find that the beauty of X-Splines is that the shape’s points can
be a mix of Cardinal, Corner or B-Splines.
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The images below show how the same shape can be created with either Bézier
splines, B-Splines or X-Splines.
Bézier

B-Spline
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X-Spline

Adjusting X-Splines
X-Splines are created by using control points and then adjusting their weight to
coincide with one of the point types: Cardinal, Corner or B-Spline. The point
type can even be somewhere in between one point type and another. The
weight can be adjusted by hovering over a selected point and Alt-dragging to
the right. The weight of the point goes from Cardinal to Corner to B-Spline.
Alternatively, you can Alt-click to cycle through the different point types.

Edge Snapping
You can snap the control points of an X-Spline to edges of an object by using
the Edge Snapping tool. Select the points you want to move and press the AltS key.
Alternatively, start dragging the points, hold the Alt-S key down and they will
snap to the nearest detectable edge. In some cases, the points may not snap
to where you want them to. If this happens, adjust the points manually.
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X-Spline Keyboard Shortcuts
Shortcut

Action

Alt-drag control point right

Adjusts the weight of the point from Cardinal to Corner to B-Spline

Alt-drag control point left

When the weight is set to B-Spline, it adjusts the weight of the point
from B-Spline to Corner to Cardinal

Alt-clicking control point

Cycles through preset weight settings of the point

Ctrl/Cmd-Alt-1

Sets the point tension to Corner

Ctrl/Cmd-Alt-2

Sets the point tension to Cardinal

Ctrl/Cmd-Alt-3

Sets the point tension to B-Spline

Alt-S

Snap selected control points to the nearest detectable edge

Drag Points-Hold Alt-S

Snap selected control points to the nearest detectable edge
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Creates freehand shapes with or without magnetic properties. A magnetic
freehand shape snaps the shape boundary to the nearest object edge.

Go to the Magnetic Freehand tutorial to see how it works.

Magnetic Shape
Creates a freehand shape with magnetic properties. There are two methods of
creating a magnetic shape: Tracing or Strokes.

Tracing
Click once near the edge you want to start with and move your cursor along the
edge you want to follow. The shape boundary snaps to the nearest edge to
where the cursor lies, tracing the shortest path from any previous click. When
you are done tracing, click the first control point that you added to close the
shape.

Magnetic Tracing Shortcuts
Shortcut

Action

Click while tracing

Anchors the currently drawn path by adding a shape point

Shift-click

Draws a straight line between the new and previous shape points
Silhouette User Guide

•
•
•
•
•
•

Roto

Strokes

•
•
• 270
•
•
•

Temporary foreground (inside the shape) and background (outside the shape)
strokes are drawn for the object you want to create a shape around. Shift-click
and drag to create foreground strokes. With each click and drag of the mouse,
a green line is drawn. Alt-click and drag to create background strokes. With
each click and drag of the mouse, a red line is drawn.

BG

X-Spline

FG

As soon as the first background stroke is drawn, an X- Spline is created around
the object.

Add additional foreground and background strokes as needed so that the
shape properly surrounds the object.

Silhouette User Guide

•
•
•
•
•
•

Roto

Press Esc to clear the foreground and background strokes as well as deselect
the current shape. You can now create a new magnetic shape or new
foreground/background strokes.
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Magnetic Stroke Marking Shortcuts
Shortcut

Action

Shift-click-drag

Creates a foreground stroke

Alt-click-drag

Creates a background stroke

Esc

Clears foreground and background strokes / Deselects current shape

Freehand Shape
Click and drag to create a freehand shape. A freehand shape is exactly like a
magnetic shape, minus the magnetic properties. When you are done drawing,
click the first control point that you added to close the shape.
Note: Anytime you press and hold the mouse down, a freehand shape is drawn.

Finalizing Magnetic and Freehand Shapes
When a magnetic or freehand shape is completed, an X-Spline that follows the
originally drawn line is created.
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X-Splines generated by the Magnetic Freehand tool have a fairly high point
count to match the subtle changes in the line.To reduce the number of points,
select an X- Spline in the Object List while in the Magnetic Freehand tool and
adjust the Detail parameter directly above the Viewer.

Adjusting the Detail reduces points for X-Splines created with the Magnetic
Freehand tool, while increasing points for normal X-Splines.

Square (Shift-S)

Creates a square or rectangular spline.

To create a Square, click and drag in the shape of a square and release the
mouse.
Go to the Square tutorial to see how it works.

Circle (Shift-C)

Creates a circular spline.

To create a Circle, click and drag in the shape of a circle and release the mouse.
Go to the Circle tutorial to see how it works.
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Shape Parameters

All of the editable parameters of a shape can be adjusted in the Object
Parameters. When a shape is selected, you will see the parameters listed
below.

Blend Mode
Controls how objects are blended together.

Add

Adds the object to other objects.

Subtract

Subtracts the object from other objects.

Multiply

Produces a result where there is a union of pixels from two objects.

Difference

Produces a result where a value exists in each object, but not in both.
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Looks at the luminance information for each object and selects the value—
whichever is brighter—as the result. Darker pixels are replaced while brighter
pixels do not change.

Inside

Places the object inside the alpha generated by the objects below it.

Blur
Sets the blur level of the selected shape or shapes. The Blur range is from 0100 and defaults to 0.

Blur Type

Determines the type of blur.

• Centered
The blur is centered on the edge of the shape, equally blurring inward and
outward.

• Inner
The shape is blurred inward from the edge of the shape.

• Outer
The shape is blurred outward from the edge of the shape.

Shrink/Grow
Shrinks or grows the shape’s alpha channel. Negative values shrink and
positive values grow.

Opacity
Sets the opacity of the selected shape. The opacity range is from 0-100 and
defaults to 100. The interpolation type is set to Hold by default making it easy
to turn shapes on and off at particular frames.
Note: You can change the Opacity interpolation type from Hold to Linear at any time.
To do so, select the shape’s Opacity keyframes in the Timeline, right-click and select
Interpolation > Linear.

Invert
Inverts the shape values. The default is off.
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Motion blur is the directional blurring of rapidly moving shapes. This parameter
turns motion blur on or off for the selected shape or shapes. The default is off.
To affect a shape, Motion Blur also needs to be enabled in the Node window.
See the Motion Blur section of the Roto Node parameters for more
information.
Note: Normally, motion blur is calculated going forward, so if there is no shape motion
beyond the end of a clip, there won’t be motion blur on the last frame. To work around
this, add an extra frame or two to the end of the work range in the Timebar and move
the shape’s last keyframe to be outside of the session range.

Color
Sets the color of the shape outline. Left-clicking the color pot opens a standard
color picker while right-clicking on the color pot opens a pop-up color menu with
16 primaries.

When the Roto node’s Color > Enable parameter is on, this sets the color of the
filled shape.

Stroke Width
Sets the thickness of an open shape. When used on a closed shape, an outline
is created.

Cap Style
Sets the end cap style for open shapes. You can choose from Flat or Round
styles.

Channel
Determines what channel the shape is rendered into. You can set each shape
to Red, Green, Blue, or Alpha. To visualize the results prior to rendering, use
View > Channels in conjunction with the Alt-R, G, B and A shortcut keys. When
ready, render shapes into the assigned channels with the Actions > Render
Shapes to Channels action.
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Resets all parameters to their default state.

Layer Parameters
Layers are used to organize shapes, but more importantly they are used to
contain the motion information from trackers. All of the editable parameters of
a layer can be adjusted in the Object Parameters. When a layer is selected, you
will see the parameters listed below. The Transform,Blend Mode, Blur and
Invert state of a layer can be adjusted.

Transform
The Position, Scale, Rotation, Corner-Pin and Anchor Point can be adjusted
and animated.
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Sets the anchor point for the layer transformation. Scaling and rotation
operations center around the anchor point.

Position

Sets the horizontal and vertical position of the layer.

Scale

Sets the horizontal and vertical scale of the layer. Typing in a negative value will
flip or flop the shapes in the layer.

Rotate

Sets the rotation of the layer.

Corner-Pin

The layer can be corner pinned by adjusting the Corner-Pin values.
Upper-Left
Controls the X and Y position of the Upper Left Point.
Upper-Right
Controls the X and Y position of the Upper Right Point.
Lower-Right
Controls the X and Y position of the Lower Right Point.
Lower-Left
Controls the X and Y position of the Lower Left Point.

Matrix

When tracking data is applied to a layer, the Matrix parameter is used to store
the tracker keyframes.

Blend Mode

Controls how layers are blended together. See the Blend Mode section for
more information.
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Sets the blur level of all shapes within the layer. The Blur range is from 0-100
and defaults to 0.

Blur Type

Determines the type of blur.

• Centered
All shapes in the layer are blurred equally inward and outward centered on the
edge of the shapes.

• Inner
All shapes in the layer are blurred inward from the edge of the shapes.

• Outer
All shapes in the layer are blurred outward from the edge of the shapes.

Invert

Inverts all shapes within the layer. The default is off.

Channel

Determines which channel the shapes in the layer are rendered into. You can
set a layer to Red, Green, Blue, or Alpha. To visualize the results prior to
rendering, use View > Channels in conjunction with the Alt-R, G, B and A
shortcut keys.

Reset All

Resets all parameters to their default state.
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Once you draw a shape, there are various ways to modify it. As the object that
you are attempting to Roto changes over time, you will need to adjust the shape
so that it exactly matches the object. While the Transform tool affects an entire
shape or a group of shapes, you can use Reshape to modify individual points
on a shape. See Reshape for more information.
Go to the Transform tutorial to see how it works.

Transform - Shape Mode (T)
Transform Shape Mode allows you to position, move, scale, rotate, shear or
corner-pin a shape or selection of shapes using the on-screen controls. To
enter this mode, press either Transform in the Toolbar or the T key once. Then,
select a shape and use the on-screen controls to modify it.
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Transform On-Screen Controls
Shortcut

Action

Drag shape

Moves the shape

Shift-drag shape

Constrain shape movement horizontally or
vertically

Drag bounding box corner or edge handle

Scales a shape
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Shift-drag bounding box corner or edge handle Proportionally scale a shape
Ctrl/Cmd-drag on a bounding box corner handle Rotate a shape
Alt-drag on a bounding box corner handle

Corner-pin a shape

Alt-Shift-drag on a bounding box corner handle Constrains the corner-pin movement to one axis
Ctrl/Cmd-drag on a bounding box edge handle Shear a shape

. (period key)

Turns the Anchor Point on or off

Drag on Anchor Point

Moves the Anchor Point

Shift- (period key)

Moves the Anchor Point to the mouse location

Q

Activates / Deactivates translation of selected
shapes or layers

W

Activates / Deactivates rotation of selected
shapes or layers

E

Activates / Deactivates scaling of selected
shapes or layers

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W

Rotates without setting the anchor point

Ctrl/Cmd-E

Scales without setting the anchor point

.

If there are any selected layers while in the Transform tool, pressing Q, W or E
and then clicking and dragging will translate, rotate or scale the selected layers.
If there are no selected layers, you must select a shape or group of shapes
before clicking and dragging. Also, the position of the cursor when W or E is
pressed sets the anchor point for the rotation or scale operation.
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Transform Points Mode allows you to position, move, scale, rotate, shear or
corner-pin a selection of points using the on-screen controls. To utilize this
mode, use Reshape to first select some points

and then press either Transform twice in the Toolbar or the T key twice.

Instead of a bounding box with on-screen controls around the shape, the
bounding box is around the selected points.

Moving Shapes
Selected shapes are moved using one of three methods:
1

Drag on the outline of a shape.

2

Nudge the shapes using the arrow keys. See Nudging for more information.

3

Press the Q key to activate translation mode and click and drag to move the
selected shapes. You must press the Q key a second time to deactivate
translation mode.
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In either case, you can constrain movement along an axis by pressing the Shift
key while dragging the outline of a shape. The movement is constrained by the
first direction (horizontal or vertical) that you drag in.
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Scaling Shapes
Scaling changes the size of the shapes. Selected shapes are scaled using one
of two methods: 1) Drag any of the points on the shape bounding box or 2)
Press the E key to activate scaling mode and click and drag to scale the
selected shapes. You must press the E key a second time to deactivate scaling
mode.

Note: The position of the cursor when E is pressed sets the anchor point for the scaling.

To proportionately scale, hold down the Shift key when resizing.

Rotating Shapes
Rotating changes the angle of the shapes. Selected shapes are rotated using
one of two methods: 1) Ctrl/Cmd-drag on a shape bounding box corner handle
or 2) Press the W key to activate rotation mode and click and drag to rotate the
selected shapes. You must press the W key a second time to deactivate
rotation mode.

Note: The position of the cursor when W is pressed sets the anchor point for the
rotation.
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The corner points of a shape’s bounding box can be corner-pinned. For
instance, you could fit the corners of a shape into the corners of a billboard. Altdrag the corners of the shape’s bounding box to corner-pin the shape.

Shearing Shapes
Shapes can be sheared resulting in the shape being skewed horizontally or
vertically. To shear a shape, Ctrl/Cmd-drag on the midpoints of a shape
bounding box on either the horizontal or vertical axis.

Anchor Point
A shape rotates around its center point, but scales from the opposite handle.
Moving the anchor point changes the center of rotation and scaling when using
the on-screen controls. To position the Anchor Point, press the (period key)
and the Anchor Point is displayed on the screen. Then, click and drag the
Anchor Point to the desired location.

.
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Now, when you rotate or scale the shape, notice how the shape rotates and
scales around the Anchor Point.
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Note: If more than one shape is selected, they will both rotate and scale around the
Anchor Point.

Cutting, Copying and Pasting Shapes
Shapes can be cut(Ctrl/Cmd-X), copied(Ctrl/Cmd-C) and pasted(Ctrl/CmdV).

Deleting Shapes
A shape or selection of shapes can be easily deleted using none other than the
Delete key.

Selecting Shapes
Shortcut

Action

Click on a shape

Selects the shape

Shift-click a shape or drag select multiple shapes

Selects multiple shapes

Ctrl/Cmd-click on a shape

Toggles the shape selection

Click anywhere off the shape

Deselects all shapes

Shift-click color pot in the Object List

Selects shapes of same color
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When a layer is selected and the Transform tool is active, you can set the
Position, Scale, Rotation, Corner-Pin and Anchor Point of the layer using the
on-screen controls.
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Layer Transform On-Screen Controls
Shortcut

Action

Drag within large center circle

Moves the layer

Shift-drag within large center circle

Constrain layer movement horizontally or vertically

Drag the intersection of the center square
and the horizontal and vertical lines

Scales the layer horizontally or vertically

Drag the center square corner

Proportionally scale the layer

Drag large center circle

Rotate the layer

Ctrl/Cmd-drag large center circle

Rotates the layer with finer control

Drag handles on corners of image

Corner-pins the layer

Drag small center circle

Moves the Anchor point

Q

Activates / Deactivates translation of selected layers

W

Activates / Deactivates rotation of selected layers

E

Activates / Deactivates scaling of selected layers

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments
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You can also use the arrow keys to nudge the layer. See Nudging for more
information.
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Reshape modifies shapes by adjusting their control points and tangents. In this
mode, the shape’s control points and tangents are visible. You must first select
a control point before it can be modified.

Reshape - Normal Mode (R)
Selected points all move the same amount.

Reshape - Magnet Mode (RR)
Points near the cursor move more than points farther away.

While in Magnet mode with multiple selected control points, you can Shift-Alt
click in the Viewer, not on any control points or shapes, and that becomes the
magnet pull position instead of using a point.
Note: If you prefer, use the Shape > Default Reshape Tool preference to set Magnet
mode as the default mode.
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Click on a single point to select it, Shift-click to add to the selection or
Ctrl/Cmd-click to toggle the point selection.

Rectangular Selection
Click and drag a rectangle over the control points to be selected. This is the
default behavior.

Freehand Selection
Control points can be selected by drawing a freehand polygon. Ctrl/Cmd-drag
in the Viewer to begin the selection. Once the selection is started, release
Ctrl/Cmd and complete the selection.
Note: A Shape > Freehand Point Selection preference controls whether freehand
selection is used by default. Pressing Ctrl/Cmd and dragging uses the non-default
method of selection. See the Shape Preferences for more information.

Control Point Selection Keyboard Shortcuts
Shortcut

Action

Click on a control point. If the control point is part of a
Bézier curve, its tangents appear

Selects the control point

Shift-click the control points or drag select multiple
control points

Selects multiple control points

Ctrl/Cmd-drag in the Viewer to begin the selection. Once Freehand select multiple control points
the selection is started, release Ctrl/Cmd- and complete
the selection
Ctrl/Cmd-Alt-I

Inverts the point selection

Alt-Shift-A

Selects all control points

Alt-Ctrl/Cmd-A

Deselects all control points

Ctrl/Cmd-click on a control point

Toggles the point selection

Click anywhere off the shape

Deselects all control points

Note: When in the Left/Right View of a stereo project, changing point selection on one
shape will match the point selection on the linked shape.

Go to the Reshape tutorial to see how it works.
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Adding control points assists in tracing more detailed images. To add a control
point, Alt-click on the selected shape. Don’t click on an existing control point
because it will move it instead.
Note: In a stereo project, adding points is only allowed when in the Left/Right View
when both shapes are selected.

Deleting Control Points
You can delete control points in one of two ways. Select the control point and
press the Delete key or right-click on the control point and select Delete from
the Reshape pop-up menu.
Note: In a stereo project, deleting points is only allowed when in the Left/Right View
when both shapes are selected and when both shapes have the same selected control
points.

Moving Control Points
Control points are easily moved. Just select one or more control points and
drag one of the selected points to a new location. You can also use the arrow
keys to nudge the points. See Nudging for more information.

Numbering Points
All points or a selection of points can be numbered. To number one point or a
selection of points, right-click on a selected control point and select Tag. To see
all points numbered, go to File > Preferences > Shape on Windows and Linux
or Silhouette > Preferences > Shape on Mac and set the Number Points
preference to All.
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A shape’s points can be feathered to create variable edged blurs on a point by
point basis.

Closed Shapes
In the Reshape tool, selected points display a red, outward feather handle.
Dragging this handle outward will pull the feather out.

After the initial drag, the outer feather point can be dragged around
independently.

To drag shape and feather points simultaneously, press Shift while dragging
the shape point.
The display of the feather handles can be hidden using Alt-F.
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Feather Shortcuts
Shortcut

Action

Alt-F

Toggles the shape feather handle on/off

Shift-Drag Shape Point

Moves shape and feather points simultaneously
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Open Shapes
In the Reshape tool, select an open shape, adjust the Stroke Width to set its
thickness and choose either a flat or round Cap Style in the Parameters
window. Once you've done this, additional per-point feather handles appear--a
red one for the Stroke Width and a green one for the Feather.

Just drag on the handles to make adjustments.

Multiple selected points can be dragged simultaneously and by a proportionate
amount. To move the shape and feather points simultaneously, press Shift
while moving the shape point.
Go to the Feather tutorial to see how it works.
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Right-click over a control point to open the Reshape pop-up menu and select
one of the options. The options will change depending on the type of shape that
is selected.

To modify multiple selected points simultaneously, do not right-click on one of
the selected points. Right-click on an open area of the Viewer instead.

Invert Selection
Inverts control point selection state.

Delete
Deletes the selected control point.

Break
Breaks the shape at the selected control point.

Close
Closes an open shape.

Reset
Resets the attributes of the selected control point.
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Linear

Both tangents are adjusted to one quarter the distance and in the direction of
their adjoining control points.

Corner

Creates a corner point.

Cardinal

Creates a smooth point where the curve passes smoothly through it.

B-Spline Options
Corner

Creates a corner point.

B-Spline

Creates a smooth point that is determined by the surrounding points.

X-Spline Options
Corner

Creates a corner point.

Cardinal

Creates a smooth point where the curve passes smoothly through it.

B-Spline

Creates a smooth point that is determined by the surrounding points.

Center
Centers the control point between its adjoining control points.

Tag
Tags control points for point numbering. For point numbers to be displayed, the
Shape > Number Points preference must be set to Tagged.

Tween
Takes the point and “re-tweens” it using the surrounding keyframes, and puts
them where they would be if you hadn't moved them on that frame. Useful for
simulating an “unkey” of selected points (the shape remains keyed of course).
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Reverses the order of all control points on all keyframes. Useful for warping and
morphing, Reverse is used when you are trying to join two shapes where the
control points go clockwise in one and counter-clockwise in the other. In this
case, the correspondence points would iterate in different directions and the
lines would cross each other. Reversing the points of one of the shapes would
make them go in the same direction and the correspondence would be correct.

Combine Shapes
Copies selected points from a source shape between the selected points of a
target shape.

Combining Shapes
• Select the points from a source shape to be copied into a target shape.
• Ctrl/Cmd-click the target shape in the Object List.
• Select two adjacent selected points in the target shape.
• Right-click and choose Combine Shapes.

Extract Shape
Extracts the selected points of a shape into a new closed shape.

Breaking Shapes
In the Reshape tool, closed shapes can be opened using the Break option from
the control point pop-up menu. To break a shape, select a point and right-click
on it to open the pop-up menu. Choose Break and the shape opens at the
selected control point.
Note: Feather information will be removed once you break a shape.

Closing and Extending Shapes
Shapes can be closed or extended with just a few mouse clicks. It is necessary
to use the Reshape tool to perform the following actions.

Closing Open Shapes
Select one of the control points at the end of the shape and Alt-click on the
other end point to close the shape.
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Select a control point at either end of the shape and Alt-click somewhere off
the shape.

Joining Open Shapes
In the Reshape tool, open shapes can be joined together. To join open shapes,
select one of the end points of the source shape by clicking on it. Next, make
sure both shapes are selected in the Object window. Finally, Alt-click on one of
the end points of the target shape. The two shapes are now joined together as
one.
Note: The target shape inherits the attributes of the source shape.

Converting B-Splines or X-Splines to Bézier Splines
You may convert your B-Splines or X-Splines to Bézier splines at any time. To
convert a B-Spline to a Bézier spline, select a B-Spline or X-Spline and choose
the Edit > Spline > Convert to Bézier menu item.
Once you select Convert to Bézier, a couple of things happen. The visibility of
the B-Spline or X-Spline is toggled to off. A new Bézier spline is created and is
named the same as the B-Spline or X-Spline but has an * at the end of the
name.
Note: The Bézier conversion of B-Splines that use extreme, variable weight
adjustments will not exactly match the original B-Spline. Do not use extreme, variable
weight adjustments if you are planning on converting the B-Spline to a Bézier.

Nudging

Shapes, control points and layers can be nudged using the Arrow keys. One
press of the Arrow key moves 1 pixel. Using the Shift key in conjunction with
the Arrow keys moves 10 pixels. Ctrl plus the Arrow keys moves one tenth of
a pixel. These nudge values can be changed in the Preferences menu located
in File > Preferences > Nudging on Windows and Linux or Silhouette >
Preferences > Nudging on Mac. Holding the Arrow keys down moves the
selection continuously.
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Nudging Keyboard Shortcuts
Shortcut

Action

Arrow keys

Moves by 1 pixel

Shift-Arrow keys

Moves by 10 pixels

Ctrl/Cmd-Arrow keys

Moves by one tenth of a pixel

Hold down Arrow keys

Moves continuously

Q, W, E then Ctrl/Cmd-drag

Translates, Rotates or Scales in finer increments

Q, W, E then Arrow keys

Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys

Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys

Translates, Rotates or Scales by 1/10 of a pixel
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Note: Nudging of the layer transform is only available if one layer is selected, and no
shapes are selected. This is to avoid confusion in case nested layers or objects in them
are also selected.

IK-Inverse Kinematics (Y)

In computer graphics, inverse kinematics (IK) is a technique that provides
automatic movement of objects. It allows elements of an object to be linked,
such as the parts of an arm or leg, and causes them to move in a prescribed,
realistic manner. IK simplifies the process of rotoscoping jointed, segmented
figures by making the motion of each part related to the motion of the linked
parts. That way, you simply have to animate the starting and ending joints, and
the ones in between will adjust themselves and create more natural looking
movement.

Go to the IK tutorial to see how it works.
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Silhouette implements IK within its existing infrastructure by using layers to
model joints with one or more shapes in each layer to represent the pieces of
the object. To do an arm, you would have this layout:
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Arm, Elbow and Wrist are layers while Upper Arm, Forearm and Hand are
shapes located in the appropriate layer.
Once the layers and shapes have been setup, the joints need to be placed by
positioning the Anchor Point of each layer using the Transform tool.
Joints
Arm

Elbow

Wrist
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With the IK tool selected, select the shapes and an IK chain is built on the fly
that flows up the shape's layer tree to the top-most layer. Each layer’s Anchor
Point becomes a joint in the IK chain. The “bones” are just the connections
between the layer anchors.
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Click-drag a bone or shape to rotate the shape around the parent’s anchor
point. Click-dragging a joint uses IK to rotate all joints up the chain. Alt-clickdrag a joint to move the joint while attempting to keep other joints in place.
When animated, keyframes are automatically set for each layer’s rotation
parameter. However, you can explicitly set the layer rotation keyframes by rightclicking on a selected bone and choosing Add Key.
Note: To quickly jump between the Reshape, Transform, and IK tools while editing a
shape, use the shortcut keys: R for Reshape, T for Transform and Y for IK. R, T and Y
are very convenient since they are right next to each other.
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IK Editing
Action

Result

Click-drag bone or shape

Rotates the shape around the parent’s anchor point

Click-drag joint

Uses IK to rotate all joints up the chain

Alt-click-drag joint

Moves the joint but tries to keep other joints in place

Right-click bone-Add Key

Sets keyframes for the selected bones
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Tracker

Tracking is a technique that involves analyzing the motion of an image over
time. In Silhouette, images can be tracked using an automatic image tracking
system called Planar Tracking or Point Tracking which utilizes either one, two
or four track points. Silhouette includes two Planar Trackers: Silhouette’s
Planar Tracker and the Mocha Planar Tracker.
Go to the Tracker to see how it works.
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Normally, adjusting a shape or points on a shape are keyframed only on that
particular frame. When MultiFrame is activated, it modifies the Transform and
Reshape tools to allow you to make adjustments across all previously set
keyframes or a selection of keyframes. A red outline is drawn around the
Viewer to let you know that MultiFrame is active.

To use MultiFrame, select it in the Toolbar. Then, drag the red ends of the
MultiFrame range bar at the top of the Timeline to limit the keyframes affected
by MultiFrame.
Note: The MultiFrame range is displayed in the status bar while it is being edited.

The Transform or Reshape tools will now only affect keyframes within the
MultiFrame selection.
Go to the MultiFrame tutorial to see how it works.
Note: When using MultiFrame, attempts to edit a shape outside the MultiFrame work
range will be ignored. If you try to, for example, transform a shape and nothing
happens, check to see if the MultiFrame range is active at that particular point in time.

Add Weighted Key (Alt-K)

Add Weighted Key creates a keyframe at the current position which changes
the timing of the animation between two surrounding keyframes. Park between
two keyframes, select a shape, press Alt-K, and drag the slider to adjust the
weight.
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RotoOverlay (Shift-O)
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The RotoOverlay tool provides three options to visualize the selected shape’s
animation and motion blur: Motion Path, Motion Blur and Onion Skin.

Once selected, a Roto Overlay window opens allowing you to select or deselect
various options.

Motion Path
Displays the shape’s motion path with visual indicators for frames and
keyframes.

Hold Alt over a motion path marker and the frame number is displayed in the
status bar. Click on the marker and the Timebar will jump to that frame.
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Displays a dashed line to show the width of the motion blur.

Note: When the Viewer is set to Foreground, this option allows you to visualize the
motion blur without rendering it. This provides a significant speed increase when using
many shapes with motion blur.

Onion Skin
Shows the shape outline on previous and future frames.

Hold Alt over an onion skin shape and the frame number is displayed in the
status bar. Click on the shape and the Timebar will jump to that frame.
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Determines the amount of frames used in the onion skin.
Backward
The Onion Skin Frame Range Backward numeric field (the first one) displays
the frames before the current frame.
Forward
The Onion Skin Frame Range Forward numeric field (the second one) displays
the frames after the current frame.
Note: By default, the Backward and Forward numeric fields are ganged together. Click
the lock icon to decouple them.

Use Shape Color
As an alternative to using the pre-defined colors for the Motion Path, Motion
Blur and Onion Skin, you can use the default shape colors.

Shape Import

Importing Shapes
Silhouette, Mocha Pro, Commotion, Elastic Reality and Shake 4.x SSF shapes
can all be imported into Silhouette using the File > Import > Shapes menu.

Note: Mocha Pro shapes and layers are imported into Silhouette using the Silhouette
Shapes format. If Copy to Clipboard was used in Mocha Pro instead of saving to a file,
the shapes and layers are copied to the system clipboard and can then be pasted into
Roto.

Go to the Import tutorial to see how it works.

Node Parameters

When the Roto is selected, parameters specific to Roto, such as Motion Blur,
can be adjusted in the Node parameters.

Alpha
Invert
Inverts the alpha channel.

Blur
Blurs the alpha Channel. The blur range is from 0-100 and defaults to 0.
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Renders shapes as outlines or filled with color in the RGB output. The color is
set using the Shape > Color parameter.

Enable
Activates the color parameters.

Outline Size
Sets the thickness of the shape outline.

Fill Opacity
Sets the opacity of the color fill. You can also change the opacity of each shape
separately using the Shape > Opacity control.

Motion Blur
Motion blur is the directional blurring of rapidly moving shapes. Enables Motion
Blur for Roto.
Go to the Motion Blur tutorial to see how it works.

Enable
Turns Motion Blur on or off. The default is off. Leave this turned off for faster
interaction while editing shapes.
Note: The Motion Blur parameters will not affect shapes unless you first activate Motion
Blur for each shape in the Object Parameters. See the Motion Blur section in the
Shape Parameters for more information.

Shutter Angle
Determines how long the camera shutter stays open when a picture is taken-higher values create more motion blur. The range of the Shutter Angle is 0-720
and defaults to 180. Measured in degrees, it simulates the exposure of a
rotating camera shutter. The shutter angle uses the footage frame rate to
determine the simulated exposure. For example, a shutter angle of 180
degrees (50% of 360 degrees) for 24fps footage creates an effective exposure
of 1/48 of a second. Typing 1 degree applies almost no motion blur, and typing
720 degrees applies a high degree of motion blur.
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Offsets the point in time, either forward or reverse, when the shutter opens. The
range of the Shutter Phase is -360 to 360 and defaults to -90.

Motion Samples
Renders intermediate frames equal to the Motion Samples value and
accumulates them, one over the other, on a single frame. The higher the
number, the smoother the motion. The Motion Samples range is from 1-256
and defaults to 16.
Note: Normally, motion blur is calculated going forward, so if there is no shape motion
beyond the end of a clip, there won’t be motion blur on the last frame. To work around
this, add an extra frame or two to the end of the work range in the Timebar and move
the shape’s last keyframe to be outside of the session range.

Antialias
Controls whether roto shapes are antialiased on their edges.
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Description

Tracking is a technique that involves analyzing the motion of an image over
time. Images can be tracked using an automatic image tracking system called
planar tracking using either Silhouette’s Planar Tracker or the Mocha Planar
Tracker. In addition, you can use a Point Tracker which utilizes either one, two
or four track points. One point tracking obtains horizontal and vertical
movement. Two point tracking analyzes scaling and rotation in addition to
horizontal and vertical movement. Lastly, four point tracking evaluates and
applies perspective movement using a corner-pin transformation.
However the tracking data is obtained, it can then be applied in one of two
ways: match moving or stabilization. Match moving applies the motion of the
trackers to an object so that it follows the motion of the clip. Stabilization inverts
the tracking data so that the clip appears to be stable.
The Tracker tool is located in the Roto node and when selected displays
various tracking features and controls.

When the Tracker (Shift-T) is selected, various non-animateable controls
appear in a Tracker Tool Tab located at the bottom portion of the screen. You
have the choice of using either the Point Tracker, Planar Tracker or Mocha
Tracker.
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Silhouette’s Planar Tracker tracks several points (corners, edges and ridges)
on the image while automatically handling partial occlusions of the tracked
object, producing excellent results even with textureless objects.

Using the Planar Trackers
The key to getting the most out of the Planar and Mocha trackers is to learn to
find planes of movement in your shot which coincide with the object that you
want to track. Sometimes it will be obvious--other times you may have to break
your object into different planes of movement. For instance, if you were tracking
a tabletop, you would want to draw the spline to avoid a flower arrangement in
the center of the table, since it is not on the same plane and will make your track
less accurate.
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Both the Planar and Mocha trackers require a selected layer with at least one
shape in it to drive the tracker.
Note: If shapes are selected and not in a layer, clicking the Track Forward/Backward
buttons will create a new layer, make it active and begin tracking.
If shapes are selected in an unselected layer, clicking the Track Forward/Backward
buttons will make the layer active and begin tracking.

The shape should surround the object you are tracking, but it does not have to
be exact and it is best to leave a little extra room around it. In addition, you can
use more than one shape as long as they are on the same geometric plane.

Handling Occlusions
In some cases, there are parts of an image that can interfere with the
effectiveness of the Planar and Mocha trackers. To handle this, you can create
an exclusion zone in the area you are tracking. For instance, a computer screen
with strong reflections could cause the track to jump. To exclude an area while
tracking, create a subtractive shape above the primary tracking shape. Then,
select both the shapes prior to tracking.
Go to the Planar Trackers tutorial to see how it works.

Tracker Direction
The Tracker Direction buttons are used to track backwards and forwards and
are enabled when a layer has been selected.

Track Backward One Frame
Tracks backward one frame at a time.

Track Backward
Tracks backward to the beginning of the Timebar.
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Tracks forward to the end of the Timebar.

Track Forward One Frame
Tracks forward one frame at a time.

As you track, the tracker’s transform data is automatically applied to the
selected layer.
Note: When a layer is selected prior to tracking, the per-shape blend mode, invert
state, on/off state and opacity are all obeyed. This allows you to use multiple shapes
while tracking.

Channel
Determines which image channel the tracker uses to analyze the image.

Luminance
The tracker analyzes the luminance or brightness of the image.

Red
The tracker analyzes the image’s red channel.

Green
The tracker analyzes the image’s green channel.

Blue
The tracker analyzes the image’s blue channel.

Reset
Resets the tracking points.

Tracking Features
Auto
Tracks corners, edges and ridges and automatically selects the best result.
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Tracks corners, crosses or points.

Edges
Tracks edges of a solid object.

Ridges
Tracks lines appearing as a strips or bands.

Motion Model
Perspective
Tracks perspective changes. Good for large shapes.

Affine
Tracks translation, rotation, scale, and skew. Good for medium shapes.

Translation
Tracks the XY offset. Good for small shapes.

Min Features
The minimum number of trackers to generate.

Max Features
The maximum number of trackers to generate.

Min Dist
The minimum distance between trackers.

Max Age
The maximum number of frames a specific tracker will live until it is removed
and a new tracker is generated.
Note: If you have really good tracks, you can increase the Max Age to cover the entire
sequence and the trackers will live for the entire time and will result in a smoother
transform. However, this value has to remain low to handle automatic occlusion
handling.

Valid Tracks
The number next to Valid Tracks is a running total of the number of trackers that
are viable as the tracker progresses.
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Displays the reference frame number. The reference frame is the frame you
first started tracking on and it locks in the picked set of track points at that
frame.

Jump to Reference Frame
When clicked, the Timebar is positioned at the reference frame.

Group Tracking
Multiple layers containing non-overlapping shapes are tracked as separate
planar surfaces.
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With multiple layers containing overlapping shapes, there is an interaction
between them whereby they share coarse motion, but have individual motion
at the fine scale. This is helpful when tracking non-planar surfaces.
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The Mocha Planar Tracker provides 2D transformation data by tracking planes
rather than points.
Go to the Planar Trackers tutorial to see how it works.

As with Silhouette’s Planar Tracker, the Mocha Planar Tracker requires that you
create a layer in the Object List and have at least one shape within it to drive
the tracker. The shape should surround the object you are tracking, but it does
not have to be exact and it is best to leave a little extra room around it. In
addition, you can use more than one shape as long as they are on the same
geometric plane.

Tracker Direction
The Tracker Direction buttons are used to track backwards and forwards and
are enabled when a layer has been selected.

Track Backward One Frame
Tracks backward one frame at a time.

Track Backward
Tracks backward to the beginning of the Timebar.
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Tracks forward to the end of the Timebar.

Track Forward One Frame
Tracks forward one frame at a time.

As you track, the tracker’s transform data is automatically applied to the
selected layer.
Note: When a layer is selected prior to tracking, the per-shape blend mode, invert
state, on/off state and opacity are all obeyed. This allows you to use multiple shapes
while tracking.

Channel
Determines which image channel the tracker uses to analyze the image.

Luminance
The tracker analyzes the luminance or brightness of the image.

Red
The tracker analyzes the image’s red channel.

Green
The tracker analyzes the image’s green channel.

Blue
The tracker analyzes the image’s blue channel.

Min % Pixels Used
Min % is one of the most important parameters to look at for tracking. By
default, the minimum percentage of pixels used is dynamic. When you draw a
shape, the Mocha Planar Tracker tries to determine the optimal amount of
pixels to look for in order to speed up tracking. If you draw a very large shape,
the percentage will be low. If you draw a small shape, the percentage will be
high.
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Min % Pixels Used is set to Auto by default.

Motion
These Motion parameters control what motion you are looking for when you
track.

Translation
The position of the object.

Scale
Whether the object gets larger or smaller.

Rotation
The angle of rotation of the object.

Shear
How the object is skewing relative to the camera.

Perspective
How the object is moving in perspective relative to the camera.
The main difference between shear and perspective is the relative motion.
Shear is defined as the object warping in only two corners, whereas
perspective is most often needed where the object is rotating away from the
viewer significantly in space.
As an example, if someone is walking towards you, their torso would be
showing shear as it rotates slightly back and forth from your point of view.
The front of a truck turning a corner in front of you would be showing significant
perspective change.

Large Motion
This is the default. It searches for motion and optimizes the track as it goes.
Small Motion is also applied when you choose Large Motion.
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Small Motion only optimizes. You would use Small Motion if there were very
subtle changes in the movement of the object you are tracking.

Search Area
The Search Area defines ranges for the tracker to search within.

Horizontal/Vertical
Determines the distance in pixels within the footage to search for the next
object position. This is set to Auto by default.

Angle
If you have a fast rotating object, like a wheel, you can set an angle of rotation
to help the tracker to lock onto the detail correctly. The tracker will handle a
small amount of rotation, less than 10º per frame, with Angle set to zero.

Zoom %
If you have a fast zoom, you can add a percentage value here to help the
tracker. Again, the tracker will still handle a small amount of zoom with this set
to zero.
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The Point Tracker uses trackers which are placed on distinguishable image
features.

Go to the Point Tracker tutorial to see how it works.

Tracker Components
Each tracker has a Match Area, Search Region, and Track Point.
Search Region
Match Area
Track Point

Match Area
The inner box is the Match Area. It defines a pattern that will be searched for
from frame to frame. It's a good idea to choose a region with good contrast and
detail. Corners with sharp contrast are usually good areas to track as
movement can easily be detected in any direction. The Match Area can be
scaled to the desired size.
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The outer, dashed box is the Search Region, which should be the maximum
amount your tracking point will move between frames. The larger the size, the
slower the processing. The trick is to make the Search Region as small as
possible, yet still large enough to cover the area the tracker will move from
frame to frame. The Search Region can be sized in the same fashion as the
Match Area.

Track Point
The center cross is the track point. It represents the position of the motion track.
Normally, the Track Point is at the center of the tracker, but can be offset if the
Match Area becomes obscured.

Tracker Direction
The tracker can track both forward and backward one frame at a time or for the
entire duration. The controls are enabled once a tracker has been selected.

Track Backward One Frame
Tracks backward one frame at a time.

Track Backward
Tracks backward to the beginning of the Timebar.

Track Forward
Tracks forward to the end of the Timebar.

Track Forward One Frame
Tracks forward one frame at a time.
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Behavior decides what frame should be used as the reference to check the
accuracy of the Match Area. By default, the reference is the first frame at which
you started the track.

Start Frame
At each frame, the Match Area is compared to the first frame at which you
started tracking. If you stop tracking halfway through your clip, and start up
again at a later frame, the later frame will be used as the reference.

Every Frame
The Match Area is compared to the previous frame. This method will cause
inherent drift in your track, but is useful for clips that have drastic changes in
perspective and scale.

Key Frames
For difficult shots, it is helpful to pre-set keyframes for the tracker at various
points in the clip. The Match Area will use these keyframes as a reference while
tracking.

Tolerance
Describes the level of accuracy between the Match Area that the Tracker is
searching for and the area it actually finds when searching from frame to frame.
A prefect match would be a value of 100. If the error that is calculated is below
the Tolerance value, no keyframe will be set on that particular frame. The
Tolerance is preset to a value of 75.
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Clicking on the Create button places a new tracker in the center of the screen.
You can also add a new tracker at any time by Alt-clicking the image when the
Tracker is activated.

Apply
Selecting the Apply button opens the Match Move window where you
determine how the tracking data will be applied.

When OK is clicked, the tracking data is transferred to the Layer’s > Transform
> Matrix parameter.
Note: With only trackers selected, clicking Apply creates a new layer and the tracking
data is applied to that layer.
If a layer is selected along with the trackers, the tracking data will be applied to the
selected layer.

Go to the Applying Trackers tutorial to see how it works.

Position
Applies X/Y position data to the layer.

Scaling
Applies X/Y scaling data to the layer. Requires two trackers.
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Applies rotation data to the layer. Requires two trackers.

Average
Averages multiple tracks into a new destination track. A common technique is
to track forwards from the first frame to the last, and then create a second track,
tracking backwards from the last frame to the first. These two trackers are then
averaged together to derive a more accurate track.

To average trackers, select more than one tracker and click the Average button.
A new averaged tracker is created.
Go to the Averaging Trackers tutorial to see how it works.

Merge
If you have multiple trackers that cover different frame ranges, they can be
merged into one tracker, automatically compensating for the different offsets.

Ideally, the trackers should overlap in time by at least one keyframe.
Go to the Merging Trackers tutorial to see how it works.

Tracker Parameters
Most tracker parameters are interactively set while moving the tracker in the
Viewer. When a point tracker is selected, its parameters are displayed in the
Object Parameters.
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A magnified version of the Match Area is displayed to aid in the placement of a
tracker. It is activated when you click the Create button or when you move an
existing tracker. The magnified area is displayed in the color space selected
from the Mode pop-up menu.

Position
Sets the position of the Track Point. This parameter is automatically set when
using the on-screen tracker controls.

Nudging Trackers

Trackers can be nudged using the Arrow keys. One press of the Arrow key
moves the tracker 1 pixel. Using the Shift key in conjunction with the Arrow
keys moves the tracker 10 pixels. Ctrl plus the Arrow keys moves the tracker
one tenth of a pixel. These nudge values can be changed in the Preferences
menu located in File > Preferences > Nudging on Windows and Linux or
Silhouette > Preferences > Nudging on Mac. Holding the Arrow keys down
slides the tracker.

Tracker Nudging Keyboard Shortcuts
Shortcut

Action

Arrow keys

Moves the tracker by 1 pixel

Shift-Arrow keys

Moves the tracker by 10 pixels

Ctrl/Cmd-Arrow keys

Moves the tracker by one tenth of a pixel

Hold down Arrow keys

Moves the tracker continuously

Channel
Determines which image channel the tracker uses to analyze the image.
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The tracker analyzes the red, green and blue channels of the image.

Luminance

The tracker analyzes the luminance or brightness of the image.

Red

The tracker analyzes the image’s red channel.

Green

The tracker analyzes the image’s green channel.

Blue

The tracker analyzes the image’s blue channel.

Match Offset
Offsets the Match Area from the tracker. This parameter is automatically set
when using the on-screen tracker controls.

Search Offset
Offsets the Search Region from the tracker. This parameter is automatically set
when using the on-screen tracker controls.

Match Size
Sets the size of the Match Area. This parameter is automatically set when using
the on-screen tracker controls.

Search Size
Sets the size of the Search Region. This parameter is automatically set when
using the on-screen tracker controls.

Path Color
Sets the color of the tracker’s path. Left-clicking the color pot opens a standard
color picker while right-clicking on the color pot opens a pop-up color menu with
16 primaries.
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Point Tracker
With the Tracker tool enabled, right-click over a shape or a selected control
point to open the Tracker pop-up menu.

Trackers can be created based on a shape’s points, the center point of a shape
or the shape’s bounding box. Trackers created in this manner are a
concatenation of the shape and layer transformation data. So, why do this?
Because, it is a handy way of creating trackers with all of this combined data
for use in other programs.

Create Corner Trackers from Shape Bounds

Creates four trackers around the four corners of the shape bounding box.

Create Tracker from Shape Center

Creates one tracker in the center of the shape.

Create Tracker from Points

Creates trackers from selected points.

Planar Tracker

Create Point Tracker

Planar Tracker track points can be converted to point trackers which can then
be treated like any other point tracker; they can be merged, smoothed,
averaged, and applied to layers. Right-click on a planar track point, choose
Create Point Tracker and a new point tracker is created.

Pre-Processing

Images that contain film grain or video noise, lack contrast or sharpness as well
as images that have flicker can be tracked more accurately by applying certain
filters during the tracking process. Filters such as Blur, Sharpen, Contrast,
Gamma, De-Noise and Remove Flicker will increase tracker accuracy for
problematic images.
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Applies a blur to the image features.

Sharpen
Sharpens image features.

Contrast
Increases contrast.

Gamma
Increases brightness by leaving the white and black points the same and only
modifies the values in-between.

De-Noise
Applies a de-noise algorithm to smooth out noise while retaining detail.

Remove Flicker
Corrects image flicker or brightness variation over time, which has a habit of
interfering with tracker accuracy.

Preview
Shows the effect of the Pre-Processing parameters on the entire image in the
Viewer.

Smooth

Smooths out inaccuracies in the tracking data.

To smooth, select a point tracker or planar tracked layer and click the Smooth
button. Adjust the slider when it pops-up and adjust it to the desired level of
smoothing.
Go to the Smoothing Point Trackers or the Smoothing Planar Tracked
Layers tutorials to see how it works.

I/0

Importing and exporting tracking data takes place in the I/0 section of the
Tracker tab.
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After Effects Corner-Pin, Nuke, Shake or Simple Format formatted trackers can
be imported into Silhouette. If you would like to import trackers from nonsupported applications, simply export a Silhouette tracker in Simple Format to
see how it should be formatted.
Go to the Importing Tracking Data tutorial to see how it works.

Export
Trackers can be exported to the After Effects, Autodesk, Nuke and Shake
tracker formats. In addition, the tracking data applied to a layer, either by the
Point Tracker or Planar Tracker, can be exported as a four point corner-pin
track.
To create trackers for export that are a concatenation of the shape and layer
transformation data, see the Tracker Pop-Up Menu section for more
information.
Go to the Exporting Tracking Data tutorial to see how it works.

View

Shapes, points or tracker vectors can be toggled on or off.

Shapes
Toggles the display of shapes in the Viewer.

Points
Toggles the display of Planar Tracker track points in the Viewer.

Vectors
Toggles the display of tracking vectors in the Viewer. This option is not available
for use with the Planar Tracker.

Preferences

Seldom adjusted tracker controls can be accessed by clicking the Tracker
Preferences icon.
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Preferences allow you to customize default settings and can be accessed by
selecting File > Preferences on Windows and Linux or Silhouette > Preferences
on Macintosh.
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Interval (minutes)

Sets the default time for autosaving the project. Set interval to 0 to disable
autosave.

Maximum # of Backups

Controls how many backup files are created. Each time a project is saved, a
copy is stored in the project folder.
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% ROI Overscan

Sets the amount of extra pixels to save around the ROI in the Cache.

% Total Physical RAM

Sets the amount of RAM to be used for playback. The default is 50% and the
range is 10-90%.
Note: A program restart is needed to enable % Total Physical RAM changes.
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Cineon/DPX Working Colorspace

Controls whether or not Cineon and DPX images are converted to scene linear.

Linear
Converts the Cineon/DPX images to scene linear.

Log
Cineon/DPX images are kept in log space.
Note: After changing this preference, you must restart Silhouette for changes to take
effect as the value is cached.
Warning: It is not a good idea to change this preference in the middle of a paint
session, since when in Linear mode, it physically alters the pixels on import/export.

OCIO Configuration

This preference is a path to a global configuration file to use. The default is
“$(OCIO)”. Silhouette will initially look for $SFX_OCIO and will use that first.
Otherwise, it will use whatever the configuration preference is set to and finally
it will check for $OCIO. If it still can't find a configuration, it will fall back to the
embedded configuration in the resources/ocio folder.
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The Environments preference sets environment variables directly inside
Silhouette without having doing so in the operating system. Once applied,
variables are immediately available in Silhouette, sub-processes, and scripts.

+
-

Adds a new variable
Remove the selected variable.

Show Internal Variables

Display the internal variables used by Silhouette. These cannot be changed.
Note: Variables can contain references to other variables.

Note: Variables are changed when Apply is pressed. Reset has no effect for this page.
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The GPU preference determines whether or not GPU acceleration is enabled.

Auto

Automatically chooses either GPU or CPU acceleration based on your graphics
card.

GPU

Forces GPU acceleration on. If your graphics card is not capable of GPU
acceleration, this setting will have no effect.

CPU

Forces CPU acceleration on.

Note: The GPU preference doesn’t actually change until there is a frame or processing
update.
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Distance (pixels)

Sets how many pixels an object moves when the Arrow keys are used.

Extended (Shift) Distance (pixels)

Sets how many pixels an object moves when the Arrow keys are used in
conjunction with the Shift key.

Precise (Ctrl/Cmd) Distance (pixels)

Sets how many fractional pixels an object moves when the Arrow keys are
used in conjunction with the Ctrl/Cmd key.
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Brush Outline Color

Sets the color of the brush outline.

Crosshair Cursor

Controls the display of the cursor crosshair while painting.

Off
The cursor crosshair is not displayed.

On
The cursor crosshair is always displayed.

On/Off
The cursor crosshair disappears while painting a stroke, but is visible
otherwise.

Hide Brush Outline While Painting
Hides the brush outline while painting.

Pressure Threshold

Controls how hard the pen has to be pressed before opacity kicks in. The
preference is from 0-1. When the threshold has been reached, the calculated
pressure is scaled into the new range from threshold to 1.

Use Tablet Pressure

Turn tablet pressure sensitivity on or off.

Clone

Absolute Frame Numbers
When activated (the default), displays the actual frame number in the Clone >
Frame field. When turned off, it uses the old Silhouette v2.3 behavior where an
offset in relation to the current frame was shown instead of the actual frame.
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Black
When in Align mode, the Viewer appears black when the Clone source and
destination are perfectly aligned.

Gray
When in Align mode, the Viewer appears gray when the Clone source and
destination are perfectly aligned.

Allow Adjustments to Auto Grade
Allows the other grade controls to be used in conjunction with Auto Grade. With
this preference off, turning on Auto Grade will reset the other grade controls to
their defaults and disable them.

Default Filter
Sets the default filter for new paint nodes.

Default Source
Sets the clone source default.

Incremental Clone Offset
Controls whether the Clone offset starts at last offset or at click location.

Overlay Color
Sets the color of the Clone transform on-screen controls.

Show Offset
Forces the Clone Offset connecting line to always be displayed.

Source Outline Color
Sets the color of the Clone brush outline.

Source Outline Color (Secondary)
Sets the color of the secondary Clone brush outline. This is the color of the
second Clone source activated by using Dual in the Clone presets.

Use Legacy Overlay Controls
Enables the Silhouette v6 and below Clone transform on-screen controls.
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Lock Selection
If paint strokes are selected in the Paint History, they become un-selected when
you change frames. If you enable Lock Selection, the strokes stay selected
when changing frames.
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Composite Color

Sets the default color background when viewing Color Comp in the Roto node.
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Active Point Color

Sets the default color of the active point (the point that the cursor is hovering
over) through the use of a standard color picker.

Auto Switch to Reshape Tool

After closing a new shape, you will switch to the Reshape tool automatically.

Blur Type

Sets the default blur type: Center, Inner, Outer.

Bounding Box Color

Sets the default color of shape bounding boxes through the use of a standard
color picker.

Control Handle Size

Sets the size of control point handles.

Control Point Color

Sets the default color of control points through the use of a standard color
picker.

Default Interpolation

Sets the default keyframe interpolation type.

Hold
There is no interpolation and abrupt switches in value occur at keyframes.

Linear
When values change, a straight line with sharp, abrupt angles from one
keyframe to the next is drawn.

Ease In
Eases in to the selected keyframe.

Ease Out
Eases out of the selected keyframe.
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Eases in and out of a selected keyframe.

Smooth (Catmull-Rom)
Smooth (Catmull-Rom) creates a smooth curve between keyframes.

Default Outline Color

Sets the default color of the shape outline through the use of a standard color
picker.

Default Reshape Tool

Sets the default mode for the Reshape tool.

Normal
Selected points all move the same amount.

Magnetic
Points near the cursor move more than points farther away.

Enable Legacy Feathering

Enables the Silhouette v5 and below Feather tool. Once enabled, the Feather
tool appears in the user interface.

Fade Outline with Opacity

Draws unselected/inactive shape outlines using the shape opacity value. The
V key toggles this preference so that you can easily see any shapes that are at
0% opacity.

Freehand Point Selection

When enabled, point selection is done by freehand selection. Press Ctrl while
dragging for rectangular selection.
When disabled, point selection is done by rectangular selection. Press Ctrl
while dragging for freehand selection.

Hide Hulls During Edit

When activated, tangents/hulls hide when editing.
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When activated, the shape outline is hidden when editing.

Hull Color

Sets the default color of the hull (lines that connect tangents) through the use
of a standard color picker.

Interpolation Engine
Temporal

Enables all interpolation types except for Smooth (Catmull-Rom).

Spatial (Nuke-compatible)
Interpolation types are limited to Smooth (Catmull-Rom), Hold and Extrapolate.
This ensures that shapes using Smooth (Catmull-Rom) interpolation in
Silhouette exactly match the result in Nuke when exported.

Number Points
None

Control points are not numbered.

Tagged
Only control points that have been tagged using the Reshape tool > control
point pop-up menu are numbered.

All
All control points are numbered.

Primitive Type

Sets what shape type is used when circles and squares are created.

Bézier
Bézier shapes are used for circle and square creation.

B-Spline
B-Splines are used for circle and square creation.
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X-Splines are used for circle and square creation.

Recursive Subdivide

Drastically improves the curvature of shapes and reduces artifacts when using
feathering. You can return to the previous behavior of v4.0.4 and below which
used a fixed-step iterator by turning this preference off, if for some reason it
causes shape artifacts.

Rotate from Center of Selection Bounding Box

Controls whether the automatic anchor point is set to the center of the collective
bounding box or to the opposite handle.

Selected Point Color

Sets the default color of selected points through the use of a standard color
picker.

Show Feather Handles

Displays feather handles on shape points. Shift-F toggles this setting.

Show Shape Name

Displays the shape name in the center of the shape.

Show Tangent Vectors

Turns Bézier tangents on or off. Turns B-Spline and X-Spline hull drawing on or
off.

Template Color

Sets the color and opacity of unselected shapes. This Viewer Template feature
is enabled by using Shift-W.

Transform from Center of Selection Bounding Box

Controls whether the automatic anchor point is set to the center of the collective
bounding box or to the opposite handle.

X-Spline Point Type

Controls the default weighting of X-Spline points when they are created.
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X-Spline points have B-Spline weighting.

Cardinal
X-Spline points have Cardinal weighting.

Corner
X-Spline points have Corner weighting.

X-Spline Tension Factor

This is a weight from -10 to 10 that is multiplied by the mouse delta when
manipulating the X-Spline point tension. You can reverse the sense of the
weight by making this value negative. Also, you can boost the amount the
tension is adjusted based on mouse movement by making the value larger, for
example closer to -10 or 10.
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Create Point Trackers in Root

When enabled, point trackers are placed in the root of the Object list, rather
than the selected layer.

Default Path Color

Sets the default color of the tracker path.

Default Point Track Tolerance

Sets the default tracker tolerance. Describes the level of accuracy between the
Match Area that the Tracker is searching for and the area it actually finds when
searching from frame to frame.

Point Tracking Behavior

Sets the default tracker behavior. Behavior decides what frame should be used
as the reference to check the accuracy of the Match Area.

Show Path Points

Displays tracker points along the path of the track.

mocha

Drift Compensation
Enables mocha’s Drift Compensation feature where surrounding frames are
used to decrease tracker drift.

Use GPU If Available
Enables GPU acceleration if a compatible graphics card is found.

Planar Tracker

Drift Compensation
Enables Silhouette’s Drift Compensation feature where surrounding frames are
used to decrease tracker drift.
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Max Undo Events

Sets the maximum number of undos.
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Allow Nested Docks

Allows all nested docks to be moved at the same time. Disabling this
preference moves individual docks only.

Automatically Raise Dock Preference

Added a User Interface > Automatically Raise Dock Views On Selection
Change preference. For instance, when the Paint node is selected, relevant
tabs like the Paint History automatically appear.

Check for New Versions

Checks for new versions and displays an alert on startup.

Colored Timeline Tracks

Colors the timeline tracks the same as the Roto node’s shape colors.

Invert Mouse Wheel in Editors

Inverts the numerical direction when adjusting sliders with the mouse wheel.

Show Object Properties on Selection

When you select an item in the Object List, the controls for that item are
automatically shown in the Parameters window. If you select an item in the
Node List, the controls for that item are automatically shown in the Node
window. This behavior can be disabled with this preference.

Show What’s New After Installing A New Version

On startup, if this is the first time launching a new version of Silhouette, it will
open the What's New. It will only do this once.
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Alpha Overlay Color

Sets the color of the alpha overlay.

Anchor Color

Sets the color of the Transform tool anchor point.

Anti-Alias Overlay Controls

Anti-aliases lines and overlay controls.

Auto-Show Overlay

If Overlay is turned off, Auto-Show Overlay automatically turns Overlay back on
when clicking in the Viewer.

Background Color

Sets the border color in the Viewer.

Display ROI Outline

Displays the ROI outline.

Handle Mode

Controls how handles are drawn.

Blend
Uses a normal blend mode to display layer and shape handles.

XOR
Uses an XOR blend mode to display layer and shape handles.

Layer Transform Color

Sets the color of the layer’s on-screen controls.

Line Width

Sets the thickness of overlay lines.
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Color

Sets the color of the mask.

Opacity
Set the opacity of the Mask Fill Color by clicking on the percentage field (to the
right of the color picker) and typing in a new number.

Mask Outline Color
Color

Sets the color of the mask outline.

Opacity
Set the opacity of the Mask Outline Color by clicking on the percentage field (to
the right of the color picker) and typing in a new number.

Picking Tolerance

Sets the radius of the threshold for picking points.

Premultiply Background Color

Sets the background color for premultiplied display modes. You can premultiply
the image in the Viewer by using Shift-0.

Restore Focus After Editing preference

Restores focus to the viewer after editing parameters. This ensures that the
arrow keys, for instance, continue to work for nudging objects.

Synchronize Viewers

Synchronizes the zoom and pan of multiple viewers from the same node.
Synchronization is one way from the main viewer to the additional viewers.

Template Mode

Turns template mode on or off. See Template Color for more information.

Zoom Factor

Controls the I/O zoom factor keyboard shortcuts. Default is 2. Range is 1.05 >
2.0.
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Linear

Interpolates pixels when zoomed into the image. This results in a smoother, but
softer image.

Nearest
Replicates pixels when zoomed into the image. This results in a sharper, but
chunkier image.
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KEYBOARD SHORTCUTS
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Paint
Brushes
Shortcut

Action

B

Selects the Black and White brush

Shift-B

Selects the Blemish brush

Ctrl/Cmd-B

Selects the Blur brush

Alt-Shift-B

Selects the Burn brush

C

Selects the Clone brush

Shift-C

Selects the Color brush

Alt-C

Selects the Color Correct brush

Alt-Shift-C

Selects the Cutout brush

Alt-D

Selects the Detail brush

Alt-Shift-D

Selects the Dodge brush

D

Selects the Drag brush

Shift-E

Selects the Eraser brush

G

Selects the Grain brush

M

Selects the Mosaic brush

R

Selects the Repair brush

Shift-S

Selects the Scatter brush

S

Selects the Stroke tool
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Clone > Pin Warp
Shortcut

Action

Click-drag on image

Creates a pin

Click-release on image

Creates a tack

Click-drag pin (source or target)

Moves the pin (source or target)

Shift-drag pin (source or target)

Moves both pins (source and target)

Ctrl/Cmd-drag pin radius

Adjusts pin radius with all radii displayed
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Hover over pin, Shift-drag pin radius Adjusts pin radius with only selected pin radius displayed
Alt-drag on a tack

Converts a tack to a pin

Right-click > Remove Pin

Deletes the pin

Right-click > Make Tack

Converts a pin to a tack

Clone > Region
Shortcut

Action

Click and drag

Creates a region

Alt-click and drag

Creates new region when one already exists

Click and drag inside a region

Moves the region

Drag the region handles

Resizes the region

Tap outside a region box without dragging

Resets the region to full screen
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Clone > Transform Keyboard Shortcuts
Shortcut

Action

Q

Activates / Deactivates translation of the clone source

W

Activates / Deactivates rotation of the clone source

E

Activates / Deactivates scaling of the clone source

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W

Rotates without setting the anchor point

Ctrl/Cmd-E

Scales without setting the anchor point

Ctrl/Cmd-1-4

Selects the top left, top right, bottom right and bottom left
corner points so they can be moved

. (Period key)

Sets the anchor point
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Clone > Transform Nudging
Shortcut

Action

Arrow keys

Moves the clone source by 1 pixel

Shift-Arrow keys

Moves the clone source by 10 pixels

Ctrl/Cmd-Arrow keys

Moves the clone source by one tenth of a pixel

Hold down Arrow keys

Moves the clone source continuously

Q, W, E then Arrow keys

Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys

Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys

Translates, Rotates or Scales by 1/10 of a pixel

Ctrl/Cmd-1 then Arrow Keys

Nudges the top left corner point

Ctrl/Cmd-2 then Arrow Keys

Nudges the top right corner point

Ctrl/Cmd-3 then Arrow Keys

Nudges the bottom right corner point

Ctrl/Cmd-4 then Arrow Keys

Nudges the bottom left corner point
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Clone > Transform On-Screen Controls
Shortcut

Action

Drag within large center circle

Moves the clone source

Shift-drag within large center circle

Constrain clone source movement horizontally or vertically
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Drag the center square horizontal and Scales the clone source horizontally or vertically
vertical halfway points
Drag a center square corner

Proportionally scale the clone source

Drag large center circle

Rotate the clone source

Ctrl/Cmd-drag large center circle

Rotates the clone source with finer control

Drag handles on corners of image

Corner-pins the clone source

Drag dash above large circle

Skews the clone source horizontally

Drag dash to the right of large circle

Skews the clone source vertically

Clone > Transform On-Screen Controls With Region Set
Shortcut

Action

Drag within region

Moves the clone source

Shift-drag region

Constrains the clone source movement horizontally or vertically

Drag edge handle

Scales the clone source horizontally or vertically

Shift-drag corner or edge handle Proportionally scale the clone source
Ctrl/Cmd-drag on corner handle

Rotate the clone source / Continue holding Ctrl to adjust with
finer control

Drag on a corner handle

Corner-pins the clone source

Ctrl/Cmd-drag on edge handle

Skews the clone source
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Cutout Brush
Shortcut

Action

Click-drag

Creates a source region when none exists

Shift-drag or Right-click-drag

Creates a new source region

Shift

Displays source region

Shift-click or Right-click

Resets source region

Ctrl/Cmd-drag boundary

Scales the cutout

Ctrl/Cmd-Shift-drag boundary

Rotates the cutout

•
•
• 356
•
•
•

Settings
Shortcut

Action

Ctrl/Cmd-drag left/right

Sizes the brush

[ and ]

Sizes the brush

Ctrl/Cmd-Shift-drag

Sets the brush softness

Shift-Alt-1 and Shift-Alt-2

Selects the Dual Clone brush setups

Shift+Ctrl+1

Toggle Dual Clone mode on/off

‘ (located to the left of 1 key)

Displays the Clone source and then the Clone
target so that you can click on each to set the Clone
offset

Caps Lock

Toggles Onion Skin mode on and off

. (period key)

Picks colors off of the screen

Right-click

Picks a color off of the screen from a single pixel

Right-click-drag

Picks a color off of the screen by drawing a box and
averages the colors within it

Alt-click-click

Draws a straight line

Alt-S

Toggles between Paint Source > Foreground or
Output

| key (vertical bar)

Snaps the vertical or horizontal split compare
position to the cursor position
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View Menu
Shortcut

Action

1

View the Output

2

View the Foreground

3-7

View Input’s 1-5

8

View Color Layer

9

View Detail Layer

P

View Paint Only
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Tools
Shortcut

Action

T

Selects Transform Shape Mode

TT

Selects Transform Points Mode

R

Selects Reshape Normal Mode

RR

Selects Reshape Magnet Mode

Y

Selects IK (Inverse Kinematics)

B

Selects B-Spline

S

Selects X-Spline

Shift-B

Selects Bézier

Shift-F

Selects Magnetic Freehand

Shift-S

Selects Square

Shift-C

Selects Circle

Shift-T

Selects Tracker

M

Selects MultiFrame

Shift-O

Selects RotoOverlay

Alt-F

Toggles the shape feather handle on/off

Alt-K

Adds weighted keyframe
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Bézier Splines
Shortcut

Action

No key needed

Adjust the length of one tangent while
retaining a fixed angle between two
tangents

Ctrl/Cmd

Adjust both tangents simultaneously while
retaining a fixed angle between two
tangents

Alt

Adjusts only one tangent to create corners

Shift

Adjusts only the length of one tangent
(similar to the “No key needed” shortcut)

Ctrl/Cmd-Alt-1

Sets the point tension to Corner

Ctrl/Cmd-Alt-2

Sets the point tension to Cardinal
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Curve

B-Spline Shapes
Shortcut

Action

Alt-drag control point right

Creates a corner point

Alt-drag control point left

Creates a smooth point

Alt-clicking control point

Cycles through the preset weight settings of the point

Ctrl/Cmd-Alt-1

Sets the point tension to Corner

Ctrl/Cmd-Alt-3

Sets the point tension to B-Spline
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Cut / Copy / Paste
Shortcut

Action

Ctrl/Cmd-X

Cuts an object

Ctrl/Cmd-C

Copies an object

Ctrl/Cmd-V

Pastes an object
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Feather
Shortcut

Action

Alt-F

Toggles the shape feather handle on/off

Shift-Drag Shape Point

Moves shape and feather points simultaneously

IK (Inverse Kinematics) Tool
Action

Result

Click-drag bone or shape

Rotates the shape around the parent’s anchor point

Click-drag joint

Uses IK to rotate all joints up the chain

Alt-click-drag joint

Moves the joint but tries to keep other joints in place

Right-click bone-Add Key

Sets keyframes for the selected bones
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Layer Transform On-Screen Controls
Shortcut

Action

Drag within large center circle

Moves the layer

Shift-drag within large center circle

Constrain layer movement horizontally or vertically

Drag the intersection of the center square
and the horizontal and vertical lines

Scales the layer horizontally or vertically

Drag the center square corner

Proportionally scale the layer

Drag large center circle

Rotate the layer

Ctrl/Cmd-drag large center circle

Rotates the layer with finer control

Drag handles on corners of image

Corner-pins the layer

Drag small center circle

Moves the Anchor point

Q

Activates / Deactivates translation of selected layers

W

Activates / Deactivates rotation of selected layers

E

Activates / Deactivates scaling of selected layers

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments
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Magnetic Freehand Shapes
Tracing
Shortcut

Action

Click while tracing

Anchors the currently drawn path by adding a shape point

Shift-click

Draws a straight line between the new and previous shape points

Stroke Marking
Shortcut

Action

Shift-click-drag

Creates a foreground stroke

Alt-click-drag

Creates a background stroke

Esc

Clears foreground and background strokes / Deselects current shape
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Nudging
Shortcut

Action

Arrow keys

Moves by 1 pixel

Shift-Arrow keys

Moves by 10 pixels

Ctrl/Cmd-Arrow keys

Moves by one tenth of a pixel

Hold down Arrow keys

Moves continuously

Q, W, E then Ctrl/Cmd-drag

Translates, Rotates or Scales in finer increments

Q, W, E then Arrow keys

Translates, Rotates or Scales by 1 pixel

Q, W, E then Shift-Arrow keys

Translates, Rotates or Scales by 10 pixels

Q, W, E then Ctrl/Cmd-Arrow keys

Translates, Rotates or Scales by 1/10 of a pixel
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Object List
Shortcut

Action

Click on an object

Selects the object

Shift-click an object

Adds an object to the current selection

Ctrl/Cmd-click on an object

Toggles the object selection

Shift-click color pot

Selects shapes of same color

Alt-click the Visibility icon

Solos an object

Alt-Ctrl/Cmd-click the Visibility icon

Forces the visibility of all objects to the on position

Shift-click the +/- icon

Expands or collapses all nested layers inside that layer

Double-click an object

Selects the object so it can be renamed
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Selecting / Deselecting Control Points
Shortcut
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Action

Click on a control point. If the control point is part of a Bézier curve, Selects the control point
its tangents appear
Shift-click the control points or drag select multiple control points

Selects multiple control points

Ctrl/Cmd-drag in the Viewer to begin the selection. Once the
selection is started, release Ctrl/Cmd and complete the selection

Freehand select multiple
control points

Ctrl/Cmd-Alt-I

Inverts the point selection

Alt-Shift-A

Selects all control points

Alt-Ctrl/Cmd-A

Deselects all control points

Ctrl/Cmd-click on a control point

Toggles the point selection

Click anywhere off the shape

Deselects all control points

Selecting / Deselecting Shapes
Shortcut

Action

Click on a shape

Selects the shape

Shift-click a shape or drag select multiple shapes

Selects multiple shapes

Ctrl/Cmd-click on a shape

Toggles the shape selection

Click anywhere off the shape

Deselects all shapes

Shift-click color pot in the Object List

Selects shapes of same color

Tracker
Shortcut

Action

Alt-click in Viewer

Creates a new tracker
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Transform Tool
Shortcut

Action

Drag shape

Moves the shape

Shift-drag shape

Constrain shape movement horizontally or
vertically

Drag bounding box corner or edge handle

Scales a shape
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Shift-drag bounding box corner or edge handle Proportionally scale a shape
Ctrl/Cmd-drag on a bounding box corner handle Rotate a shape
Alt-drag on a bounding box corner handle

Corner-pin a shape

Alt-Shift-drag on a bounding box corner handle Constrains the corner-pin movement to one axis
Ctrl/Cmd-drag on a bounding box edge handle Shear a shape

. (period key)

Turns the Anchor Point on or off

Drag on Anchor Point

Moves the Anchor Point

Shift- (period key)

Moves the Anchor Point to the mouse location

Q

Activates / Deactivates translation of selected
shapes or layers

W

Activates / Deactivates rotation of selected
shapes or layers

E

Activates / Deactivates scaling of selected
shapes or layers

Q, W, E then Ctrl/Cmd

Translates, Rotates or Scales in finer increments

Ctrl/Cmd-W

Rotates without setting the anchor point

Ctrl/Cmd-E

Scales without setting the anchor point

.
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Transform On-Screen Controls

Corner Pin
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Shear X

Scale Y

Scale X/Y
Rotate

Shear Y

Position X/Y

Scale X

Shortcut

Action

Drag small center cross

Moves the image’s X/Y Position

Drag on the large cross’s horizontal and
vertical lines

Scales the image horizontally or vertically

Drag large center circle

Proportionally scales the image

Drag small circle at 3 o’clock position

Rotates the image

Drag crosses on corners of image

Corner-pins the image

Drag bars at 9 and 12 o’clock positions

Shears the image

Alt-click-drag

Moves the anchor point to a different area of the image
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X-Spline Shapes
Shortcut

Action

Alt-drag control point right

Adjusts the weight of the point from Cardinal to Corner to B-Spline

Alt-drag control point left

When the weight is set to B-Spline, it adjusts the weight of the point
from B-Spline to Corner to Cardinal

Alt-clicking control point

Cycles through preset weight settings of the point

Ctrl/Cmd-Alt-1

Sets the point tension to Corner

Ctrl/Cmd-Alt-2

Sets the point tension to Cardinal

Ctrl/Cmd-Alt-3

Sets the point tension to B-Spline

Alt-S

Snap selected control points to the nearest detectable edge

Drag Points-Hold Alt-S

Snap selected control points to the nearest detectable edge
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View Menu
Shortcut

Action

1

View the Output

2

View the Foreground

3

View the Background

4

View the Color Comp

5

View Composite

6

View Channels
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Timeline
Shortcut

Action

Scroll wheel

Zooms the Timeline in and out

Shift-Middle-mouse drag

Zooms the Timeline in and out

Space Bar-move mouse

Pans the Timeline

Middle-mouse drag

Pans the Timeline

Single-click keyframe

Selects one keyframe

Ctrl/Cmd-click keyframe

Toggle the keyframe selection

Shift-click keyframes

Selects a range of keyframes

Alt-click

Inserts a keyframe

Right-click keyframe

Opens Timeline pop-up menu

Click-drag keyframe

Moves the keyframe

Ctrl/Cmd-drag the ends of work range bar

Changes the start and end of the work range

Ctrl/Cmd-drag the work range bar

Slides the work range forward and back

Click top left corner of the Timeline

Centers the timeline on the current frame
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Curve Editor
Shortcut

Action

Alt-click on curve

Inserts a point on the curve

Click-drag curve point

Moves the curve point

+ or =

Zooms the Curve Editor in

-

Zooms the Curve Editor out

Space Bar-move mouse

Pans the Curve Editor

Hover cursor over curve

Displays the current curve value

Right-click curve point

Opens Curve pop-up menu
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Viewer
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General
Shortcut

Action

F1

The composite workspace is displayed

F2

The Viewer is displayed full screen

F3

The Viewer and Timeline are displayed

F4

The Viewer and Trees window are displayed

F5

The dual monitor workspace is displayed

0

Toggles the display of overlays which are lines, shapes or objects

1-7 (Number Keys)

Switches the Viewer > View menu

~

Cycles through the update modes

A

Cycles the display between the full color image, the alpha channel
superimposed over the image, and the alpha channel by itself

Shift-A

Toggles the View to Output, superimposes the alpha channel over the
image and deactivates the Overlay

Alt-R/G/B/A

Toggles the red, green, blue and alpha channels on and off

Alt-O

Toggles the Roto node’s view mode to Output and displays the alpha.
Pressing Alt-O again returns the Viewer to its previous state.

Shift-Ctrl/Cmd-R

Toggles the Viewer rotation mode on/off

Shift-R

Toggles the Viewer rotation editing mode on/off

Shift-0

Premultiplies the image in the Viewer by the alpha

Alt-]

Cycles to next node in the Node pop-up menu
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Pan/Zoom
Shortcut

Action

Middle-mouse drag

Pans the image

Space Bar-move mouse

Pans the image

+ or =

Zooms the image in

-

Zooms the image out

Shift-Middle-mouse drag

Zooms the image in and out

Scroll wheel

Zooms the image in and out

Space Bar-Shift-move mouse up/down

Zooms the image in and out

F

Fits the image in the Viewer

H or Middle-mouse double click

Centers the image in the Viewer at 100%

Ctrl/Cmd-F

Centers selected object in the Viewer

‘

Opens a context menu over pen/mouse location
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Keyboard Shortcuts

Playback Controls
Shortcut

Action

Z

Step backward 1 frame

Shift-Z

Moves to the previous keyframe

X

Step forward 1 frame

Shift-X

Moves to the next keyframe

J

Plays backward

K

Stops or starts playback

L

Plays the forward

Space Bar

Stops playback

Home

Moves to the first frame

End

Moves to the last frame

Click and drag in the shuttle area

Shuttles through the clip
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Shift-Alt-click and drag a keyframe marker Moves the keyframe in time

ROI
Shortcut

Action

Initial click-drag bounding box

Sets the ROI

Click-drag bounding box points

Scales the ROI

Click-drag bounding box

Positions the ROI

Ctrl/Cmd-Shift-drag

Draws a new ROI
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Silhouette uses the following third-party libraries and commercial licenses. Where
relevant, full license text is listed under each heading.

GLEW (OpenGL Extension Wrangler Library)
License

The OpenGL Extension Wrangler Library
Copyright (C) 2008-2016, Nigel Stewart <nigels[]users sourceforge net>
Copyright (C) 2002-2008, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2008, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

• The name of the author may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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libjpeg
This software is based in part on the work of the Independent JPEG Group.
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License

This copy of the libpng notices is provided for your convenience. In case of any
discrepancy between this copy and the notices in the file png.h that is included in the
libpng distribution, the latter shall prevail.
COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:
If you modify libpng you may insert additional notices immediately following this
sentence.
This code is released under the libpng license.
libpng versions 1.0.7, July 1, 2000 through 1.6.35, July 15, 2018 are Copyright (c)
2000-2002, 2004, 2006-2018 Glenn Randers-Pehrson, are derived from libpng-1.0.6,
and are distributed according to the same disclaimer and license as libpng-1.0.6 with
the following individuals added to the list of Contributing Authors:
Simon-Pierre Cadieux
Eric S. Raymond
Mans Rullgard
Cosmin Truta
Gilles Vollant
James Yu
Mandar Sahastrabuddhe
Google Inc.
Vadim Barkov
and with the following additions to the disclaimer:
There is no warranty against interference with your enjoyment of the library or against
infringement. There is no warranty that our efforts or the library will fulfill any of your
particular purposes or needs. This library is provided with all faults, and the entire risk
of satisfactory quality, performance, accuracy, and effort is with the user.
Some files in the "contrib" directory and some configure-generated files that are
distributed with libpng have other copyright owners and are released under other open
source licenses.
libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c)
1998-2000 Glenn Randers-Pehrson, are derived from libpng-0.96, and are distributed
according to the same disclaimer and license as libpng-0.96, with the following
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individuals added to the list of Contributing Authors:
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Tom Lane
Glenn Randers-Pehrson
Willem van Schaik
libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996-1997
Andreas Dilger, are derived from libpng-0.88, and are distributed according to the same
disclaimer and license as libpng-0.88, with the following individuals added to the list of
Contributing Authors:
John Bowler
Kevin Bracey
Sam Bushell
Magnus Holmgren
Greg Roelofs
Tom Tanner
Some files in the "scripts" directory have other copyright owners but are released under
this license.
libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 19951996 Guy Eric Schalnat, Group 42, Inc.
For the purposes of this copyright and license, "Contributing Authors" is defined as the
following set of individuals:
Andreas Dilger
Dave Martindale
Guy Eric Schalnat
Paul Schmidt
Tim Wegner
The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group
42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the
warranties of merchantability and of fitness for any purpose. The Contributing Authors
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and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary,
or consequential damages, which may result from the use of the PNG Reference
Library, even if advised of the possibility of such damage.
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Permission is hereby granted to use, copy, modify, and distribute this source code, or
portions hereof, for any purpose, without fee, subject to the following restrictions:
1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not
be misrepresented as being the original source.
3. This Copyright notice may not be removed or altered from any source or altered
source distribution.
The Contributing Authors and Group 42, Inc. specifically permit, without fee, and
encourage the use of this source code as a component to supporting the PNG file
format in commercial products. If you use this source code in a product,
acknowledgment is not required but would be appreciated.
END OF COPYRIGHT NOTICE, DISCLAIMER, and LICENSE.
TRADEMARK:
The name "libpng" has not been registered by the Copyright owner as a trademark in
any jurisdiction. However, because libpng has been distributed and maintained worldwide, continually since 1995, the Copyright owner claims "common-law trademark
protection" in any jurisdiction where common-law trademark is recognized.
OSI CERTIFICATION:
Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a
certification mark of the Open Source Initiative. OSI has not addressed the additional
disclaimers inserted at version 1.0.7.
EXPORT CONTROL:
The Copyright owner believes that the Export Control Classification Number (ECCN)
for libpng is EAR99, which means not subject to export controls or International Traffic
in Arms Regulations (ITAR) because it is open source, publicly available software, that
does not contain any encryption software. See the EAR, paragraphs 734.3(b)(3) and
734.7(b).
Glenn Randers-Pehrson
glennrp at users.sourceforge.net
July 15, 2018
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libtiff
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License

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation
for any purpose is hereby granted without fee, provided that (i) the above copyright
notices and this permission notice appear in all copies of the software and related
documentation, and (ii) the names
of
Sam Leffler and Silicon Graphics may not be used in any advertising or publicity
relating to the software without the specific, prior written permission of Sam Leffler and
Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY
KIND,OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA
OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH
THE USE OR PERFORMANCE OF THIS SOFTWARE.
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libz
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License

zlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.11, January 15th, 2017
Copyright (C) 1995-2017 Jean-loup Gailly and Mark Adler
This software is provided 'as-is', without any express or implied warranty. In no event
will the authors be held liable for any damages arising from the use of this software.
Permission is granted to anyone to use this software for any purpose, including
commercial applications, and to alter it and redistribute it freely, subject to the following
restrictions:
1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment
in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.
Jean-loup Gailly
jloup@gzip.org
Mark Adler
madler@alumni.caltech.edu
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OpenColorIO
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License

All code by Sony Pictures Imageworks except:
Pystring http://code.google.com/p/pystring/
TinyXML http://sourceforge.net/projects/tinyxml/
yaml-cpp http://code.google.com/p/yaml-cpp/
PTex (Mutex), courtesy of Brent Burley and Disney http://ptex.us/
Little CMS http://www.littlecms.com/
MD5, courtesy L. Peter Deutsch, Aladdin Enterprises.
http://sourceforge.net/projects/libmd5-rfc/files/
argparse, courtesy OpenImageIO and Larry Gritz http://openimageio.org
Copyright (c) 2003-2010 Sony Pictures Imageworks Inc., et al. All Rights Reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
Neither the name of Sony Pictures Imageworks nor the names of its contributors may
be used to endorse or promote products derived from this software without specific
prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Pystring
Copyright (c) 2008-2010, Sony Pictures Imageworks Inc All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer. Redistributions in binary form must reproduce
the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution. Neither the name
of the organization Sony Pictures Imageworks nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior
written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT
HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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TinyXML is released under the zlib license:
This software is provided ‘as-is’, without any express or implied warranty. In no event
will the authors be held liable for any damages arising from the use of this software.
Permission is granted to anyone to use this software for any purpose, including
commercial applications, and to alter it and redistribute it freely, subject to the following
restrictions:
1. The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment
in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.
yaml-cpp
Copyright (c) 2008 Jesse Beder.
Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
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WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.
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PTEX SOFTWARE Copyright 2009 Disney Enterprises, Inc. All rights reserved
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
The names “Disney”, “Walt Disney Pictures”, “Walt Disney Animation Studios” or the
names of its contributors may NOT be used to endorse or promote products derived
from this software without specific prior written permission from Walt Disney Pictures.
Disclaimer: THIS SOFTWARE IS PROVIDED BY WALT DISNEY PICTURES AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT AND TITLE ARE DISCLAIMED. IN NO EVENT SHALL WALT
DISNEY PICTURES, THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND BASED
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
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TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.
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Little CMS Copyright (c) 1998-2010 Marti Maria Saguer
Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
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WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.
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MD5
Copyright (C) 1999, 2002 Aladdin Enterprises. All rights reserved.
This software is provided ‘as-is’, without any express or implied warranty. In no event
will the authors be held liable for any damages arising from the use of this software.
Permission is granted to anyone to use this software for any purpose, including
commercial applications, and to alter it and redistribute it freely, subject to the following
restrictions:
The origin of this software must not be misrepresented; you must not claim that you
wrote the original software. If you use this software in a product, an acknowledgment
in the product documentation would be appreciated but is not required.
Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
This notice may not be removed or altered from any source distribution.
L. Peter Deutsch ghost@aladdin.com
argparse
Copyright 2008 Larry Gritz and the other authors and contributors. All Rights Reserved.
Based on BSD-licensed software Copyright 2004 NVIDIA Corp.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met: * Redistributions of source
code must retain the above copyright notice, this list of conditions and the following
disclaimer. * Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution. * Neither the name of the software’s owners nor
the names of its contributors may be used to endorse or promote products derived from
this software without specific prior written permission. THIS SOFTWARE IS
PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
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INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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OpenCV (Open Source Computer Vision Library)
License

Copyright (C) 2000-2019, Intel Corporation, all rights reserved.
Copyright (C) 2009-2011, Willow Garage Inc., all rights reserved.
Copyright (C) 2009-2016, NVIDIA Corporation, all rights reserved.
Copyright (C) 2010-2013, Advanced Micro Devices, Inc., all rights reserved.
Copyright (C) 2015-2016, OpenCV Foundation, all rights reserved.
Copyright (C) 2015-2016, Itseez Inc., all rights reserved.
Third party copyrights are property of their respective owners.

• Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

Neither the names of the copyright holders nor the names of the contributors may be
used to endorse or promote products derived from this software without specific prior
written permission.
This software is provided by the copyright holders and contributors “as is” and any
express or implied warranties, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose are disclaimed. In no event shall
copyright holders or contributors be liable for any direct, indirect, incidental, special,
exemplary, or consequential damages (including, but not limited to, procurement of
substitute goods or services; loss of use, data, or profits; or business interruption)
however caused and on any theory of liability, whether in contract, strict liability, or tort
(including negligence or otherwise) arising in any way out of the use of this software,
even if advised of the possibility of such damage.
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OpenEXR
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OpenEXR uses a modified BSD license.

License

Copyright (c) 2002-2011, Industrial Light & Magic, a division of Lucasfilm
Entertainment Company Ltd. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
Neither the name of Industrial Light & Magic nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior
written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Power Matte
Power Matte is based on unpublished research and technology by Jue Wang from the
Department of Electrical Engineering at the University of Washington.

PySide2
PySide2 uses Lesser General Public License (LGPL) version 2.1
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GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document,
but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts as the successor of
the GNU Library Public License, version 2, hence the version number 2.1.]
Preamble
The licenses for most software are designed to take away your freedom to share and
change it. By contrast, the GNU General Public Licenses are intended to guarantee
your freedom to share and change free software--to make sure the software is free for
all its users.
This license, the Lesser General Public License, applies to some specially designated
software packages--typically libraries--of the Free Software Foundation and other
authors who decide to use it. You can use it too, but we suggest you first think carefully
about whether this license or the ordinary General Public License is the better strategy
to use in any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use, not price. Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish); that you
receive source code or can get it if you want it; that you can change the software and
use pieces of it in new free programs; and that you are informed that you can do these
things.
To protect your rights, we need to make restrictions that forbid distributors to deny you
these rights or to ask you to surrender these rights. These restrictions translate to
certain responsibilities for you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis or for a fee, you must
give the recipients all the rights that we gave you. You must make sure that they, too,
receive or can get the source code. If you link other code with the library, you must
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provide complete object files to the recipients, so that they can relink them with the
library after making changes to the library and recompiling it. And you must show them
these terms so they know their rights.
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We protect your rights with a two-step method: (1) we copyright the library, and (2) we
offer you this license, which gives you legal permission to copy, distribute and/or modify
the library.
To protect each distributor, we want to make it very clear that there is no warranty for
the free library. Also, if the library is modified by someone else and passed on, the
recipients should know that what they have is not the original version, so that the
original author's reputation will not be affected by problems that might be introduced by
others.
Finally, software patents pose a constant threat to the existence of any free program.
We wish to make sure that a company cannot effectively restrict the users of a free
program by obtaining a restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be consistent with the full
freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the ordinary GNU General
Public License. This license, the GNU Lesser General Public License, applies to
certain designated libraries, and is quite different from the ordinary General Public
License. We use this license for certain libraries in order to permit linking those libraries
into non-free programs.
When a program is linked with a library, whether statically or using a shared library, the
combination of the two is legally speaking a combined work, a derivative of the original
library. The ordinary General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General Public License
permits more lax criteria for linking other code with the library.
We call this license the "Lesser" General Public License because it does Less to
protect the user's freedom than the ordinary General Public License. It also provides
other free software developers Less of an advantage over competing non-free
programs. These disadvantages are the reason we use the ordinary General Public
License for many libraries. However, the Lesser license provides advantages in certain
special circumstances.
For example, on rare occasions, there may be a special need to encourage the widest
possible use of a certain library, so that it becomes a de-facto standard. To achieve this,
non-free programs must be allowed to use the library. A more frequent case is that a
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free library does the same job as widely used non-free libraries. In this case, there is
little to gain by limiting the free library to free software only, so we use the Lesser
General Public License.
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In other cases, permission to use a particular library in non-free programs enables a
greater number of people to use a large body of free software. For example, permission
to use the GNU C Library in non-free programs enables many more people to use the
whole GNU operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users' freedom, it
does ensure that the user of a program that is linked with the Library has the freedom
and the wherewithal to run that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and modification follow. Pay
close attention to the difference between a "work based on the library" and a "work that
uses the library". The former contains code derived from the library, whereas the latter
must be combined with the library in order to run.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License Agreement applies to any software library or other program which
contains a notice placed by the copyright holder or other authorized party saying it may
be distributed under the terms of this Lesser General Public License (also called "this
License"). Each licensee is addressed as "you".
A "library" means a collection of software functions and/or data prepared so as to be
conveniently linked with application programs (which use some of those functions and
data) to form executables.
The "Library", below, refers to any such software library or work which has been
distributed under these terms. A "work based on the Library" means either the Library
or any derivative work under copyright law: that is to say, a work containing the Library
or a portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is included without
limitation in the term "modification".)
"Source code" for a work means the preferred form of the work for making modifications
to it. For a library, complete source code means all the source code for all modules it
contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the library.
Activities other than copying, distribution and modification are not covered by this
License; they are outside its scope. The act of running a program using the Library is
not restricted, and output from such a program is covered only if its contents constitute
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a work based on the Library (independent of the use of the Library in a tool for writing
it). Whether that is true depends on what the Library does and what the program that
uses the Library does.
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1. You may copy and distribute verbatim copies of the Library's complete source code
as you receive it, in any medium, provided that you conspicuously and appropriately
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep
intact all the notices that refer to this License and to the absence of any warranty; and
distribute a copy of this License along with the Library.
You may charge a fee for the physical act of transferring a copy, and you may at your
option offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Library or any portion of it, thus forming
a work based on the Library, and copy and distribute such modifications or work under
the terms of Section 1 above, provided that you also meet all of these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices stating that you
changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no charge to all third parties
under the terms of this License.
d) If a facility in the modified Library refers to a function or a table of data to be supplied
by an application program that uses the facility, other than as an argument passed
when the facility is invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the facility still operates,
and performs whatever part of its purpose remains meaningful.
(For example, a function in a library to compute square roots has a purpose that is
entirely well-defined independent of the application. Therefore, Subsection 2d requires
that any application-supplied function or table used by this function must be optional: if
the application does not supply it, the square root function must still compute square
roots.)
These requirements apply to the modified work as a whole. If identifiable sections of
that work are not derived from the Library, and can be reasonably considered
independent and separate works in themselves, then this License, and its terms, do not
apply to those sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based on the Library,
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the distribution of the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or contest your rights to work
written entirely by you; rather, the intent is to exercise the right to control the distribution
of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library
(or with a work based on the Library) on a volume of a storage or distribution medium
does not bring the other work under the scope of this License.
3. You may opt to apply the terms of the ordinary GNU General Public License instead
of this License to a given copy of the Library. To do this, you must alter all the notices
that refer to this License, so that they refer to the ordinary GNU General Public License,
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version 2, instead of to this License. (If a newer version than version 2 of the ordinary
GNU General Public License has appeared, then you can specify that version instead
if you wish.) Do not make any other change in these notices.
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Once this change is made in a given copy, it is irreversible for that copy, so the ordinary
GNU General Public License applies to all subsequent copies and derivative works
made from that copy.
This option is useful when you wish to copy part of the code of the Library into a
program that is not a library.
4. You may copy and distribute the Library (or a portion or derivative of it, under Section
2) in object code or executable form under the terms of Sections 1 and 2 above
provided that you accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections 1 and 2 above on
a medium customarily used for software interchange.
If distribution of object code is made by offering access to copy from a designated
place, then offering equivalent access to copy the source code from the same place
satisfies the requirement to distribute the source code, even though third parties are
not compelled to copy the source along with the object code.
5. A program that contains no derivative of any portion of the Library, but is designed
to work with the Library by being compiled or linked with it, is called a "work that uses
the Library". Such a work, in isolation, is not a derivative work of the Library, and
therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of the Library), rather
than a "work that uses the library". The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.
When a "work that uses the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the Library even
though the source code is not. Whether this is true is especially significant if the work
can be linked without the Library, or if the work is itself a library. The threshold for this
to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and
accessors, and small macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall
under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object code
for the work under the terms of Section 6. Any executables containing that work also
fall under Section 6, whether or not they are linked directly with the Library itself.
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6. As an exception to the Sections above, you may also combine or link a "work that
uses the Library" with the Library to produce a work containing portions of the Library,
and distribute that work under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse engineering for
debugging such modifications.
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You must give prominent notice with each copy of the work that the Library is used in it
and that the Library and its use are covered by this License. You must supply a copy of
this License. If the work during execution displays copyright notices, you must include
the copyright notice for the Library among them, as well as a reference directing the
user to the copy of this License. Also, you must do one of these things:
a) Accompany the work with the complete corresponding machine-readable source
code for the Library including whatever changes were used in the work (which must be
distributed under Sections 1 and 2 above); and, if the work is an executable linked with
the Library, with the complete machine-readable "work that uses the Library", as object
code and/or source code, so that the user can modify the Library and then relink to
produce a modified executable containing the modified Library. (It is understood that
the user who changes the contents of definitions files in the Library will not necessarily
be able to recompile the application to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (1) uses at run time a copy of the library already present on the
user's computer system, rather than copying library functions into the executable, and
(2) will operate properly with a modified version of the library, if the user installs one, as
long as the modified version is interface-compatible with the version that the work was
made with.
c) Accompany the work with a written offer, valid for at least three years, to give the
same user the materials specified in Subsection 6a, above, for a charge no more than
the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy from a designated place,
offer equivalent access to copy the above specified materials from the same place.
e) Verify that the user has already received a copy of these materials or that you have
already sent this user a copy.
For an executable, the required form of the "work that uses the Library" must include
any data and utility programs needed for reproducing the executable from it. However,
as a special exception, the materials to be distributed need not include anything that is
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normally distributed (in either source or binary form) with the major components
(compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.
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It may happen that this requirement contradicts the license restrictions of other
proprietary libraries that do not normally accompany the operating system. Such a
contradiction means you cannot use both them and the Library together in an
executable that you distribute.
7. You may place library facilities that are a work based on the Library side-by-side in
a single library together with other library facilities not covered by this License, and
distribute such a combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise permitted, and
provided that you do these two things:
a) Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities. This must be distributed under the terms of
the Sections above.
b) Give prominent notice with the combined library of the fact that part of it is a work
based on the Library, and explaining where to find the accompanying uncombined form
of the same work.
8. You may not copy, modify, sublicense, link with, or distribute the Library except as
expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense, link with, or distribute the Library is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such
parties remain in full compliance.
9. You are not required to accept this License, since you have not signed it. However,
nothing else grants you permission to modify or distribute the Library or its derivative
works. These actions are prohibited by law if you do not accept this License. Therefore,
by modifying or distributing the Library (or any work based on the Library), you indicate
your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Library or works based on it.
10. Each time you redistribute the Library (or any work based on the Library), the
recipient automatically receives a license from the original licensor to copy, distribute,
link with or modify the Library subject to these terms and conditions. You may not
impose any further restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for
any other reason (not limited to patent issues), conditions are imposed on you (whether
by court order, agreement or otherwise) that contradict the conditions of this License,
they do not excuse you from the conditions of this License. If you cannot distribute so
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as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Library at all. For
example, if a patent license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from distribution of the
Library.
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If any portion of this section is held invalid or unenforceable under any particular
circumstance, the balance of the section is intended to apply, and the section as a
whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other
property right claims or to contest validity of any such claims; this section has the sole
purpose of protecting the integrity of the free software distribution system which is
implemented by public license practices. Many people have made generous
contributions to the wide range of software distributed through that system in reliance
on consistent application of that system; it is up to the author/donor to decide if he or
she is willing to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence
of the rest of this License.
12. If the distribution and/or use of the Library is restricted in certain countries either by
patents or by copyrighted interfaces, the original copyright holder who places the
Library under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the limitation as if written in
the body of this License.
13. The Free Software Foundation may publish revised and/or new versions of the
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or
concerns.
Each version is given a distinguishing version number. If the Library specifies a version
number of this License which applies to it and "any later version", you have the option
of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Library does not specify a license
version number, you may choose any version ever published by the Free Software
Foundation.
14. If you wish to incorporate parts of the Library into other free programs whose
distribution conditions are incompatible with these, write to the author to ask for
permission. For software which is copyrighted by the Free Software Foundation, write
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to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free
software and of promoting the sharing and reuse of software generally.
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NO WARRANTY
15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.
16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
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YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Libraries
If you develop a new library, and you want it to be of the greatest possible use to the
public, we recommend making it free software that everyone can redistribute and
change. You can do so by permitting redistribution under these terms (or, alternatively,
under the terms of the ordinary General Public License).
To apply these terms, attach the following notices to the library. It is safest to attach
them to the start of each source file to most effectively convey the exclusion of
warranty; and each file should have at least the "copyright" line and a pointer to where
the full notice is found.
one line to give the library's name and an idea of what it does.
Copyright (C) year name of author
This library is free software; you can redistribute it and/or modify it under the terms of
the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details.
You should have received a copy of the GNU Lesser General Public License along with
this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth
Floor, Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
You should also get your employer (if you work as a programmer) or your school, if any,
to sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the
names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for
tweaking knobs) written by James Random Hacker.
signature of Ty Coon, 1 April 1990
Ty Coon, President of Vice
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The Python Software Foundation License (PSFL) is a BSD-style, permissive
free software license which is compatible with the GNU General Public License
(GPL).

License

1. This LICENSE AGREEMENT is between the Python Software Foundation ("PSF"),
and the Individual or Organization ("Licensee") accessing and otherwise using Python
3.7.4 software in source or binary form and its associated documentation.
2. Subject to the terms and conditions of this License Agreement, PSF hereby grants
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test,
perform and/or display publicly, prepare derivative works, distribute, and otherwise use
Python 3.7.4 alone or in any derivative version, provided, however, that PSF's License
Agreement and PSF's notice of copyright, i.e., "Copyright © 2001-2019 Python
Software Foundation; All Rights Reserved" are retained in Python 3.7.4 alone or in any
derivative version prepared by Licensee.
3. In the event Licensee prepares a derivative work that is based on or incorporates
Python 3.7.4 or any part thereof, and wants to make the derivative work available to
others as provided herein, then Licensee hereby agrees to include in any such work a
brief summary of the changes made to Python 3.7.4.
4. PSF is making Python 3.7.4 available to Licensee on an "AS IS" basis. PSF MAKES
NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED BY WAY OF
EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DISCLAIMS ANY
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REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON 3.7.4 WILL NOT
INFRINGE ANY THIRD PARTY RIGHTS.

•
•
• 398
•
•
•

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF
PYTHON 3.7.4 FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL
DAMAGES OR LOSS AS A RESULT OF MODIFYING, DISTRIBUTING, OR
OTHERWISE USING PYTHON 3.7.4, OR ANY DERIVATIVE THEREOF, EVEN IF
ADVISED OF THE POSSIBILITY THEREOF.
6. This License Agreement will automatically terminate upon a material breach of its
terms and conditions.
7. Nothing in this License Agreement shall be deemed to create any relationship of
agency, partnership, or joint venture between PSF and Licensee. This License
Agreement does not grant permission to use PSF trademarks or trade name in a
trademark sense to endorse or promote products or services of Licensee, or any third
party.
8. By copying, installing or otherwise using Python 3.7.4, Licensee agrees to be bound
by the terms and conditions of this License Agreement.

Qt
Qt is available under the GNU Lesser General Public License version 3.
The Qt Toolkit is Copyright (C) 2018 The Qt Company Ltd. and other contributors.
Contact: https://www.qt.io/licensing/
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GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. http://fsf.org/
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
This version of the GNU Lesser General Public License incorporates the terms and
conditions of version 3 of the GNU General Public License, supplemented by the
additional permissions listed below.
0. Additional Definitions.
As used herein, "this License" refers to version 3 of the GNU Lesser General Public
License, and the "GNU GPL" refers to version 3 of the GNU General Public License.
"The Library" refers to a covered work governed by this License, other than an
Application or a Combined Work as defined below.
An "Application" is any work that makes use of an interface provided by the Library, but
which is not otherwise based on the Library. Defining a subclass of a class defined by
the Library is deemed a mode of using an interface provided by the Library.
A "Combined Work" is a work produced by combining or linking an Application with the
Library. The particular version of the Library with which the Combined Work was made
is also called the "Linked Version".
The "Minimal Corresponding Source" for a Combined Work means the Corresponding
Source for the Combined Work, excluding any source code for portions of the
Combined Work that, considered in isolation, are based on the Application, and not on
the Linked Version.
The "Corresponding Application Code" for a Combined Work means the object code
and/or source code for the Application, including any data and utility programs needed
for reproducing the Combined Work from the Application, but excluding the System
Libraries of the Combined Work.
1. Exception to Section 3 of the GNU GPL.
You may convey a covered work under sections 3 and 4 of this License without being
bound by section 3 of the GNU GPL.
2. Conveying Modified Versions.
If you modify a copy of the Library, and, in your modifications, a facility refers to a
function or data to be supplied by an Application that uses the facility (other than as an
argument passed when the facility is invoked), then you may convey a copy of the
Silhouette User Guide

•
•
•
•
•
•

Licenses Used by Silhouette

modified version:

•
•
• 400
•
•
•

a) under this License, provided that you make a good faith effort to ensure that, in the
event an Application does not supply the function or data, the facility still operates, and
performs whatever part of its purpose remains meaningful, or
b) under the GNU GPL, with none of the additional permissions of this License
applicable to that copy.
3. Object Code Incorporating Material from Library Header Files.
The object code form of an Application may incorporate material from a header file that
is part of the Library. You may convey such object code under terms of your choice,
provided that, if the incorporated material is not limited to numerical parameters, data
structure layouts and accessors, or small macros, inline functions and templates (ten
or fewer lines in length), you do both of the following:
a) Give prominent notice with each copy of the object code that the Library is used in it
and that the Library and its use are covered by this License.
b) Accompany the object code with a copy of the GNU GPL and this license document.
4. Combined Works.
You may convey a Combined Work under terms of your choice that, taken together,
effectively do not restrict modification of the portions of the Library contained in the
Combined Work and reverse engineering for debugging such modifications, if you also
do each of the following:
a) Give prominent notice with each copy of the Combined Work that the Library is used
in it and that the Library and its use are covered by this License.
b) Accompany the Combined Work with a copy of the GNU GPL and this license
document.
c) For a Combined Work that displays copyright notices during execution, include the
copyright notice for the Library among these notices, as well as a reference directing
the user to the copies of the GNU GPL and this license document.
d) Do one of the following:
0) Convey the Minimal Corresponding Source under the terms of this License, and the
Corresponding Application Code in a form suitable for, and under terms that permit, the
user to recombine or relink the Application with a modified version of the Linked Version
to produce a modified Combined Work, in the manner specified by section 6 of the GNU
GPL for conveying Corresponding Source.
1) Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (a) uses at run time a copy of the Library already present on the
user's computer system, and (b) will operate properly with a modified version of the
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Library that is interface-compatible with the Linked Version.
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e) Provide Installation Information, but only if you would otherwise be required to
provide such information under section 6 of the GNU GPL, and only to the extent that
such information is necessary to install and execute a modified version of the
Combined Work produced by recombining or relinking the Application with a modified
version of the Linked Version. (If you use option 4d0, the Installation Information must
accompany the Minimal Corresponding Source and Corresponding Application Code.
If you use option 4d1, you must provide the Installation Information in the manner
specified by section 6 of the GNU GPL for conveying Corresponding Source.)
5. Combined Libraries.
You may place library facilities that are a work based on the Library side by side in a
single library together with other library facilities that are not Applications and are not
covered by this License, and convey such a combined library under terms of your
choice, if you do both of the following:
a) Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities, conveyed under the terms of this License.
b) Give prominent notice with the combined library that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same
work.
6. Revised Versions of the GNU Lesser General Public License.
The Free Software Foundation may publish revised and/or new versions of the GNU
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or
concerns.
Each version is given a distinguishing version number. If the Library as you received it
specifies that a certain numbered version of the GNU Lesser General Public License
"or any later version" applies to it, you have the option of following the terms and
conditions either of that published version or of any later version published by the Free
Software Foundation. If the Library as you received it does not specify a version
number of the GNU Lesser General Public License, you may choose any version of the
GNU Lesser General Public License ever published by the Free Software Foundation.
If the Library as you received it specifies that a proxy can decide whether future
versions of the GNU Lesser General Public License shall apply, that proxy's public
statement of acceptance of any version is permanent authorization for you to choose
that version for the Library.
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Shiboken uses Lesser General Public License (LGPL) version 2.1.

License

GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document,
but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts as the successor of
the GNU Library Public License, version 2, hence the version number 2.1.]
Preamble
The licenses for most software are designed to take away your freedom to share and
change it. By contrast, the GNU General Public Licenses are intended to guarantee
your freedom to share and change free software--to make sure the software is free for
all its users.
This license, the Lesser General Public License, applies to some specially designated
software packages--typically libraries--of the Free Software Foundation and other
authors who decide to use it. You can use it too, but we suggest you first think carefully
about whether this license or the ordinary General Public License is the better strategy
to use in any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use, not price. Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish); that you
receive source code or can get it if you want it; that you can change the software and
use pieces of it in new free programs; and that you are informed that you can do these
things.
To protect your rights, we need to make restrictions that forbid distributors to deny you
these rights or to ask you to surrender these rights. These restrictions translate to
certain responsibilities for you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis or for a fee, you must
give the recipients all the rights that we gave you. You must make sure that they, too,
receive or can get the source code. If you link other code with the library, you must
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provide complete object files to the recipients, so that they can relink them with the
library after making changes to the library and recompiling it. And you must show them
these terms so they know their rights.
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We protect your rights with a two-step method: (1) we copyright the library, and (2) we
offer you this license, which gives you legal permission to copy, distribute and/or modify
the library.
To protect each distributor, we want to make it very clear that there is no warranty for
the free library. Also, if the library is modified by someone else and passed on, the
recipients should know that what they have is not the original version, so that the
original author's reputation will not be affected by problems that might be introduced by
others.
Finally, software patents pose a constant threat to the existence of any free program.
We wish to make sure that a company cannot effectively restrict the users of a free
program by obtaining a restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be consistent with the full
freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the ordinary GNU General
Public License. This license, the GNU Lesser General Public License, applies to
certain designated libraries, and is quite different from the ordinary General Public
License. We use this license for certain libraries in order to permit linking those libraries
into non-free programs.
When a program is linked with a library, whether statically or using a shared library, the
combination of the two is legally speaking a combined work, a derivative of the original
library. The ordinary General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General Public License
permits more lax criteria for linking other code with the library.
We call this license the "Lesser" General Public License because it does Less to
protect the user's freedom than the ordinary General Public License. It also provides
other free software developers Less of an advantage over competing non-free
programs. These disadvantages are the reason we use the ordinary General Public
License for many libraries. However, the Lesser license provides advantages in certain
special circumstances.
For example, on rare occasions, there may be a special need to encourage the widest
possible use of a certain library, so that it becomes a de-facto standard. To achieve this,
non-free programs must be allowed to use the library. A more frequent case is that a
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free library does the same job as widely used non-free libraries. In this case, there is
little to gain by limiting the free library to free software only, so we use the Lesser
General Public License.
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In other cases, permission to use a particular library in non-free programs enables a
greater number of people to use a large body of free software. For example, permission
to use the GNU C Library in non-free programs enables many more people to use the
whole GNU operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users' freedom, it
does ensure that the user of a program that is linked with the Library has the freedom
and the wherewithal to run that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and modification follow. Pay
close attention to the difference between a "work based on the library" and a "work that
uses the library". The former contains code derived from the library, whereas the latter
must be combined with the library in order to run.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License Agreement applies to any software library or other program which
contains a notice placed by the copyright holder or other authorized party saying it may
be distributed under the terms of this Lesser General Public License (also called "this
License"). Each licensee is addressed as "you".
A "library" means a collection of software functions and/or data prepared so as to be
conveniently linked with application programs (which use some of those functions and
data) to form executables.
The "Library", below, refers to any such software library or work which has been
distributed under these terms. A "work based on the Library" means either the Library
or any derivative work under copyright law: that is to say, a work containing the Library
or a portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is included without
limitation in the term "modification".)
"Source code" for a work means the preferred form of the work for making modifications
to it. For a library, complete source code means all the source code for all modules it
contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the library.
Activities other than copying, distribution and modification are not covered by this
License; they are outside its scope. The act of running a program using the Library is
not restricted, and output from such a program is covered only if its contents constitute
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a work based on the Library (independent of the use of the Library in a tool for writing
it). Whether that is true depends on what the Library does and what the program that
uses the Library does.
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1. You may copy and distribute verbatim copies of the Library's complete source code
as you receive it, in any medium, provided that you conspicuously and appropriately
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep
intact all the notices that refer to this License and to the absence of any warranty; and
distribute a copy of this License along with the Library.
You may charge a fee for the physical act of transferring a copy, and you may at your
option offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Library or any portion of it, thus forming
a work based on the Library, and copy and distribute such modifications or work under
the terms of Section 1 above, provided that you also meet all of these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices stating that you
changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no charge to all third parties
under the terms of this License.
d) If a facility in the modified Library refers to a function or a table of data to be supplied
by an application program that uses the facility, other than as an argument passed
when the facility is invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the facility still operates,
and performs whatever part of its purpose remains meaningful.
(For example, a function in a library to compute square roots has a purpose that is
entirely well-defined independent of the application. Therefore, Subsection 2d requires
that any application-supplied function or table used by this function must be optional: if
the application does not supply it, the square root function must still compute square
roots.)
These requirements apply to the modified work as a whole. If identifiable sections of
that work are not derived from the Library, and can be reasonably considered
independent and separate works in themselves, then this License, and its terms, do not
apply to those sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based on the Library,
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the distribution of the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or contest your rights to work
written entirely by you; rather, the intent is to exercise the right to control the distribution
of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library
(or with a work based on the Library) on a volume of a storage or distribution medium
does not bring the other work under the scope of this License.
3. You may opt to apply the terms of the ordinary GNU General Public License instead
of this License to a given copy of the Library. To do this, you must alter all the notices
that refer to this License, so that they refer to the ordinary GNU General Public License,
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version 2, instead of to this License. (If a newer version than version 2 of the ordinary
GNU General Public License has appeared, then you can specify that version instead
if you wish.) Do not make any other change in these notices.
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Once this change is made in a given copy, it is irreversible for that copy, so the ordinary
GNU General Public License applies to all subsequent copies and derivative works
made from that copy.
This option is useful when you wish to copy part of the code of the Library into a
program that is not a library.
4. You may copy and distribute the Library (or a portion or derivative of it, under Section
2) in object code or executable form under the terms of Sections 1 and 2 above
provided that you accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections 1 and 2 above on
a medium customarily used for software interchange.
If distribution of object code is made by offering access to copy from a designated
place, then offering equivalent access to copy the source code from the same place
satisfies the requirement to distribute the source code, even though third parties are
not compelled to copy the source along with the object code.
5. A program that contains no derivative of any portion of the Library, but is designed
to work with the Library by being compiled or linked with it, is called a "work that uses
the Library". Such a work, in isolation, is not a derivative work of the Library, and
therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of the Library), rather
than a "work that uses the library". The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.
When a "work that uses the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the Library even
though the source code is not. Whether this is true is especially significant if the work
can be linked without the Library, or if the work is itself a library. The threshold for this
to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and
accessors, and small macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall
under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object code
for the work under the terms of Section 6. Any executables containing that work also
fall under Section 6, whether or not they are linked directly with the Library itself.
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6. As an exception to the Sections above, you may also combine or link a "work that
uses the Library" with the Library to produce a work containing portions of the Library,
and distribute that work under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse engineering for
debugging such modifications.
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You must give prominent notice with each copy of the work that the Library is used in it
and that the Library and its use are covered by this License. You must supply a copy of
this License. If the work during execution displays copyright notices, you must include
the copyright notice for the Library among them, as well as a reference directing the
user to the copy of this License. Also, you must do one of these things:
a) Accompany the work with the complete corresponding machine-readable source
code for the Library including whatever changes were used in the work (which must be
distributed under Sections 1 and 2 above); and, if the work is an executable linked with
the Library, with the complete machine-readable "work that uses the Library", as object
code and/or source code, so that the user can modify the Library and then relink to
produce a modified executable containing the modified Library. (It is understood that
the user who changes the contents of definitions files in the Library will not necessarily
be able to recompile the application to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (1) uses at run time a copy of the library already present on the
user's computer system, rather than copying library functions into the executable, and
(2) will operate properly with a modified version of the library, if the user installs one, as
long as the modified version is interface-compatible with the version that the work was
made with.
c) Accompany the work with a written offer, valid for at least three years, to give the
same user the materials specified in Subsection 6a, above, for a charge no more than
the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy from a designated place,
offer equivalent access to copy the above specified materials from the same place.
e) Verify that the user has already received a copy of these materials or that you have
already sent this user a copy.
For an executable, the required form of the "work that uses the Library" must include
any data and utility programs needed for reproducing the executable from it. However,
as a special exception, the materials to be distributed need not include anything that is
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normally distributed (in either source or binary form) with the major components
(compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.
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It may happen that this requirement contradicts the license restrictions of other
proprietary libraries that do not normally accompany the operating system. Such a
contradiction means you cannot use both them and the Library together in an
executable that you distribute.
7. You may place library facilities that are a work based on the Library side-by-side in
a single library together with other library facilities not covered by this License, and
distribute such a combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise permitted, and
provided that you do these two things:
a) Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities. This must be distributed under the terms of
the Sections above.
b) Give prominent notice with the combined library of the fact that part of it is a work
based on the Library, and explaining where to find the accompanying uncombined form
of the same work.
8. You may not copy, modify, sublicense, link with, or distribute the Library except as
expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense, link with, or distribute the Library is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such
parties remain in full compliance.
9. You are not required to accept this License, since you have not signed it. However,
nothing else grants you permission to modify or distribute the Library or its derivative
works. These actions are prohibited by law if you do not accept this License. Therefore,
by modifying or distributing the Library (or any work based on the Library), you indicate
your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Library or works based on it.
10. Each time you redistribute the Library (or any work based on the Library), the
recipient automatically receives a license from the original licensor to copy, distribute,
link with or modify the Library subject to these terms and conditions. You may not
impose any further restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for
any other reason (not limited to patent issues), conditions are imposed on you (whether
by court order, agreement or otherwise) that contradict the conditions of this License,
they do not excuse you from the conditions of this License. If you cannot distribute so
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as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Library at all. For
example, if a patent license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from distribution of the
Library.
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If any portion of this section is held invalid or unenforceable under any particular
circumstance, the balance of the section is intended to apply, and the section as a
whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other
property right claims or to contest validity of any such claims; this section has the sole
purpose of protecting the integrity of the free software distribution system which is
implemented by public license practices. Many people have made generous
contributions to the wide range of software distributed through that system in reliance
on consistent application of that system; it is up to the author/donor to decide if he or
she is willing to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence
of the rest of this License.
12. If the distribution and/or use of the Library is restricted in certain countries either by
patents or by copyrighted interfaces, the original copyright holder who places the
Library under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the limitation as if written in
the body of this License.
13. The Free Software Foundation may publish revised and/or new versions of the
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or
concerns.
Each version is given a distinguishing version number. If the Library specifies a version
number of this License which applies to it and "any later version", you have the option
of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Library does not specify a license
version number, you may choose any version ever published by the Free Software
Foundation.
14. If you wish to incorporate parts of the Library into other free programs whose
distribution conditions are incompatible with these, write to the author to ask for
permission. For software which is copyrighted by the Free Software Foundation, write
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to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free
software and of promoting the sharing and reuse of software generally.
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NO WARRANTY
15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.
16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
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YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Libraries
If you develop a new library, and you want it to be of the greatest possible use to the
public, we recommend making it free software that everyone can redistribute and
change. You can do so by permitting redistribution under these terms (or, alternatively,
under the terms of the ordinary General Public License).
To apply these terms, attach the following notices to the library. It is safest to attach
them to the start of each source file to most effectively convey the exclusion of
warranty; and each file should have at least the "copyright" line and a pointer to where
the full notice is found.
one line to give the library's name and an idea of what it does.
Copyright (C) year name of author
This library is free software; you can redistribute it and/or modify it under the terms of
the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details.
You should have received a copy of the GNU Lesser General Public License along with
this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth
Floor, Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
You should also get your employer (if you work as a programmer) or your school, if any,
to sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the
names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for
tweaking knobs) written by James Random Hacker.
signature of Ty Coon, 1 April 1990
Ty Coon, President of Vice
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xmlio
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The xmlio library uses Lesser General Public License (LGPL) version 2 or
newer.

License

GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document,
but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts as the successor of
the GNU Library Public License, version 2, hence the version number 2.1.]
Preamble
The licenses for most software are designed to take away your freedom to share and
change it. By contrast, the GNU General Public Licenses are intended to guarantee
your freedom to share and change free software--to make sure the software is free for
all its users.
This license, the Lesser General Public License, applies to some specially designated
software packages--typically libraries--of the Free Software Foundation and other
authors who decide to use it. You can use it too, but we suggest you first think carefully
about whether this license or the ordinary General Public License is the better strategy
to use in any particular case, based on the explanations below.
When we speak of free software, we are referring to freedom of use, not price. Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish); that you
receive source code or can get it if you want it; that you can change the software and
use pieces of it in new free programs; and that you are informed that you can do these
things.
To protect your rights, we need to make restrictions that forbid distributors to deny you
these rights or to ask you to surrender these rights. These restrictions translate to
certain responsibilities for you if you distribute copies of the library or if you modify it.
For example, if you distribute copies of the library, whether gratis or for a fee, you must
give the recipients all the rights that we gave you. You must make sure that they, too,
receive or can get the source code. If you link other code with the library, you must
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provide complete object files to the recipients, so that they can relink them with the
library after making changes to the library and recompiling it. And you must show them
these terms so they know their rights.
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We protect your rights with a two-step method: (1) we copyright the library, and (2) we
offer you this license, which gives you legal permission to copy, distribute and/or modify
the library.
To protect each distributor, we want to make it very clear that there is no warranty for
the free library. Also, if the library is modified by someone else and passed on, the
recipients should know that what they have is not the original version, so that the
original author's reputation will not be affected by problems that might be introduced by
others.
Finally, software patents pose a constant threat to the existence of any free program.
We wish to make sure that a company cannot effectively restrict the users of a free
program by obtaining a restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be consistent with the full
freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the ordinary GNU General
Public License. This license, the GNU Lesser General Public License, applies to
certain designated libraries, and is quite different from the ordinary General Public
License. We use this license for certain libraries in order to permit linking those libraries
into non-free programs.
When a program is linked with a library, whether statically or using a shared library, the
combination of the two is legally speaking a combined work, a derivative of the original
library. The ordinary General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General Public License
permits more lax criteria for linking other code with the library.
We call this license the "Lesser" General Public License because it does Less to
protect the user's freedom than the ordinary General Public License. It also provides
other free software developers Less of an advantage over competing non-free
programs. These disadvantages are the reason we use the ordinary General Public
License for many libraries. However, the Lesser license provides advantages in certain
special circumstances.
For example, on rare occasions, there may be a special need to encourage the widest
possible use of a certain library, so that it becomes a de-facto standard. To achieve this,
non-free programs must be allowed to use the library. A more frequent case is that a
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free library does the same job as widely used non-free libraries. In this case, there is
little to gain by limiting the free library to free software only, so we use the Lesser
General Public License.
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In other cases, permission to use a particular library in non-free programs enables a
greater number of people to use a large body of free software. For example, permission
to use the GNU C Library in non-free programs enables many more people to use the
whole GNU operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users' freedom, it
does ensure that the user of a program that is linked with the Library has the freedom
and the wherewithal to run that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and modification follow. Pay
close attention to the difference between a "work based on the library" and a "work that
uses the library". The former contains code derived from the library, whereas the latter
must be combined with the library in order to run.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License Agreement applies to any software library or other program which
contains a notice placed by the copyright holder or other authorized party saying it may
be distributed under the terms of this Lesser General Public License (also called "this
License"). Each licensee is addressed as "you".
A "library" means a collection of software functions and/or data prepared so as to be
conveniently linked with application programs (which use some of those functions and
data) to form executables.
The "Library", below, refers to any such software library or work which has been
distributed under these terms. A "work based on the Library" means either the Library
or any derivative work under copyright law: that is to say, a work containing the Library
or a portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is included without
limitation in the term "modification".)
"Source code" for a work means the preferred form of the work for making modifications
to it. For a library, complete source code means all the source code for all modules it
contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the library.
Activities other than copying, distribution and modification are not covered by this
License; they are outside its scope. The act of running a program using the Library is
not restricted, and output from such a program is covered only if its contents constitute
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a work based on the Library (independent of the use of the Library in a tool for writing
it). Whether that is true depends on what the Library does and what the program that
uses the Library does.
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1. You may copy and distribute verbatim copies of the Library's complete source code
as you receive it, in any medium, provided that you conspicuously and appropriately
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep
intact all the notices that refer to this License and to the absence of any warranty; and
distribute a copy of this License along with the Library.
You may charge a fee for the physical act of transferring a copy, and you may at your
option offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Library or any portion of it, thus forming
a work based on the Library, and copy and distribute such modifications or work under
the terms of Section 1 above, provided that you also meet all of these conditions:
a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices stating that you
changed the files and the date of any change.
c) You must cause the whole of the work to be licensed at no charge to all third parties
under the terms of this License.
d) If a facility in the modified Library refers to a function or a table of data to be supplied
by an application program that uses the facility, other than as an argument passed
when the facility is invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the facility still operates,
and performs whatever part of its purpose remains meaningful.
(For example, a function in a library to compute square roots has a purpose that is
entirely well-defined independent of the application. Therefore, Subsection 2d requires
that any application-supplied function or table used by this function must be optional: if
the application does not supply it, the square root function must still compute square
roots.)
These requirements apply to the modified work as a whole. If identifiable sections of
that work are not derived from the Library, and can be reasonably considered
independent and separate works in themselves, then this License, and its terms, do not
apply to those sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based on the Library,
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the distribution of the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or contest your rights to work
written entirely by you; rather, the intent is to exercise the right to control the distribution
of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library
(or with a work based on the Library) on a volume of a storage or distribution medium
does not bring the other work under the scope of this License.
3. You may opt to apply the terms of the ordinary GNU General Public License instead
of this License to a given copy of the Library. To do this, you must alter all the notices
that refer to this License, so that they refer to the ordinary GNU General Public License,
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version 2, instead of to this License. (If a newer version than version 2 of the ordinary
GNU General Public License has appeared, then you can specify that version instead
if you wish.) Do not make any other change in these notices.
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Once this change is made in a given copy, it is irreversible for that copy, so the ordinary
GNU General Public License applies to all subsequent copies and derivative works
made from that copy.
This option is useful when you wish to copy part of the code of the Library into a
program that is not a library.
4. You may copy and distribute the Library (or a portion or derivative of it, under Section
2) in object code or executable form under the terms of Sections 1 and 2 above
provided that you accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections 1 and 2 above on
a medium customarily used for software interchange.
If distribution of object code is made by offering access to copy from a designated
place, then offering equivalent access to copy the source code from the same place
satisfies the requirement to distribute the source code, even though third parties are
not compelled to copy the source along with the object code.
5. A program that contains no derivative of any portion of the Library, but is designed
to work with the Library by being compiled or linked with it, is called a "work that uses
the Library". Such a work, in isolation, is not a derivative work of the Library, and
therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of the Library), rather
than a "work that uses the library". The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.
When a "work that uses the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the Library even
though the source code is not. Whether this is true is especially significant if the work
can be linked without the Library, or if the work is itself a library. The threshold for this
to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and
accessors, and small macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall
under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object code
for the work under the terms of Section 6. Any executables containing that work also
fall under Section 6, whether or not they are linked directly with the Library itself.
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6. As an exception to the Sections above, you may also combine or link a "work that
uses the Library" with the Library to produce a work containing portions of the Library,
and distribute that work under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse engineering for
debugging such modifications.
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You must give prominent notice with each copy of the work that the Library is used in it
and that the Library and its use are covered by this License. You must supply a copy of
this License. If the work during execution displays copyright notices, you must include
the copyright notice for the Library among them, as well as a reference directing the
user to the copy of this License. Also, you must do one of these things:
a) Accompany the work with the complete corresponding machine-readable source
code for the Library including whatever changes were used in the work (which must be
distributed under Sections 1 and 2 above); and, if the work is an executable linked with
the Library, with the complete machine-readable "work that uses the Library", as object
code and/or source code, so that the user can modify the Library and then relink to
produce a modified executable containing the modified Library. (It is understood that
the user who changes the contents of definitions files in the Library will not necessarily
be able to recompile the application to use the modified definitions.)
b) Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (1) uses at run time a copy of the library already present on the
user's computer system, rather than copying library functions into the executable, and
(2) will operate properly with a modified version of the library, if the user installs one, as
long as the modified version is interface-compatible with the version that the work was
made with.
c) Accompany the work with a written offer, valid for at least three years, to give the
same user the materials specified in Subsection 6a, above, for a charge no more than
the cost of performing this distribution.
d) If distribution of the work is made by offering access to copy from a designated place,
offer equivalent access to copy the above specified materials from the same place.
e) Verify that the user has already received a copy of these materials or that you have
already sent this user a copy.
For an executable, the required form of the "work that uses the Library" must include
any data and utility programs needed for reproducing the executable from it. However,
as a special exception, the materials to be distributed need not include anything that is
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normally distributed (in either source or binary form) with the major components
(compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.
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It may happen that this requirement contradicts the license restrictions of other
proprietary libraries that do not normally accompany the operating system. Such a
contradiction means you cannot use both them and the Library together in an
executable that you distribute.
7. You may place library facilities that are a work based on the Library side-by-side in
a single library together with other library facilities not covered by this License, and
distribute such a combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise permitted, and
provided that you do these two things:
a) Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities. This must be distributed under the terms of
the Sections above.
b) Give prominent notice with the combined library of the fact that part of it is a work
based on the Library, and explaining where to find the accompanying uncombined form
of the same work.
8. You may not copy, modify, sublicense, link with, or distribute the Library except as
expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense, link with, or distribute the Library is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such
parties remain in full compliance.
9. You are not required to accept this License, since you have not signed it. However,
nothing else grants you permission to modify or distribute the Library or its derivative
works. These actions are prohibited by law if you do not accept this License. Therefore,
by modifying or distributing the Library (or any work based on the Library), you indicate
your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Library or works based on it.
10. Each time you redistribute the Library (or any work based on the Library), the
recipient automatically receives a license from the original licensor to copy, distribute,
link with or modify the Library subject to these terms and conditions. You may not
impose any further restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for
any other reason (not limited to patent issues), conditions are imposed on you (whether
by court order, agreement or otherwise) that contradict the conditions of this License,
they do not excuse you from the conditions of this License. If you cannot distribute so
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as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Library at all. For
example, if a patent license would not permit royalty-free redistribution of the Library by
all those who receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from distribution of the
Library.
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If any portion of this section is held invalid or unenforceable under any particular
circumstance, the balance of the section is intended to apply, and the section as a
whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other
property right claims or to contest validity of any such claims; this section has the sole
purpose of protecting the integrity of the free software distribution system which is
implemented by public license practices. Many people have made generous
contributions to the wide range of software distributed through that system in reliance
on consistent application of that system; it is up to the author/donor to decide if he or
she is willing to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence
of the rest of this License.
12. If the distribution and/or use of the Library is restricted in certain countries either by
patents or by copyrighted interfaces, the original copyright holder who places the
Library under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the limitation as if written in
the body of this License.
13. The Free Software Foundation may publish revised and/or new versions of the
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or
concerns.
Each version is given a distinguishing version number. If the Library specifies a version
number of this License which applies to it and "any later version", you have the option
of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Library does not specify a license
version number, you may choose any version ever published by the Free Software
Foundation.
14. If you wish to incorporate parts of the Library into other free programs whose
distribution conditions are incompatible with these, write to the author to ask for
permission. For software which is copyrighted by the Free Software Foundation, write
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to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free
software and of promoting the sharing and reuse of software generally.

•
•
• 422
•
•
•

NO WARRANTY
15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.
16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
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YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Libraries
If you develop a new library, and you want it to be of the greatest possible use to the
public, we recommend making it free software that everyone can redistribute and
change. You can do so by permitting redistribution under these terms (or, alternatively,
under the terms of the ordinary General Public License).
To apply these terms, attach the following notices to the library. It is safest to attach
them to the start of each source file to most effectively convey the exclusion of
warranty; and each file should have at least the "copyright" line and a pointer to where
the full notice is found.
one line to give the library's name and an idea of what it does.
Copyright (C) year name of author
This library is free software; you can redistribute it and/or modify it under the terms of
the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version.
This library is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details.
You should have received a copy of the GNU Lesser General Public License along with
this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth
Floor, Boston, MA 02110-1301 USA
Also add information on how to contact you by electronic and paper mail.
You should also get your employer (if you work as a programmer) or your school, if any,
to sign a "copyright disclaimer" for the library, if necessary. Here is a sample; alter the
names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for
tweaking knobs) written by James Random Hacker.
signature of Ty Coon, 1 April 1990
Ty Coon, President of Vice

Silhouette User Guide

•
•
•
•
•
•

